GEM/3 Desktop

Installation Guide
Welcome to GEM Setup. This easy-to-use installation program prepares or sets up the GEM® Desktop™ software application to work with your particular hardware. It does so by asking which types of devices (graphics card, mouse, printer, etc.) are attached to your computer. Then it creates special directories on your hard disk or floppy disk, and copies the GEM®/3™ system files and hardware-specific files into these directories.

The entire installation process takes only minutes. When you are done, you will be able to use desktop publishing, drawing, painting, and many other graphics-based programs formerly unavailable to DOS users.

How to Use this Guide

For quick installation instructions, see “Starting GEM Setup” in Chapter 2.

If you are unfamiliar with GEM, you should read “Conventions” in this Foreword and Chapter 1 before starting GEM Setup.

If you are upgrading from an earlier version of the GEM Desktop, see “GEM/3 Features” in this Foreword and “Upgrading to GEM/3” in Chapter 1.
• Chapter 1 acquaints you with the GEM Desktop package and explains how to prepare to run GEM Setup.

• Chapter 2 takes you step-by-step through the GEM Setup program and describes the directories and files created as a result of installation. It also tells you how to start the GEM Desktop and set up the commands to start it automatically every time you boot your computer.

• Chapter 3 explains how to change your hardware setup once you've installed the GEM Desktop on your computer. It provides instructions for installing, removing, and changing printers, plotters, scanners, and cameras.

• Chapter 4 presents the generic procedure for installing other GEM software applications from Digital Research®.

• Chapter 5 contains basic troubleshooting information. It lists commonly asked questions and common problems and provides some answers.

• Appendix A lists the hardware and software that can be used with the GEM Desktop and contains the GEM/3 system requirements.

Conventions

This guide uses the conventions and terminology presented below.

Examples

• Examples pertaining to hard disk systems assume that they have at least one hard disk drive, drive C.

• Information you must enter on your keyboard is displayed in the typeface shown below. The characters you type are shown in upper case, although you can use either upper or lower case.

  USER INPUT _

  The _ symbol means press the ENTER or RETURN key.

• GEM Setup screen examples use √ to indicate items being selected.
Terminology

The term *high-density disk* means a floppy diskette containing 720K bytes or more of space. It refers to both 5.25" and 3.5" floppy disks.

*Double-density disk* means a floppy disk containing 360K bytes of space.

*Mouse* is used generically to refer to a pointing device attached to your computer.

GEM/3 Features

In response to customer requests, this release of GEM system software provides enhancements in the following areas:

- installation
- GEM Output
- fonts
- printers

Installation

The installation program is easier to use and provides more options. GEM Setup combines the functions of the GEM 2.x GEMPREP and GEM Setup programs. It handles both first-time installation and subsequent changes.

GEM Output

The GEM Output application program offers a new interface as well as new functions. It also implements new printer functions supported by GEM Desktop, and organizes the menu entries in a more understandable form.
Fonts

Many additional fonts and font sizes are now available.

Printers

Added printer functions include:

**Graphics Mode**
- more native printer functions
- multiple page sizes and paper tray options
- manual feed selection
- use of resident graphics fonts
- use of downloadable fonts

**Text Mode**
- more text attributes (superscript, subscript, light text, italics)
- proportional, condensed, and expanded spacing
- elite and pica typefaces

Ventura Compatibility

You can now run Xerox® Ventura Publisher™ Edition 1.1 from the GEM Desktop. Devices installed under GEM/3 also work with this version of Ventura Publisher.
1 BEFORE YOU BEGIN
What's in this Package ............... 1-2
Backing Up Your Master Disks ......... 1-2
Information You'll Need ......... 1-3
    About Communications Ports ......... 1-3
Upgrading to GEM/3 ............... 1-5

2 INSTALLATION
Starting GEM Setup ............... 2-2
Installing onto a Hard Disk ......... 2-3
Installing onto Floppy Disks ......... 2-6
Installation Results ......... 2-9
    Hard Disk, High-Density Disk, and 3.5" Floppy Disk ......... 2-9
    Dual Floppy Disks ......... 2-10
Starting the GEM Desktop ......... 2-11
    Starting from Hard Disk ......... 2-11
    Starting from Floppy Disks ......... 2-11
GEM Desktop Screen Components ......... 2-12
    Starting the GEM Desktop Automatically: Hard Disk ......... 2-13

3 CHANGING YOUR HARDWARE
Choosing the Operation ......... 3-2
Installing Printers ......... 3-4
    Installing Multiple Devices on Floppy Disks ......... 3-6
5.25" Floppy Disks ......... 3-6
3.5" Floppy Disks ......... 3-7
Installing from Driver Packs ......... 3-8
    What Is a Driver? ......... 3-8
    Installation Procedure ......... 3-9
Removing Devices ......... 3-10
Changing Your Setup ......... 3-11
    Changing Setups on Multiple Hard Disks ......... 3-11
4 INSTALLING GEM APPLICATIONS

Running INSTALL.APP .................................................. 4-2

5 TROUBLESHOOTING

Questions Commonly Asked ............................................. 5-1
Problems ........................................................................ 5-2
Resolving Problems ......................................................... 5-3

A SYSTEM INFORMATION

Computer ................................................................. A-1
Operating System ...................................................... A-2
Memory ................................................................. A-2
Monochrome Graphics ............................................. A-2
Color Graphics ........................................................ A-2
Printer ................................................................. A-3
Mouse ................................................................. A-3
Driver Packs ......................................................... A-4
Before you install the GEM Desktop onto your computer system, you need to:

- check the contents of your GEM Desktop package to ensure that it is complete
- back up the GEM Desktop product disks (using the DOS DISKCOPY command)
- gather the information required by the installation program GEM Setup

This chapter explains these steps.

If you are upgrading from an earlier version of GEM, be sure to read "Upgrading to GEM/3" later in this chapter.
What's In this Package

Check to ensure that your GEM/3 Desktop package contains the following:

- Master disk set
- User's Guide
- End-user software license agreement
- End-user software registration card

Backing Up Your Master Disks

Before installing the GEM Desktop, make backup copies of the master disks and store the originals in a safe place. You'll use the copies to run the installation program, GEM Setup.

**Note:** You must use the DOS DISKCOPY command to make backup disks. Consult your operating system documentation for instructions.
Information You’ll Need

The form on the following page lists the information that GEM Setup requires. You can collect this information and enter it in the spaces provided before you start GEM Setup. When you are done, you’ll be prepared to complete the installation procedure quickly and easily.

About Communications Ports

If you are using a printer, a non-bus mouse, or other peripheral device, it is physically attached to a communications port located at the back of your computer. GEM Setup asks you to identify the communications port to which each device is attached.

There are two types of communications port: serial and parallel. The port you attach a device to depends on the device itself. If you do not know which port you need to use, consult the associated documentation or contact your computer dealer or a systems specialist. Note, however, that if you make an error in GEM Setup, the device affected will not function. This will not harm your system, and you can correct the error by rerunning GEM Setup.
### System Information Sheet

1. Graphics card/display:

2. Mouse/graphics tablet (if any):

3. Mouse communications port: #1(COM1) #2(COM2)

4. Printer 1:
   - Printer serial port: #1(COM1) #2(COM2) #3(COM3)
   - Parallel port: #1(LPT1) #2(LPT2) #3(LPT3)

5. Printer 2:
   - Printer serial port: #1(COM1) #2(COM2) #3(COM3)
   - Parallel port: #1(LPT1) #2(LPT2) #3(LPT3)

6. Plotter:
   - Plotter serial port: #1(COM1) #2(COM2) #3(COM3)

7. Camera:
   - Camera serial port: #1(COM1) #2(COM2) #3(COM3)

8. Scanner:
   - Input/output port address: 200 220 300 Other
   - Transfer port address: 200 220 300 Other
Upgrading to GEM/3

In GEM/3, all GEM directories are placed within a directory called GEMAPPS, shown below:

![GEM/3 Directories Diagram]

* Used by GEM® Desktop Publisher™ and GEM® 1st Word Plus™
If you have GEM 2.x (versions from 2.0 to 2.2) installed on your system, your GEM directories (folders) are located at the root level and organized as follows:

**GEM 2.x Directories**

![Diagram of GEM 2.x Directories]

*Used by GEM Desktop Publisher*

When you install GEM/3, your GEM 2.x directories remain intact. Documents you created with GEM 2.x can be read and edited with GEM/3 application programs. To avoid confusing GEM/3 directories with GEM 2.x directories, you should delete the directories indicated in this illustration before installing GEM/3.
This chapter takes you step-by-step through the GEM Setup installation procedures for both hard disk systems and dual floppy disk systems. It describes the results of installation on your system, and explains how to start the GEM Desktop. The chapter ends with a section explaining how to set the commands needed to open the GEM Desktop automatically whenever you start up your computer.

**Note:** If you make a mistake during GEM Setup, this will not harm your system. You can correct it by rerunning GEM Setup, which you can run as many times as you need.
Starting GEM Setup

If you intend to run the GEM Desktop from floppy disks, you need two blank, formatted double-density (360K) disks or one blank formatted high-density (720K) disk. Your computer must be equipped with a high-density disk drive to use high-density disks. If you are unsure about the type of disk drive or other hardware you have, refer to your hardware documentation or consult a systems specialist.

To run GEM Setup, follow these steps:

1. Start your computer to DOS.
2. Insert the disk labeled GEM SYSTEM MASTER into drive A.
3. Logon to drive A (floppy disk drive). The A:\ prompt is displayed.
4. Type this command:
   
   GEMSETUP

   This starts GEM Setup. The first GEM Setup Screen you see looks similar to the illustration below:

---

**Welcome to GEM Setup!**

This program installs GEM/3 onto your computer. Do you want to install GEM/3 for the first time or change an existing GEM/3 installation?

[ ] INSTALL NEW CONFIGURATION

[ ] CHANGE EXISTING CONFIGURATION

Press ‼️ or ‐ to move cursor, [ENTER] to choose, [ESC] to exit/cancel.

---

Digital Research Inc.  
GEM Setup R 3.0
The ✓ symbol, which blinks on your screen, indicates the item being selected. On some display monitors, this symbol appears as a box or triangle.

Select **INSTALL NEW CONFIGURATION** and follow the instructions through the end of the program. The instructions differ, depending on whether you are installing GEM/3 onto a hard disk or onto floppy disks. These instructions are explained below. In either case, you will be asked to provide the information outlined on the System Information Sheet in Chapter 1.

**Installing onto a Hard Disk**

Follow the steps below to install GEM/3 onto your hard disk.

You have just selected **INSTALL NEW CONFIGURATION**. If your system has more than one hard disk, GEM Setup asks you to specify the one onto which you want to install GEM/3. Otherwise, you see the following:

From the list below, select the graphics card and display installed in your system.

1. [ ] AT&T DEB Card / 16-Color Display (640x400)
2. [ ] AT&T Monochrome Card (640x400)
3. [ ] Hercules Card / Monochrome PC Display (720x348)
4. [ ] IBM CGA / Color Display (640x200) - Mono Mode
5. [ ] IBM EGA / Monochrome Display (640x350)
6. [✓] IBM Enhanced Card & Enhanced 16-Color Display (640x350)
7. [ ] IBM 16-Color VGA for PS/2 (640x480) or Compatible
8. [ ] IBM VGA Monochrome for the PS/2 (640x480) or Compatible
9. [ ] MDS THE GENIUS Monitor / THE GENIUS Monitor Card (728x1008)
10. [ ] Video 7 Vega Deluxe / Quadram Prosync 16-Color Display (640x480)
11. [ ] Video 7 Vega Deluxe / Quadram Prosync 16-Color Display (752x410)
12. [ ] Wyse/Amdek Monochrome Graphics Display (1280x800)
13. [ ] OTHER (Driver Pack)

Press [F1] for device info, ↑ or ↓ to move cursor, [ENTER] to choose.
1. Choose the graphics card/display type installed on your computer. If your display is compatible with any of the devices listed, choose the entry for the compatible device. If you are installing from a driver pack disk, choose OTHER and select your device from the list displayed.

For more information about driver packs available from Digital Research, see the Driver Pack Information Sheet supplied with this package.

**Note:** The devices listed on your screen may differ from the ones shown in the preceding illustration.

Next you see:

```
Select the mouse or tablet you are using from the list below.

[✓] No Mouse
[ ] Bus Mouse (Requires file MOUSE.COM)
[ ] IBM Personal System/2 Mouse
[ ] Microsoft Serial Mouse (RS232)
[ ] Mouse Systems PC Mouse / SummaMouse / Compatibles
[ ] SummaSketch 961 cursor-type tablet
[ ] SummaSketch 961 stylus-type tablet
[ ] SummaSketch 1201 cursor-type tablet
[ ] SummaSketch 1201 stylus-type tablet
[ ] Summagraphics MM1812 cursor-type tablet
[ ] Summagraphics MM1812 stylus-type tablet

Press [F1] for device info, ↑ or ↓ to move cursor, [ENTER] to choose.
```

2. Identify your mouse as you did your graphics card/display. If you are unable to determine the type of mouse you are using, chances are you are using a *generic* serial mouse. In this case, choose the fifth option:

Mouse Systems PC Mouse / SummaMouse / Compatibles
GEM Setup displays:

Select a communications port for your mouse or tablet:

- [✓] Communications port #1 (COM1)
- [ ] Communications port #2 (COM2)

Press ↑ or ↓ to move cursor, [ENTER] to choose, [ESC] to exit/cancel.

3. Choose your mouse communications port. Read "Specifying Communications Ports" in Chapter 1 for information about communications ports.

Note: If you have a bus mouse, you need to install it according to the manufacturer's instructions and copy the file MOUSE.COM onto the root directory of your hard disk. You will find this file either on the disk supplied with your mouse or on your DOS boot disk.

You must run MOUSE.COM before starting the GEM Desktop. You can run it from within your AUTOEXEC.BAT file (See "Starting the GEM Desktop Automatically" later in this chapter.)

After you choose your mouse port, GEM Setup displays your hardware setup. It looks like the following example:

Your current setup is:

IBM Enhanced Card & 16-Color Display (640x350)
Mouse Systems PC Mouse / SummaMouse / Compatibles
Communications port #1 (COM1)

Would you like to:
- [✓] CONTINUE
- [ ] SAVE AND EXIT FROM GEM SETUP

Press ↑ or ↓ to move cursor, [ENTER] to choose, [ESC] to exit/cancel.
If you wish to install GEM/3 software for another device such as a printer, choose CONTINUE – see Chapter 3 for installation instructions. If you do not intend to use an output device, you should now check to see that installation was successful. Installation results are explained later in this chapter.

Installing onto Floppy Disks

You have just selected INSTALL NEW CONFIGURATION. The following alert (reminder or warning) is displayed:

To continue, you will need to have TWO empty formatted disks ready. If you need to clean off or format a disk, you must exit GEM Setup and return to DOS to do so.

[✓] EXIT TO DOS
[ ] CONTINUE

This alert is displayed if you are using double-density disks. If you are using a high-density or 3.5" disk, you need only one empty disk.

1. Choose CONTINUE unless you need to exit GEM Setup to prepare your disk(s).

Next, GEM Setup instructs you to label your GEM STARTUP and GEM DESKTOP disks (GEM DESKTOP only if 3.5"disk) and set them aside. When you complete these instructions, you see a list of graphics cards/displays (shown on page 2-3).

2. Choose the graphics card/display type installed on your computer. If your display is compatible with any of the display monitors listed, choose the entry for the compatible display. If you are installing from a driver pack disk, choose OTHER and select your device from those listed.

For more information about the driver packs available from Digital Research, see the GEM/3 Driver Pack Information Sheet supplied with this package.

GEM Setup displays a list of mice and graphics tablets (see page 2-4).
3. Choose your mouse as you did your graphics card/display monitor. If you are unable to determine the type of mouse you are using, chances are you are using a *generic* serial mouse. In this case, select the fifth option:

Mouse Systems PC Mouse / SummaMouse / Compatibles

When you choose your mouse, GEM Setup lists communications ports COM1 and COM2 (shown on page 2-5).

4. Choose your mouse communications port. See "Specifying Communications Ports" in Chapter 1 for information about communications ports.

**Note:** If you have a bus mouse, you need to install it according to the mouse manufacturer's instructions and copy the file MOUSE.COM onto your DOS boot disk. You will find this file either on the disk supplied with your mouse or on your DOS boot disk.

You need to copy MOUSE.COM *before* starting the GEM Desktop. MOUSE.COM can be executed from within your AUTOEXEC.BAT file.

When you choose your mouse port, GEM Setup displays your current hardware setup. Here's an example:

<table>
<thead>
<tr>
<th>Your current setup is:</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Enhanced Card &amp; 16-Color Display (640x350)</td>
</tr>
<tr>
<td>Mouse Systems PC Mouse / SummaMouse / Compatibles</td>
</tr>
<tr>
<td>Communications port #1 (COM1)</td>
</tr>
</tbody>
</table>

Would you like to:

- [✓] CONTINUE
- [ ] SAVE AND EXIT FROM GEM SETUP

Press ↑ or ↓ to move cursor, [ENTER] to choose, [ESC] to exit/cancel.

To install another device, such as a printer, choose `CONTINUE` (see Chapter 3 for installation instructions).
If you do not intend to use an output device, choose **SAVE AND EXIT FROM GEM SETUP**. GEM Setup instructs you to insert your installation disks and copies the driver files onto your system. When it finishes copying, installation is complete.
Installation Results

This section describes the directory structures and files that GEM Setup creates, for both hard disk and floppy disk systems.

Hard Disk, High-Density Disk, and 3.5" Floppy Disk

GEM Setup creates a folder called GEMAPPS on the drive or disk you specify. This directory contains all of the GEM Desktop files as well as other GEM applications, as outlined below:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root</td>
<td>GEM.BAT</td>
</tr>
<tr>
<td>GEMAPPS</td>
<td>GEM Output files: OUTPUT.APP and OUTPUT.RSC</td>
</tr>
<tr>
<td>GEMSYS</td>
<td>System files</td>
</tr>
<tr>
<td></td>
<td>Device Drivers</td>
</tr>
<tr>
<td></td>
<td>Desk accessories</td>
</tr>
<tr>
<td>FONTS</td>
<td>Font files</td>
</tr>
<tr>
<td>CLIPBRD</td>
<td>Used by GEM Desktop Publisher and GEM 1st Word Plus</td>
</tr>
</tbody>
</table>

The GEM.BAT file created in your root directory contains the commands that open the GEM Desktop from your DOS command line. The GEM/3 directories are illustrated on page 1-5.
Dual Floppy Disks

During installation, you create two disks: GEM Startup and GEM Desktop.

The following chart outlines the directories and files contained on each disk:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root</td>
<td>GEM.BAT</td>
</tr>
<tr>
<td>GEMAPPS</td>
<td>System files</td>
</tr>
<tr>
<td>GEMSYS</td>
<td>Device Drivers</td>
</tr>
<tr>
<td></td>
<td>Desk accessories</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Directory</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>GEMAPPS</td>
<td>GEM Output files: OUTPUT.APP and OUTPUT.RSC</td>
</tr>
<tr>
<td></td>
<td>System files</td>
</tr>
<tr>
<td></td>
<td>Device drivers</td>
</tr>
<tr>
<td>FONTS</td>
<td>Font files</td>
</tr>
<tr>
<td>CLIPBRD</td>
<td>Used by GEM Desktop Publisher and GEM 1st Word Plus</td>
</tr>
</tbody>
</table>

To ensure that installation was successful, you should start the GEM Desktop. The procedure for this is explained next.
Starting the GEM Desktop

This section explains the procedure for starting the GEM Desktop for both hard disk and floppy disk systems.

Starting from Hard Disk

Follow these steps to start the GEM Desktop:
1. Move to your hard disk drive.
2. Type this command to move to the root directory:
   \n3. Type:
   GEM

This executes the GEM.BAT file, which contains the commands that start the GEM Desktop. The GEM Desktop screen, explained in the following section, is displayed.

Starting from Floppy Disks

Follow these steps to start the GEM Desktop:
1. Start your computer to DOS.
2. Insert your GEM STARTUP disk (GEM DESKTOP, if 3.5" disk) into drive A and logon to this drive.
3. When you see the A:\ prompt, type:
   GEM
4. As instructed, insert your GEM DESKTOP disk in drive A, close the drive door, and press any key.

You see an hourglass icon on your screen indicating that your computer is busy retrieving the GEM Desktop.

The GEM Desktop screen, explained below, is displayed.
GEM Desktop Screen Components

The GEM Desktop screen represents graphically the data structures within your operating system. When you start the GEM Desktop, the screen looks similar to the following illustration, depending on your hardware configuration and on the number of GEM applications you've installed.

Notice that the screen is divided into two sections called windows. The top window is labeled `C:\GEMAPPS\`, which means that the folder GEMAPPS is open and you have access to the folders within it.

The bottom window is labeled Disk Drives. It contains two or more disk icons representing the disk drives on your system. In this example, the window contains a floppy disk icon labeled A and a hard disk icon labeled C.
Folder icons represent both directories and subdirectories.

Refer to *GEM Desktop User's Guide* for a complete explanation of the GEM Desktop screen components.

**Starting the GEM Desktop Automatically: Hard Disk**

If you are using a hard disk system, you can set commands that open the GEM Desktop automatically every time you start your computer. To do this, you need to create an AUTOEXEC.BAT file containing these commands.

The AUTOEXEC.BAT file is a batch file that your computer looks for every time you turn it on or reboot the operating system. If it finds this file, it completes the commands contained in the file before doing anything else. If you are using a bus mouse, you can execute the MOUSE.COM program from within the AUTOEXEC.BAT file.

*Note:* Be sure to have completed GEM Setup *before* taking any of the steps described below.

**If You Already Have AUTOEXEC.BAT**

If you installed the GEM Desktop onto your hard disk and you *already have* an AUTOEXEC.BAT file on that disk, you need to modify this file. There are two ways to do this:

1. Use the DOS COPY command to merge the GEM.BAT file with your AUTOEXEC.BAT file.

   First, logon to your hard disk. When you see the system prompt (such as C:\ or D:\), type the following commands:

   ```
   CD \ ..
   COPY AUTOEXEC.BAT + GEM.BAT ..
   ```

2. Using a word processor or text editor, add the following command to the end of your existing AUTOEXEC.BAT file:

   ```
   GEM
   ```

   *Note:* Be sure that a carriage return precedes the GEM command.
Now whenever you start your computer or reboot the operating system, the GEM Desktop will open automatically.

If You Don’t Have AUTOEXEC.BAT

If you installed the GEM Desktop onto your hard disk, and you do not already have an AUTOEXEC.BAT file on that disk, do the following:

1. Logon to your hard disk.
2. Type the following commands when the system prompt (C:\ or D:\) is displayed:

```
CD \..
RENAME GEM.BAT AUTOEXEC.BAT ..
```

Now whenever you start your computer or reboot the operating system, the GEM Desktop will open automatically.
Changing Your Hardware

Whenever you add, remove, or change the hardware components you are using, you need to change the device setup you created with GEM Setup. This section explains how to:

- install printers
- install multiple devices on floppy disks
- install from driver packs
- remove devices from your setup
- change device types within your setup

The first step is to choose which operation you want to perform. Read "Choosing the Operation" in the next section, then see the section in this chapter that explains the operation.

For instructions on adding a printer See this section
adding a plotter, camera, scanner, screen, or display from a driver pack
changing device types within your current setup
removing devices from your setup

See this section
"Installing Printers"
"Installing from Driver Packs"
"Changing Your Setup"
"Removing Devices"
Choosing the Operation

If you're not running GEM Setup, start it now. (If you do not remember how, see Chapter 2, "Running GEM Setup.") The first GEM Setup screen is displayed:

[Digital Research Inc.]

Welcome to GEM Setup!

This program installs GEM/3 onto your computer. Do you want to install GEM/3 for the first time or change an existing GEM/3 installation?

[ ] INSTALL NEW CONFIGURATION
[√] CHANGE EXISTING CONFIGURATION

Press ↑ or ↓ to move cursor, [ENTER] to choose, [ESC] to exit/cancel.

Select CHANGE EXISTING CONFIGURATION.

The screen displays your current setup and gives you the option to continue or exit the program.

Choose CONTINUE.
GEM Setup displays:

Would you like to:

[✓] ADD A PRINTER
[ ] ADD A PLOTTER
[ ] ADD A CAMERA
[ ] ADD A SCANNER
[ ] CHANGE YOUR CURRENT SETUP
[ ] REMOVE A DEVICE FROM YOUR SETUP

Press ↑ or ↓ to move cursor, [ENTER] to choose, [ESC] to exit/cancel.

Select the operation you want to perform, then see the section in this chapter that explains the operation, outlined on page 3-1.
Installing Printers

This section explains how to install printers for both hard disk and floppy disk systems.

If you have not already done so, read and follow the instructions in “Choosing the Operation” in the preceding section.

Follow the steps below to add a printer to your setup. You have just selected ADD A PRINTER. The screen displays:

```
Select the printer that you intend to use from the list below.

[ ] Epson GQ-3500 Laser Printer (300 x 300 Dots/Inch)
[ ] Epson LQ Series Printers (180 x 180 Dots/Inch)
[ ] Hewlett Packard LaserJet II Printer (300 x 300 Dots/Inch)
[ ] Hewlett Packard LaserJet+ (150 x 150 Dots/Inch)
[ ] IBM/Epson High Resolution Printers (120 x 144 Dots/Inch)
[ ] IBM Proprinter (120 x 144 Dots/Inch)
[ ] LaserWriter / Postscript Printers
[ ] LaserWriter Plus / Postscript Printers
[ ] Toshiba Printer (180 x 180 Dots/Inch)
[ ] Xerox 4020 Color Ink Jet (120 x 240 Dots/Inch)
[ ] OTHER (Driver Pack)

Press [F1] for device info, ↑ or ↓ to move cursor, [ENTER] to choose.
```

1. Choose your printer. This example shows the entry to choose if you are using a printer that uses the a Postscript® driver, such as the Apple® LaserWriter™.
Next, you see:

Select a communications port for your printer:

- [✓] Parallel port #1 (LPT1)
-  Parallel port #2 (LPT2)
-  Parallel port #3 (LPT3)
-  Communications port #1 (COM1)
-  Communications port #2 (COM2)

Press ↑ or ↓ to move cursor, [ENTER] to choose, [ESC] to exit/cancel.

2. Choose a communications port for your printer. See “About Communications Ports” in Chapter 1 for further information.

GEM Setup displays your new setup.

If you want to make another change to your setup, select CONTINUE, then choose the operation you want to perform. To finish installation and exit GEM Setup, select SAVE AND EXIT FROM GEM SETUP.

GEM Setup instructs you to insert one of your disks labeled GEM PRINTER DISK into drive A. This disk contains the device driver and font files for your printer.

3. Insert your printer driver disk into drive A. Press ↓. You see a list of files being copied onto your disk. If you are installing onto floppy disks, GEM Setup instructs you to insert disks as needed.

When copying is completed, your printer is installed. GEM Setup concludes with instructions on starting the GEM Desktop.
Installing Multiple Devices on Floppy Disks

This section explains how to add more than one output device to your setup. You can add:

- printers
- plotters
- scanners
- cameras

5.25" Floppy Disks

When you install GEM/3 onto 5.25" floppy disks, you create a disk labeled GEM STARTUP and another labeled GEM DESKTOP. The GEM STARTUP disk contains the files that execute GEM/3. The GEM DESKTOP disk contains the printer and other device-related files. Since floppy disk space is limited, to install more than one device, you need to create as many GEM DESKTOP disks as there are devices attached to your computer. Here's how:

1. Format as many disks as you'll need. Label each "Desktop Disk" and add the name of the device.

2. If you have not already done so, run GEM Setup as a new installation and install the first device. (See Chapter 2, "Installing onto Floppy Disk Systems." ) Put the first Desktop Disk you create aside.

3. Restart GEM Setup. When you see the first GEM Setup screen (see page 3-2), choose CHANGE EXISTING CONFIGURATION. When prompted to insert your GEM STARTUP disk, insert the one you created originally.

GEM Setup displays your current setup and gives you the option to continue or exit the program.

4. Choose CONTINUE.

Next, you see a list of options (illustrated on page 3-3). You can choose any of the first four. Let's assume you select ADD A PRINTER.
5. The screen displays a list of printers (see page 3-3). Choose your second printer.

6. GEM Setup displays a list of communications ports. Choose the one you intend to use.

   GEM Setup displays your new setup, which lists both printers you've installed.

7. Choose **SAVE AND EXIT FROM GEM SETUP**.

8. When prompted to insert your GEM DESKTOP disk, insert the new one.

Repeat steps 3 through 8 for each additional device, using a new GEM DESKTOP disk each time.

### 3.5" Floppy Disks

Before attempting to add a device to your setup, check the amount of available disk space on your GEM DESKTOP disk. Most likely, there is enough disk space to add a second device to your setup, although the amount of space required varies for different devices.

To install a second device, rerun GEM Setup and follow steps 3 through 8 of the preceding section, only using the same GEM DESKTOP disk you created originally.

If, when GEM Setup displays your new setup, the second output device is not listed, prepare a separate GEM DESKTOP disk, rerun GEM Setup, and install the device as a new installation.
Installing from Driver Packs

This section explains how to install devices from driver packs. The procedure is the same for all of the following devices:

- display monitors
- printers
- plotters
- scanners
- cameras

Notes:

1. If you are installing a plotter, ensure that it is configured to the following settings before running GEM Setup:
   - 9600 baud
   - No parity
   - 8 data bits

2. If you are installing a scanner, you may be asked for one or more of the following:
   - input/output port address
   - transfer address
   - .COM file (DOS command file)

If this information is required, refer to your scanner hardware documentation or contact your scanner dealer.

What Is a Driver?

When you install a device, you are actually installing a device driver – a software program which enables an application program to use a device (printer, plotter, screen, etc.). When you install device drivers for GEM, you are providing the GEM software with the means to identify and use the devices you are installing.
GEM is supplied with a certain number of standard device drivers. Since drivers can take up large segments of memory and disk space, not all devices can be supplied as part of the standard GEM Desktop package. Many drivers are available on disks called driver packs, obtainable directly from Digital Research. See the GEM/3 Driver Pack Information Sheet supplied with this package for a list of available driver packs.

Note that some hardware manufacturers also supply device drivers compatible with GEM/3. You can contact them directly for driver availability information.

**Installation Procedure**

If you have not already done so, read and follow the instructions in “Choosing the Operation” at the beginning of this chapter.

Let’s assume you are adding a plotter. You have just selected **ADD A PLOTTER**.

1. Insert your plotter driver pack disk into drive A and press _J_.
   The screen displays a list of plotters.

2. Move your cursor to the plotter you wish to install and press _J_.
   GEM Setup displays a list of communications ports.

3. Choose the port you intend to use. For more information, see Chapter 1, “Selecting Communications Ports.”
   The screen displays your new device setup. If you want to perform another operation, choose **CONTINUE**; to complete installation and exit GEM Setup, choose **SAVE AND EXIT FROM GEM SETUP**.
   GEM Setup copies the GEM plotter driver onto your target disk. When it finishes copying, plotter installation is complete.
Removing Devices

This section tells you how to remove a device from your setup. When you remove a device from your setup, you remove its device driver and any associated fonts. The driver takes up disk and memory space, and you don't need the driver if you're not using the device.

If you have not already done so, read and follow the instructions in "Choosing the Operation" at the beginning of this chapter.

You have just selected REMOVE A DEVICE FROM SETUP. GEM Setup displays your current setup and instructs you to choose the device you want to delete.

When you choose the device, GEM Setup displays your new device setup. If you want to perform another operation, choose CONTINUE; to exit GEM Setup, choose SAVE AND EXIT GEM SETUP.

GEM Setup removes the device driver and any associated files.
Changing Your Setup

This section explains how to substitute one device for another within your setup without deleting or adding to the setup.

If you have not already done so, read and follow the instructions in "Choosing the Operation" at the beginning of this chapter.

You have just selected CHANGE YOUR CURRENT SETUP. The screen displays your current setup and asks you to identify the item you want to change.

Let's assume you want to change the mouse installed in your setup.

Move your cursor to the mouse entry and press *. The screen displays a list of mice and tablets. Choose the one you intend to use.

GEM Setup then displays your new setup. If you want to perform another operation, select CONTINUE; to exit GEM Setup, select SAVE AND EXIT FROM GEM SETUP. The new driver is copied onto your disk.

Changing Setups on Multiple Hard Disks

If you installed GEM/3 on multiple hard disks, whenever you select CHANGE YOUR CURRENT SETUP, GEM Setup makes changes to your setup on the drive having the lower letter drive identifier. For example, if you installed GEM/3 on drives C and E, it makes changes to drive C. To change your setup on drive E, you would need to assign drive C as drive E temporarily. Here's how:

1. Enter DOS and move to drive C.

2. Type the following command:

   \texttt{ASSIGN C=E \\}

   This redirects instructions performed on drive C to drive E. The \texttt{ASSIGN} command remains in effect until you reboot your computer.

   \textbf{Note:} The \texttt{ASSIGN} command is available only on DOS 3.0 and later versions.


Installing GEM Applications

This chapter steps you through the generic procedure for installing other GEM applications for use with the GEM Desktop.

Each application is supplied with an installation program called INSTALL.APP. You run INSTALL.APP from within the GEM Desktop, which, except for application-specific instructions, is very similar from one application to another.

Note: This installation procedure applies only to GEM applications from Digital Research.
Running INSTALL.APP

Here is the typical installation procedure:

1. Start the GEM Desktop. If you do not recall how to do this, see Chapter 2, "Starting The GEM Desktop."

2. Insert your GEM application master disk into drive A.

3. Double click on the A disk-drive icon in the window labeled "Disk Drives."
   The window changes to show the contents of the master application disk.

4. Double-click on the icon labeled INSTALL.APP.
   INSTALL.APP displays a message confirming the disk drive on which the application is to be installed.

5. Click on OK.
   INSTALL.APP displays the names of the application files as they are copied onto your disk.
   When copying is completed, a message is displayed, indicating the name of the folder on your hard or floppy disk containing the newly installed application.
   When installation is complete, the screen displays instructions for running the application program.
Troubleshooting

This chapter answers commonly asked questions about using the GEM Desktop and other GEM applications. It lists problems you may encounter when using the GEM Desktop and their solutions.

Questions Commonly Asked

1. **I have purchased several GEM applications and received a different release of the GEM Desktop with each. Which release should I install?**
   - Install the most recent release using the program GEM Setup on the disk labeled SYSTEM.

2. **Can I remove or move any of the GEM/3 subdirectories?**
   - No.

3. **Can GEM Setup be run from the hard disk?**
   - Yes, by copying files GEMSETUP.EXE and GEMSETUP.TXT from the GEM system master disk onto the hard disk. Having GEM Setup on your hard disk may be useful if you need to change your setup frequently.

4. **What cable do I need for the Hewlett-Packard® 7550 Plotter?**
   - Hewlett-Packard part number: HP 17255F
Problems

1. After you type the GEM startup command, the screen is blank.
   - The graphics card selected during GEM Setup is the wrong type or model. Rerun GEM Setup and change this entry.

2. When you print a document, the graphics are printed but no text.
   - Either the printer font files have not been installed or they were installed and subsequently erased. Rerun GEM Setup.

3. The screen displays this error message when you attempt to start the GEM Desktop:
   
   GEM VDI not installed.
   - This occurs most commonly when:
     - The disk labeled SYSTEM has been copied to the root directory of your hard disk, or you typed "GEM" from within the \GEMAPPS\GEMSYS directory.
     - There is insufficient memory available on your system.

4. When attempting to use any GEM application, an alert is displayed instructing you to insert your GEM Fonts disk.
   - The screen fonts are not installed on your system. Rerun GEM Setup and, for dual-floppy systems, reinstall the application.

5. You are using an IBM® CGA™, but your display is not in color.
   - GEM/3 supports the IBM CGA in monochrome mode only.
Resolving Problems

When experiencing a problem:

- Learn which systems your hardware is compatible with.
- Try to find out whether the problem is hardware incompatibility-related or software-related.

Have the following information ready when you call Digital Research's Customer Technical Support Services – (408) 646-6464:

- type of computer (IBM PC/XT®, PC/AT®, Personal System/2™, etc.)
- type of graphics card
- mouse and mouse communications port
- printer(s) and printer port(s)
- release of the GEM Desktop installed
- product serial number

The GEM Desktop serial number is located on your SYSTEM disk. For GEM/3 applications, it is located on the application master disk.
Appendix A

System Information

This appendix lists the hardware and software that you can use with the GEM Desktop, as well as the GEM/3 system requirements.

Computer

AT&T® 6300
IBM PC™, PC/XT, PC/AT
3270 PC,
Personal System/2
100%-compatible computer

Notes:

• Your computer must have a graphics card installed.

• While you can perform all GEM Desktop operations directly from your keyboard, a mouse or graphics tablet is recommended for ease of use.

• Your computer must have at least two disk drives. You can have either two floppy drives or one floppy drive and at least one hard disk drive. The GEM Desktop is available in both 5.25" and 3.5" disk versions.

• For floppy disk systems, the GEM Desktop and GEM applications require two double-sided, double-density disks or one high-density disk.
Operating System

PC-DOS™ version 2.1 or higher
DOS Plus™

- For systems with multiple hard disks, DOS 3.0 and higher versions are recommended.

Memory

512K

Monochrome Graphics

AT&T Monochrome Card/Monochrome Display (640 x 400)
IBM Color Graphics Adaptor (CGA)/Color Display (640 x 200) - Mono Mode
IBM Enhanced Graphics Adaptor (EGA™)/Monochrome Display (640 x 350)

IBM Vector Graphics Adaptor (VGA™)/Monochrome Display (640 x 480)
Hercules Graphics Card™/Monochrome PC Display (720 x 348)
The GENIUS® Monitor/The GENIUS Monitor Card (720 x 1008)
Wyse®/Amdek Monochrome Graphics Display (1280 x 800)
100% compatible

Color Graphics

AT&T DEB Card/16-color Display (640 x 400)
IBM Enhanced Graphics Adaptor/16-color Display (640 x 350)
IBM 16-Color VGA Card for PS/2 (640 x 480)
Video 7™ Vega™ Deluxe/Quadram® Prosync™ 16-Color Display (640 x 480 and 752 x 410 models)
100% compatibles
Printer

Apple LaserWriter, LaserWriter Plus™, and other Postscript printers
Epson® GQ-3500 Laser Printer
Epson LQ-Series Printers
Hewlett-Packard® LaserJet+™
Hewlett-Packard LaserJet II™
IBM/Epson High Resolution Printers (120 x 144 dots/inch)
Toshiba® 321, 341, and 351
Xerox® 4020 Color Ink Jet

Mouse

IBM Personal System/2 Mouse
Logimouse®
Manager Mouse®
Microsoft® Bus Mouse/generic bus mouse
Microsoft Serial Mouse
Mouse Systems™
PC Mouse™
SummaMouse™
SummaSketch™ 961or 1201 cursor-/stylus-type tablet
Summagrahics ™MM1812 cursor-/stylus-type tablet
Driver Packs

Digital Research offers over a dozen “driver packs,” disks containing drivers for additional devices. These include many popular printers, displays, plotters, scanners, and cameras. If your display/graphics card or printer is not among those listed above, see the GEM/3 Driver Pack Information sheet elsewhere in this package.

Certain hardware manufacturers also supply GEM/3-compatible device drivers. You can contact them directly for driver availability information.
The GEM® Desktop™ and GEM® text and graphics applications make creating high-quality publications and graphics with your computer enjoyable and easy.

GEM/3™ is the latest addition to the GEM applications product line. It offers many new features, yet retains the best of previous versions of the GEM Desktop. New features are outlined in the GEM/3 Desktop Installation Guide.

How to Use this Guide

If you are familiar with the GEM Desktop and want information only about new features, skim Section 10 for an overview of the new version of GEM Output and read Section 13, which presents the GEM Output menus and commands. Also read Section 14 for information about new options for using your printer, plotter, and other output devices.

If you're new to the GEM Desktop but are familiar with graphics applications and mouse techniques, you should read Section 1 and skim through the manual once to get an overall impression of the GEM Desktop. Then read Section 2 to get started, and Sections 4, 5, and 6 for detailed instructions on using the GEM Desktop. Section 9 covers GEM Desktop menus and commands.

If you are using a graphics application for the first time, this manual guides you every step of the way. Simply read each section and follow the instructions. You'll be productive almost immediately and will soon master the GEM Desktop.
What this Guide Contains

Section 1: "Introduction"
This section describes the basic concepts behind the GEM Desktop.

Section 2: "Getting Started"
This section tells you how to start the GEM Desktop.

Section 3: "Getting Acquainted"
This tutorial section introduces you to the mouse techniques you’ll be using in the GEM Desktop and other GEM applications.

Section 4: "Windows"
The GEM Desktop divides your screen into windows. Windows allow you to view the contents of your disks and folders, bring up a desk accessory, and so on. This section describes window components and operations.

Section 5: "Folders"
Folders contain files and other folders. This section describes how you organize your documents or applications in folders.

Section 6: "Icons"
The basic elements in the GEM Desktop—disks, folders, applications, and documents—are shown as icons, or small pictures. This section shows you how to manipulate the icons to perform a variety of tasks.

Section 7: "Applications"
This section discusses software programs, how they relate to the GEM Desktop, and how document types are associated with them. It also describes the Clock, Calculator, and Print Spooler desk accessories.
Section 8: "Dialogs"
The GEM Desktop displays dialogs to provide information or ask for information in connection with an operation that you are performing.

Section 9: "Menus and Commands"
This section explains how to use the GEM Desktop's menus and commands.

Section 10: "GEM Output Overview"
GEM Output is a sophisticated print application that lets you control how your output devices are used.

Section 11: "Starting and Using GEM Output"
This section tells you, in tutorial format, how to start GEM Output, select documents to print, choose the device to do the printing, and begin printing.

Section 12: "Output Lists"
GEM Output lets you create lists for printing multiple documents. You can save these lists for repeated use.

Section 13: "GEM Output Menus and Commands"
The commands in the GEM Output menus are described in this section.

Section 14: "Device Preferences"
This section shows you how to customize the operation of your printer, plotter, or other output device so that documents are produced to your specifications.
Assumptions and Conventions

Unless otherwise stated, the examples in this guide assume your computer has one floppy disk drive (drive A) and a hard disk drive (drive C).

"Mouse" is used generically to refer to the pointing device attached to your computer.

If you don't have a mouse, you can learn how to use your keyboard in place of a mouse by studying the GEM Desktop Keyboard Reference card provided at the back of this guide. Keyboard shortcuts are explained in Section 9.

Some GEM Desktop commands, when they appear in menus, are followed by three dots. These dots indicate that a dialog appears when you choose the command. The Desktop uses dialogs to communicate interactively with you—they provide or request information.
## Contents

1. **Introduction**
   - What Is the GEM Desktop? ............................................. 1-2
   - Who Can Benefit from the GEM Desktop? .......................... 1-3
   - GEM Desktop Terminology ........................................... 1-3
   - What's Next? .................................................................. 1-4

2. **Getting Started**
   - Starting the GEM Desktop ............................................. 2-1
     - Starting from a Hard Disk ......................................... 2-2
     - Starting from Floppy Disks ....................................... 2-2
     - Starting the GEM Desktop Automatically ....................... 2-3

3. **Getting Acquainted**
   - Starting the GEM Desktop ............................................. 3-2
   - Moving the Pointer ...................................................... 3-3
     - Mouse Techniques .................................................... 3-3
   - Selecting an Icon (Clicking) ....................................... 3-4
   - Opening an Icon (Double-clicking) ............................... 3-5
   - Selecting Multiple Icons (Dragging) ............................ 3-5
   - Selecting Multiple Icons (Shift-clicking) .................... 3-7
   - Copying an Icon ......................................................... 3-8
     - Copying Multiple Icons ............................................ 3-8
   - Displaying Menus ........................................................ 3-9
   - Renaming Icons ........................................................... 3-9
   - Deleting Icons ............................................................. 3-10

4. **Windows**
   - Title Bar ...................................................................... 4-1
   - Close Box ..................................................................... 4-4
   - Full Box ........................................................................ 4-4
   - Window Scroll Components .......................................... 4-4
     - Scroll Bar and Slider ................................................. 4-5
     - Scroll Arrows ............................................................ 4-6
     - Summary of Scroll Techniques .................................... 4-6
   - Other Window Operations ............................................. 4-7
     - Display Contents as Text .......................................... 4-7
     - Display Contents in a Different Order ......................... 4-7
     - Save Your Windows .................................................... 4-7
## Contents

### GEM Desktop

**5 Folders**
- Creating a New Folder ............................................ 5-1
  - Folders Inside Other Folders .............................. 5-2
- Copying Folders .................................................. 5-3
- Placing Icons Inside Folders ................................. 5-4
- Deleting Icons .................................................... 5-5
- Deleting Folders .................................................. 5-5
- Renaming Folders .................................................. 5-5

**6 Icons**
- Disk Drive and Folder Icons ................................. 6-1
- Application and Document Icons ............................. 6-2
- Copying Icons ..................................................... 6-3
  - Name Conflicts ............................................... 6-4
- Renaming Icons ................................................... 6-4

**7 Applications**
- DOS Applications .................................................. 7-1
- GEM Applications ................................................ 7-2
- Application and Document Types ............................ 7-3
- Starting Applications .......................................... 7-4
  - Normal Startup ............................................... 7-4
  - Startup with a Specific Document ....................... 7-4
  - OPEN APPLICATION Dialog .................................. 7-5
- Configuring Applications ...................................... 7-5
  - Saving an Application's Configuration .................. 7-8
  - Removing an Application's Configuration ............... 7-8
- Search Paths ...................................................... 7-9
- Desk Accessories .................................................. 7-10
  - Using Desk Accessories ..................................... 7-10
  - Calculator ...................................................... 7-11
  - Clock .......................................................... 7-13
  - Print Spooler ................................................. 7-13

**8 Dialogs**
- Exit Buttons ..................................................... 8-1
- Information Dialogs .............................................. 8-2
- Data Entry Dialogs .............................................. 8-3
9 Menus and Commands

Keyboard Shortcuts ........................................ 9-1
File Menu ...................................................... 9-2
Options Menu .................................................. 9-3
Arrange Menu .................................................. 9-4
DESKTOP Menu .................................................. 9-5
File Menu Commands ........................................... 9-6
  Open Command .............................................. 9-6
  Info/Rename Command ..................................... 9-6
  Format Command .......................................... 9-7
Options Menu Commands ...................................... 9-8
  Install Disk Drive Command ............................... 9-8
  Set Preferences Command ................................ 9-9
  Save Desktop Command .................................... 9-11
Arrange Menu Commands ..................................... 9-12
  Show as Text/Icons Command ............................. 9-12
  Sort by Name Command ................................... 9-13
  Sort by Type Command .................................... 9-13
  Sort by Size Command .................................... 9-14
  Sort by Date Command .................................... 9-14

10 GEM Output Overview

Output Processing Modes .................................. 10-2
  Batch Mode ................................................ 10-2
  Auto Display Mode ....................................... 10-2
Types of Documents You Can Print or Display ......... 10-3
  Non-Graphic Document Reproduction .................. 10-4

11 Starting and Using GEM Output

Starting GEM Output ....................................... 11-1
Printing a Document ....................................... 11-2
  Step 1: Select Document(s) to Print .................... 11-2
  Step 2: Start GEM Output ................................ 11-2
  Step 3: Start Printing ................................... 11-4
  Step 4: Return to GEM Desktop ......................... 11-4

12 Output Lists

Output List Box ............................................. 12-2
Size Box ...................................................... 12-3
Tool Kit Icons .............................................. 12-3
### Contents

Rules for Selecting Documents ............................................. 12-5  
Preselecting Documents ..................................................... 12-5  
Adding Document Names ..................................................... 12-6  
Removing Document Names ................................................. 12-7  
Duplicating Document Names .............................................. 12-7  
Moving Document Names ..................................................... 12-7  
Saving an Output List ...................................................... 12-7  
Opening Output Lists ....................................................... 12-8  
Starting Production ......................................................... 12-9  
ITEM SELECTOR Dialog ...................................................... 12-9  
- Directory Line .............................................................. 12-10  
- Selection Line .............................................................. 12-12  
- Directory Window .......................................................... 12-12  
- Folder Indicators .......................................................... 12-12  
- Directory Window Close Box ............................................. 12-13

**13 GEM Output Menus and Commands**

GEM Output File Menu Commands ............................................. 13-2  
Global Menu Commands ........................................................ 13-3  
Preferences Menu Commands ................................................. 13-3  
- Screen Preferences .......................................................... 13-3  
- Printer/Plotter Preferences .............................................. 13-4  
- Camera Preferences .......................................................... 13-4  
OUTPUT Menu Commands ..................................................... 13-5

**14 Device Preferences**

Global Menu .............................................................................. 14-1  
- GLOBAL PREFERENCES Dialog .......................................... 14-2  
Preferences Menu ............................................................... 14-3  
Screen Preferences .............................................................. 14-3  
Printer and Plotter Preferences ........................................... 14-5  
- Page Preferences ............................................................ 14-5  
- Paper Size Preferences ....................................................... 14-6  
- Paper Tray Preferences ....................................................... 14-7  
- File Redirection Settings ................................................... 14-8  
Camera Preferences ............................................................. 14-9  
- Film ................................................................................. 14-9  
- Color .............................................................................. 14-10
As computers have become increasingly a part of everyday life, both in the workplace and at home, one plaintive question has been asked over and over: "Why are they so hard to use?"

Many would-be computer users are dissuaded by the belief that the secrets of using a computer are accessible only to a select few endowed with special training or a very particular kind of intelligence. They don't think "ordinary people" can use a computer.

The GEM® Desktop™ and the other applications in the GEM® software family are designed specifically to put these fears to rest. They offer a pictorial, visually-oriented alternative to complex computer concepts.

For example, suppose you want to copy a file named TABLE.DOC from one place on a disk to another. Your operating system calls these places subdirectories, and the command for copying this file could take the following form:

```
COPY \ TEXT\ TABLES\ TABLE.DOC \ DOCUMENT\ CHARTS
```

Using your operating system to copy the file requires that you understand the principles of subdirectory hierarchies and the command syntax that will find the file and copy it to the destination you want. If you look to your operating system's manual for help in understanding these concepts, you'll first have to figure out what this means:

```
"COPY [/A][/B][d:] [path] filename[.ext][/A][/B] 
[d:] [path] [filename[.ext][/A][/B][/V]"
```
Using the GEM Desktop, you can do exactly the same thing by moving pictures on the screen. These pictures are called icons, and you use the mouse as an extension of your hand to move the icons about.

To copy TABLE.DOC, you simply move a copy of its icon to the GEM Desktop folder that represents the destination subdirectory. It's just like taking a piece of paper out of one folder on your desk and inserting it into another folder.

What Is the GEM Desktop?

In technical language, the GEM Desktop is an operating system interface, a set of features that determine how you use your computer and its operating system.

Here's a simple example of an interface. If you wear a wristwatch, its interface is either analog (hour hand and minute hand) or digital (a numerical read-out). The net effect of both is the same; they tell you the time. But the two interfaces require different mental processes for reading the time and different mechanical actions for setting the time.

Similarly, you can perform all the basic file operations using the command line or the GEM Desktop. The advantage of the GEM interface is that it presents your actions visually. For example, when you copy a file, you see the file you're copying and the folder to which you're copying it. In this way, the GEM Desktop removes the level of abstraction the command line imposes.
Who Can Benefit from the GEM Desktop?

The GEM Desktop is designed to be productive for first-time and experienced users.

If you're new to computers, the GEM Desktop will help you get started quickly. You can begin working in the GEM Desktop and in your GEM applications without first having to learn the ins and outs of the operating system.

If you're already familiar with your computer's operating system, you'll find that the GEM Desktop offers some features not found there (for example, deleting a subdirectory and its contents in a single step). And if there are some operations you still prefer to initiate from the command line, you can leave the GEM Desktop, use the command line, and return to the GEM Desktop with just a couple of keystrokes.

GEM Desktop Terminology

Like anything unique, the GEM Desktop has a vocabulary of its own. Most of the terms (like "window," "dialog," and "scrolling") are explained later in this guide. If you encounter a term and are unsure of its meaning, look it up in the index.

The GEM Desktop uses three terms—folder, application, and document—that correspond directly to terms used in your operating system.

As noted previously, a folder is the same as a subdirectory.

An application is a program that does work for us or amuses us. This includes word processors, spelling checkers, drawing programs, and games.

GEM Desktop terminology uses "document" as a collective term to describe all other kinds of files. In operating system terminology, these files include data files, overlay files, and other files either associated with or created by an application.
What's Next?

If you haven't already installed the GEM Desktop, do so now—you'll find instructions in the *GEM/3 Desktop Installation Guide*. Then you can move on to the next section of this guide and start using the GEM Desktop!
Getting Started

This section contains the basic information you need to start the GEM Desktop.

Starting the GEM Desktop

How you start the GEM Desktop depends on whether you've installed it on a hard disk or on floppy disks. Instructions for starting from either type of installation follow.

During installation, the GEM Setup program creates a batch file called GEM.BAT and places it in the root directory of the disk on which you have installed the GEM Desktop. GEM.BAT contains the commands you need to start the GEM Desktop. See your operating system manual for a complete description of batch files. GEM Setup is described in the GEM/3 Desktop Installation Guide.
Starting the GEM Desktop

Assuming your hard disk is drive C, type each of the following commands at your operating system prompt (A> or C>):

```
C:\
CD \.
GEM
```

When the GEM Desktop appears on your screen, you're ready to start work. Before you move on to Section 3, you might want to read “Start the GEM Desktop Automatically,” later in this section.

If the GEM Desktop doesn't appear after you enter the GEM command, you probably made an incorrect selection when you installed the software with the GEM Setup program. Review the information you provided on the system information sheet in the *GEM/3 Desktop Installation Guide* and then rerun GEM Setup.

Starting from Floppy Disks

Insert your GEM STARTUP disk in drive A. Turn on your computer or, if it's already on, reboot your operating system. Type this command when your operating system's prompt is displayed:

```
GEM
```

In response to this command, you'll see the following message displayed on your screen:

To run the GEM Desktop, insert your GEM DESKTOP disk in drive A and click on OK or press Enter. To return to DOS, click on Cancel.

Remove your GEM STARTUP disk from drive A and set it aside.
Insert your GEM DESKTOP disk in drive A, close the drive door, and press the Enter key. You see an hourglass icon on your screen, telling you your computer is busy completing your instructions.

In a few moments, the GEM Desktop appears.

If the GEM Desktop doesn't appear after you've inserted your GEM DESKTOP disk, you probably made an incorrect selection when you installed the software with the GEM Setup program. Review the information you provided on the system information sheet in the GEM/3 Desktop Installation Guide and then rerun GEM Setup.

Starting the GEM Desktop Automatically

Every time you load the operating system by turning on your computer or rebooting, it looks for a batch file named AUTOEXEC.BAT. If the operating system finds this file in the root directory of the disk from which it was loaded, it automatically processes the commands contained in the file.

If you want the GEM Desktop to start automatically every time you start your computer, you can:

• create an AUTOEXEC.BAT file that contains the necessary commands
• include the necessary commands in an existing AUTOEXEC.BAT file

Please see the GEM/3 Desktop Installation Guide for directions concerning an AUTOEXEC.BAT file.
Getting Acquainted

This section acquaints you with some basic operations of the GEM Desktop. It's written as a tutorial with accompanying illustrations. Keep in mind that your screen might look a little different from the illustrations because the GEM Desktop is tailored to your specific machine.

The tutorial assumes you have a mouse attached to your computer. If you don't, you'll need the GEM Desktop Keyboard Reference (provided at the end of this manual) to do the exercises.

The tutorial also assumes you have successfully installed the GEM Desktop as described in the GEM/3 Desktop Installation Guide. If you haven't, you won't be able to start the GEM Desktop.

To complete the tutorial exercises, you'll need a floppy disk. You can use your backup copy of the GEM SYSTEM DISK (make sure it's write-protected). If you use a different floppy disk, it should contain at least one but no more than 15 items (files); it should not contain any folders (subdirectories). The disk you use doesn't have to meet these requirements but the instructions will be easier to understand if it does.
Starting the GEM Desktop

In Section 2, you learned that there are several ways to start the GEM Desktop. Refer to that section if you need help with this step.

When the Desktop first appears, it looks similar to the following illustration. We've labeled the components you need to know about for the tutorial. You'll learn more about these and other components in later sections.
Note the two windows that take up most of the screen. The icons in the top window represent the contents of the disk from which you started the GEM Desktop—the example shows hard disk drive C. The icons in the bottom window represent the disk drives on your computer.

**Moving the Pointer**

The pointer moves on the Desktop when you move your mouse. Practice moving the pointer, but for now, stay away from the menu bar at the top of the screen. (If you accidentally make a menu drop down, move the pointer out of the menu into an open area, then press and release the mouse button. If your mouse has more than one button, use the one on the left.)

To move the mouse without moving the pointer, lift the mouse up before moving it.

**Mouse Techniques**

You manipulate the pointer with your mouse, graphic tablet, or keyboard to do a variety of Desktop operations.

If you don't have a mouse, you can move the pointer with your keyboard's arrow keys. If the arrow keys don't work at first, press the Ctrl key. The Ctrl key switches the keyboard in and out of the mode in which the arrow keys control the pointer's movements.

The mouse techniques most commonly used with GEM applications are listed with their keyboard equivalents on the next page.

**Note:** If your mouse has more than one button (most do), use only the button on the left. The GEM Desktop does not respond to input from the other buttons.
Selecting an Icon (Clicking)

Click means press and immediately release the mouse button. You click on an icon to select it. Most GEM applications work on the principle that you first select an object, such as an icon, and then do something to that object either by direct manipulation with the mouse or by choosing a command from a menu.

Select the drive A floppy disk icon by placing the pointer on it and clicking the mouse button. The GEM Desktop highlights the selected icon by placing a bold shadow around it.

Now move the pointer to an open area of the window and click again. This de-selects the icon and the bold shadow disappears.
Opening an Icon (Double-clicking)

*Double-click* means press and release the mouse button twice, quickly. Double-clicking is an easy way to *open* an icon so you can see what it contains. Try the following steps:

1. Insert the floppy disk you chose to use during the tutorial in drive A and close the drive door.

2. Place the pointer on the drive A icon in the bottom window and double-click.

You should see icons in the bottom window representing the items on the disk in drive A. If the icons didn't appear, try double-clicking more rapidly.

You can adjust the speed with which you must double-click by using the **Set preferences** command; see “Options Menu” in Section 9, “Menus and Commands.”

Selecting Multiple Icons (Dragging)

Sometimes you’ll want to select more than one icon at a time. For example, you might want to select several icons so you can copy them all in one operation.

*Drag* means press and hold down the mouse button while you move the mouse. When you drag, you form a “rubber rectangle” that expands and contracts as you move the pointer. When the rubber rectangle touches the icons you want to select (it doesn’t have to completely surround them), release the mouse button. The GEM Desktop highlights the icons you’ve selected.

You can form the rubber-rectangle only by dragging from upper left to lower right.
Important Note: To form the rubber rectangle, you must begin the drag operation with the pointer in an open area of the window. If you start with the pointer directly on an icon, you'll drag that icon. This is another use for dragging described later in this section.

Study the following illustration and then try dragging to select multiple icons:

To de-select all of the icons you just selected, click in an open area of either window.
Selecting Multiple Icons (Shift-clicking)

When you use the drag technique to select icons, you can only select icons that are next to each other. Use the **Shift-click** technique to select icons that are scattered throughout the window. For example, if you want to select only the icons in the top left and bottom right corner, Shift-click is the technique to use.

To shift-click, hold down the Shift key on your keyboard while you click on the icons you want to select. The next illustration shows two icons in the lower window of the Desktop that have been selected by Shift-clicking. Try Shift-clicking on your Desktop to select multiple icons:

![Selection of Icons](image)

To de-select all of the icons you just selected, click in an open area of the window.

To de-select individual icons, Shift-click on those you want to de-select. This is a good way to de-select individual icons from a group selected with the rubber rectangle.
Copying an Icon

To copy an icon, drag it where you want it copied and release the mouse button. The copy’s destination can be a window, folder, file, or disk icon.

You must begin with the pointer directly on top of the icon you want to copy; otherwise, you form a rubber rectangle, as described earlier.

Look at the bottom window and find an icon you want to copy. If you’re using the backup copy of your GEM DESKTOP SYSTEM DISK, use the “GEMSETUP.TXT” icon. (We’ll delete the copy in a later step.) Do not copy a folder icon for this exercise (if one is present).

Place the pointer on the icon you want to copy and drag it to an open area in the top window. Notice that when you drag, the pointer changes from an arrow to a hand.

When you release the mouse button, you’ll see the COPY FOLDERS / ITEMS dialog on your screen:

COPY FOLDERS / ITEMS

Folders to copy: 0
Items to copy: 1

OK Cancel

Place the pointer on the rectangle labeled “OK” (it’s called a button) and click. This starts the copy process.

Copying Multiple Icons

When you use the copy technique just described, the GEM Desktop copies all currently selected icons. For example, if you select several icons and then drag any one of them to the copy destination, you end up with copies of all the selected icons.
Displaying Menus

The GEM Desktop menus contain commands you choose to do things on the Desktop.

Move the pointer up to the left corner of the Desktop and touch the word "File." The File Menu drops down below the menu bar.

Each line in a menu is a command. Some commands are "dimmed" or "greyed out." You cannot choose these dimmed commands because they have no meaning in the context of what you are doing at the time. For example, if no icons are selected when you display the File Menu, the Delete command is dimmed because the GEM Desktop doesn't know what you want to delete.

Slide the pointer along the menu bar. When it touches the other menu titles their respective menus drop down.

We're not ready to choose a command yet, so move the pointer to an open area of the Desktop and click. The last menu you displayed disappears.

Renaming Icons

In an earlier step, you copied an icon. Now you can use one of the File Menu commands to change the copy's name. Following these steps:

1. Click on the icon in the top window that represents the copy you made earlier. (The icon's name is "GEMSETUP.TXT" if you're using the backup of your GEM DESKTOP SYSTEM DISK.)

2. Display the File Menu and place the pointer on the Info/Rename command. Click the mouse button; you'll see a dialog titled "ITEM IN-
FORMATION / RENAME.” This dialog shows you the name of the icon you selected in step 1. The vertical bar at the end of the name is the text cursor.

3. Press the Esc key to erase the icon name and then type:

```
JUNK.AAA _
```

Pressing the Enter key is the same as clicking on the OK button. You should see an icon labeled JUNK.AAA in the top window.

Deleting Icons

To delete the icon you copied and renamed to JUNK.AAA, follow these steps:

1. Select the JUNK.AAA icon by clicking on it.
2. Choose the Delete command from the File Menu.
3. When you see the DELETE FOLDERS / ITEMS dialog, click on the OK button or press the Enter key—if you change your mind and don't want to delete the icon, click on the Cancel button. The GEM Desktop erases the file from your disk and removes the icon from the window.

This completes the tutorial.
When you first start the GEM Desktop, it displays two windows on your screen. The windows allow you to “look inside” things, like a disk or a folder.

Although they probably contain different icons, the two windows are made up of the same components. The following illustration identifies the window components:

![Window Components Diagram]

**Title Bar**

Information in the *title bar* tells you, at a glance, which disk drive and folders you have open, if any.

The steps that follow explain what the title bar information means.
Assume the bottom window on your Desktop looks like the one shown below:

![Disk Drives:](image)

The phrase “Disk Drives:” in the title bar means the window's icons represent your computer’s disk drives—drive A is a floppy disk drive and drive C is a hard disk drive.

Now assume you place a disk in drive A. When you double-click on its icon to open the disk, the bottom window looks like this:

![A:](image)

The title bar now reads “A:" to tell you the window is open to drive A.

Note the folder icon named EXPENSES. As the next illustration shows, if you double-click on this icon, the GEM Desktop opens the folder and displays its contents.
To indicate that you are now in the EXPENSES folder on drive A, the information in the title bar changes to “A:\EXPENSES\.” In the window, there are now three icons for folders that contain monthly expense information.

If you double-click on the FEBRUARY folder icon, your window looks like the one shown next:

The contents of the window and title bar change once again, and so it goes as you continue opening more folders until you find the specific icon you want.
Close Box

Click on the close box to go back to the previous folder you opened. If there is no previous folder, you see disk drive icons in the window.

If you hold down the mouse button while the pointer is on the close box, the effect is continuous.

Full Box

Your windows can be either normal or full size. Click on a window's full box to change from one size to the other.

Expanding a window to full size is useful if the disk or folder contains more icons than the window can show in normal size.

When either window is full size, it covers up the other window.

Window Scroll Components

Sometimes a window (even when expanded to full size) won't be able to display all of the icons the disk or folder contains. When this happens, use the scroll bar, slider, and the scroll arrows to scroll the contents through the window to see the other icons. The next illustration shows the concept of scrolling:
Scroll Bar and Slider

The scroll bar and slider help you move around within a window when it contains more icons than can be displayed at one time. The slider also tells you something about the size of the disk or folder and your current location within it.

If the slider extends the full length of the scroll bar, the window is showing you all of the icons in that particular disk or folder. You can't scroll the window in this case, of course.

If the slider does not extend the full length of the scroll bar, the disk or folder contains more icons than are currently shown in the window. Drag the slider up or down the scroll bar to see the other icons.

If you click on the scroll bar, rather than dragging the slider, the GEM Desktop scrolls one full window of icons at a time. Click above the slider to scroll up and below it to scroll down.

The size of the slider in relation to the scroll bar tells you how much of the disk or folder is visible in the window. For example, if the slider ex-
tends half the length of the scroll bar, the window is showing you half the icons in the disk or folder.

The relative position of the slider inside the scroll bar indicates your position. For example, if the slider is at the bottom of the scroll bar, you are at the bottom of the disk or folder.

Scroll Arrows

The up-arrow is at the top of the scroll bar; the down-arrow is at the bottom. Click on the up-arrow to scroll one line of icons toward the top of the folder and on the down-arrow to scroll one line toward the bottom. Hold the mouse button down for continuous scrolling.

Summary of Scroll Techniques

Here's a summary of how to use the window scroll components:

Click in the scroll bar to scroll one full window of icons in either direction.

Drag the slider up or down to scroll in that direction.

Click on the scroll arrows to scroll one line of icons up or down.
Other Window Operations

The following window operations are described in detail elsewhere in this guide.

Display Contents as Text

You can display disk and folder contents as icons or as text. Read the description of the **Show as icons/text** command beginning in Section 9, “Menus and Commands.”

Display Contents in a Different Order

Use the commands on the Arrange Menu to arrange the window contents in various ways. You can arrange the contents by icon name or type, icon size, or the date the icon was created or last modified. The Arrange Menu is described in Section 9, “Menus and Commands.”

Save Your Windows

If you want your windows and their contents to appear a certain way each time you start the GEM Desktop, read about **Save desktop** under “Options Menu Commands” in Section 9.
Folders

To be consistent with the desktop metaphor, the GEM Desktop provides you with folders. You use the folders much the same way you use them in a file cabinet. That is, you organize your information into different folders so you can locate it quickly and easily when you need it.

(If you are experienced with the DOS operating system, it will help you to know that folders are the same thing as directories and subdirectories.)

When you first open a disk icon and the disk contains folders, you see the folders in the window. Until you open one of the folders, you are in the root directory of that disk. A disk does not have to contain folders, and it can contain icons in the root directory.

Creating a New Folder

Folders are represented on the GEM Desktop by an icon like the one shown here. You can place icons inside folders, remove them from folders, open folders to display their contents, and much more.

The first icon in every window is always a folder named "New Folder" (except when the window displays disk drive icons).
To create a new folder, double-click on the New Folder icon. The GEM Desktop then displays the NEW FOLDER dialog so you can type the name of the folder you are creating:

As you type the folder's name, it appears on the "Name:" line of the NEW FOLDER dialog. The folder's name can be up to eight characters long—you can also use a three character folder type. The optional folder type follows the period in the folder's name.

After you type the folder's name, click on the OK button or press the Enter key. The dialog will be removed from the screen and you'll see an icon for the new folder appear in the current window. Another New Folder icon replaces the one you just used, so you always have a "new folder” available.

Folders Inside Other Folders

Up to a certain point, you can place folders inside other folders. For example, assume you have a disk containing a folder named TAXES-87 and you want to create folders named EXPENSES and INCOME inside the TAXES-87 folder. Here are the steps:

1. With your disk drive icons visible in the window, place the disk containing the TAXES-87 folder in drive A and double-click on the disk drive icon to open its window. You see your TAXES-87 folder in the window.

2. Double-click on the TAXES-87 folder. Its contents appear in the window. You also see a folder labeled New Folder at the top-left corner of the window.

3. Double-click on the New Folder icon. The NEW FOLDER dialog appears. Name your new folder “EXPENSES.”
4. Repeat the previous step, only this time name your new folder "INCOME."

5. Click on the window's close box to move back into the TAXES-87 folder. You'll see the two new folders, EXPENSES and INCOME, in your window.

Note: DOS limits the number of folders you can place inside other folders. The limiting factor is the number of characters in the combined folder names. When you combine all of the folder names into one string, the string cannot contain more than 63 characters (including backslashes). The string can contain a disk drive identifier (for example "A:"), in which case it can be up to 65 characters long.

Copying Folders

The basic method for copying a folder and its contents is to drag the folder's icon to the place where you want the copy created. However, your results vary depending on several different factors.

If you drag a folder icon to an open area of the same window, you create a "name conflict" because, in most cases, you cannot have two folders with the same name. If you attempt to do this, the GEM Desktop asks you to enter a different name for the copy you are making. For details, read "Name Conflicts" in Section 6.

If you drag a folder icon on top of another folder icon and the two have different names, the GEM Desktop places the first folder icon and its contents inside the destination folder icon. For example, assume you have two folders named EXPENSES and PAYROLL. You drag the PAYROLL folder icon on top of the EXPENSES folder icon and release the mouse button. If you then open the EXPENSES folder icon, you'll see the PAYROLL folder icon inside. The original PAYROLL folder icon still exists and both PAYROLL folders have identical contents.

If you drag a folder icon on top of another folder icon and the two have the same name, the GEM Desktop copies only the contents of the first
folder into the second. For example, assume you have folders named EXPENSES on both your hard disk and on a floppy disk. You drag your EXPENSES folder icon from the floppy disk on top of your EXPENSES folder icon on your hard disk and release the mouse button. If you then open the EXPENSES folder icon on your hard disk, it has its original contents plus whatever was in the EXPENSES folder icon on your floppy disk. You will not, however, see a new EXPENSES folder icon inside of your original EXPENSES folder.

Placing Icons Inside Folders

One way to place an icon (document, application program, or existing folder) inside a folder is to drag the icon on top of the folder's icon. When the destination folder icon is highlighted, release the mouse button.

For example, assume you have an icon named PAYROLL.RPT (Payroll Report) you want to place inside your EXPENSES folder. With the EXPENSES folder visible in your window, drag the PAYROLL.RPT icon on top of the folder icon. When the EXPENSES folder icon is highlighted, release the mouse button.

Another way to place an icon inside a folder is to open the folder and drag the icon inside the folder's window.

Both of these operations place a copy of the icon in the destination folder—the original icon still exists.
Deleting Icons

Follow these steps to delete an icon from a folder:
1. Double-click on the folder's icon to open its window.
2. Select the icon you want to delete by clicking on it.
3. Choose the **Delete** command from the File Menu.

To delete multiple icons in a single operation, use the Shift-click or drag technique to select the icons before you choose the **Delete** command.

Deleting Folders

Follow these steps to delete a folder:
1. Select the folder or folders you want to delete.
2. Choose the **Delete** command from the File Menu.

When you delete a folder, you also delete **all** of the icons it contains, including other folders and their contents.

Renaming Folders

You cannot directly rename a folder, but you can do the following:
1. Create a new folder.
2. Copy the icons from the old folder to the new one.
3. Delete the old folder.
Icons

Icons are pictures of items you use with the GEM Desktop. A different style of icon represents each of the following different types of items:

- Disk drives
- Folders
- Applications
- Documents

Disk Drive and Folder Icons

Disk drive icons (like the ones shown at the left) are labeled with their corresponding drive identifier letters: A, B, C, etc. If the disk drive icons shown on your Desktop do not exactly match your computer system, use the Install disk drive command (described in Section 9, "Menus and Commands") to make the necessary additions or deletions. You can also use this command to change drive identifier letters and icon labels.

Folder icons are labeled with the folder name you provide when you create the folder. Folders always appear as the first icons in a window and are always in alphabetical order, regardless of how the other icons in the window are arranged. The folder's name appears in the window title bar when you open the folder. For more information about folders, see Section 5.
Application and Document Icons

Application and document icons are labeled with their name (up to eight characters) followed by a type identifier (up to three characters). The name and type are separated by a period (.)

The next figure shows the icon set that represents different types of applications and the documents they create. In each set, the icon on the left represents a type of application; the one on the right represents the document it creates.
Note the "Generic" icons in the preceding figure. Unless you tell the Desktop to use a different set of icons to represent an application and its documents, the generic icons are used. You can use the Configure application command (described in Section 7) to select a different set of icons to represent an application and its documents.

Copying Icons

Follow these steps to copy an icon:

1. Select the icon you want to copy. If you want to copy more than one icon, Shift-click to select the ones you want.

2. Drag the icon or any single icon in a group to the place you want to store the copies. You can drag to an open area of a window, directly to a disk icon, or directly to a folder icon.

3. When the COPY FOLDERS / ITEMS dialog appears, click on the OK button to start the copy process. (You can bypass the dialog using the Set preferences command on the Options Menu.)

For the description of how to remove icons from the Desktop, see "Deleting Icons" in Section 5.
Name Conflicts

You cannot have two icons with the same name in the same folder or in the root directory of a disk. If you attempt to do this, the NAME CONFLICT DURING COPY dialog appears:

![NAME CONFLICT DURING COPY]

Click on the dialog button that matches the action you wish to take:

- **OK**: Click on this button after you enter a name for the new copy you are making. You can use the Esc key to erase the “Copy's” name completely before typing a new one.

- **Cancel**: Click on this button to cancel copying the current icon. If you're only copying one icon, it cancels the copy operation. If you're copying multiple icons, the copy operation continues with the next icon.

- **Stop**: Click on this button to stop the entire copy operation.

Renaming Icons

Disk drives can have both names and identifying letters. You can use the **Install disk drive** command (Section 9) to change the drive name and/or identifier letter.
Disk drive names can be anything you want them to be. The GEM Desktop, by default, names them "Floppy Disk" or "Hard Disk".

Typically, the letters A and B identify floppy disk drives; the letters C and D identify hard disks.

You cannot directly rename a folder icon. See "Renaming Folders" in Section 5 for details.

Here's how to rename an application or document icon:

1. Select the icon you want to rename.
2. Choose the Info/Rename command from the File Menu.
3. When the ITEM INFORMATION / RENAME dialog appears, press Esc to erase the icon's name from the dialog.
4. Enter the name and type you want and then click on OK or press Enter. (Read "Name Conflicts" earlier in this section for restrictions on the new name you enter.)

If you rename either an application or a document that has been "configured," you might be breaking the association between the two. See "Configuring Applications" in Section 7 for details.
Applications

Applications are software programs you run on your computer to create and process information. The GEM Desktop classifies applications into two categories:

• DOS Applications
• GEM Applications

DOS Applications

Applications in this category are usually character-based. That is, they don't use the basic components typical in the GEM Desktop, such as drop-down menus, icons, and a mouse pointer. Examples of DOS applications include the following:

• Lotus® 1-2-3®
• MicroPro® WordStar®
• Ashton-Tate® dBase®

With very few exceptions, you can run any DOS application from the GEM Desktop. Instructions for starting and configuring DOS applications follow later in this section.
GEM Applications

Digital Research® and other software development companies publish GEM applications. These applications use a graphics-based interface, optional pointing device, drop-down menus, and other GEM Desktop-type features. GEM applications published by Digital Research include:

GEM®Desktop Publisher™
A publishing program you use to produce illustrated brochures, pamphlets, newsletters and other documents.

GEM® Draw Plus™
A graphics program you use to create “object-based” pictures (circles, lines, rectangles, text, and so forth).

GEM® First Word Plus™
A full-featured word processing program with the ability to merge graphics-based pictures with text.

GEM® Graph™
A graphics program that translates information (numbers, statistics, etc.) into pie charts, bar charts, line graphs, and so forth.

GEM® Paint™
A graphics program you use to create “pixel-based” pictures. (Pixels are the individual dots that form images on your screen.)

GEM® Scan™
An image scanning and editing program that connects your scanner to your personal computer. With GEM Scan, you can include photographs, drawings, and other printed images in your documents.

GEM® WordChart™
A text-based program you use to create charts, signs, presentation foils, and overhead projections. You can subsequently add graphics to your charts with GEM Draw Plus.
Application and Document Types

Applications and documents all have names. The name appears beneath the icon when it is displayed in a window. The name can contain up to eight characters.

Applications and documents also have a type, which follows the name. The type can contain up to three characters. A period (.) separates the name and the type. Here are some examples:

**DRAW.APP** The name of the icon is DRAW (for GEM Draw Plus) and its type is APP (indicating a GEM application).

**INCOME.GRF** The name of the icon is INCOME and its type is GRF; this is a graph-type document created with GEM Graph.

**WS.COM** The name of the icon is WS (for WordStar) and its type is COM (indicating a DOS application). DOS applications also use type EXE.

Applications are of the following types:

- **APP** (GEM applications)
- **BAT** (batch files)
- **COM** (command files—DOS applications)
- **EXE** (executable files—DOS applications)

You can't run an application from "within" the GEM Desktop unless it's one of these types.

Documents can be any type that you or the application program want them to be.
Starting Applications

You have several ways of starting applications under the GEM Desktop.

Normal Startup

The most common ways of starting an application are:

• double-clicking on the application's icon

• selecting the application's icon and then choosing the **Open** command from the File Menu

If you use either of these methods to start a DOS application, you might see the OPEN APPLICATION dialog, which is explained later in this section.

Startup with a Specific Document

You can start an application and have it immediately load a particular document. To start an application this way, do either of the following:

• double-click on the icon that represents the document you want loaded

• click on the document's icon to select it and then choose the **Open** command from the File Menu

Before you can start a GEM or DOS application this way, however, it must meet the following requirements:

• You must "configure" the application. (This process is described later in this section.)

• You must have specified the document's type in the CONFIGURE APPLICATION dialog.

• If the application is a DOS application, it must be one that lets you name a document when you start the program.
The application and the document must be in the same folder, or the application must be in a “search path.” (Search paths are described later in this section.)

**OPEN APPLICATION Dialog**

Some DOS applications let you specify the name of a document you want to use, or enter parameters that control how the application operates. If you configure the application as this type (see “Configuring Applications” next in this section), the OPEN APPLICATION dialog appears when you start the application from the GEM Desktop:

```
OPEN APPLICATION

Name: _______.
Parameters: ____________________________

Enter the name of the document you want to load, or enter parameter values that are acceptable to this application.  [OK]  [Cancel]
```

You can enter a document name or program control parameters in the Parameters field. (Refer to the application's manual to find out what you can enter.)

**Configuring Applications**

When you configure a DOS or GEM application, you're telling the GEM Desktop how you want the application to run. You can also choose a different icon to represent the application and its documents.
Note: GEM applications published by Digital Research have an application named INSTALL.APP on the product disk. When you run this program, it configures the application for you. See your application manual for instructions.

You configure an application by completing the CONFIGURE APPLICATION dialog, shown in the following illustration:

Here's how to configure an application:

1. Click on the application's icon to select it. The application's type must be APP, BAT, COM, or EXE. (PAINT.APP, WS.COM, and 123.EXE are examples.)
If an application is already configured and you want to reconfigure it, you can either click on one of its document icons or on the application's icon.

2. Choose the **Configure application** command from the Options Menu to display the CONFIGURE APPLICATION dialog.

3. In the "Document type" fields, enter the document types you want to associate with the application. For example, you might want to associate document types DOC and TXT with documents you create with your word processing application. You can enter as many as eight types. Use the Tab key, Shift-Tab keys, or the mouse pointer to move between fields.

If the application automatically assigns a type to its documents, enter that type here. For example, Lotus 1-2-3 versions 1 and 1A produce documents with a WKS type. Check the application's manual to see if it assigns a type to its documents.

If the application doesn't automatically assign a type, enter one or more of your own choosing. Be sure you give this type to any documents you create with the application.

If you associate the same document type with more than one application, the GEM Desktop recognizes **only the last one you configure**.

4. Click on the button following the "Application type" message to identify the kind of application you're configuring: GEM, DOS, or "DOS-takes parameters".

If you're configuring a DOS application that lets you enter a document name or other parameters when you start the program, click on the "DOS-takes parameters" button. When you start a DOS application of this type, the OPEN APPLICATION dialog appears, as described earlier in this section.

5. Some applications, such as a spreadsheet program, might require a lot of memory to operate. If you are configuring an application of this type, click on the Yes button following the "Needs full memory?" message.
If you click on the Yes button, the GEM Desktop operates in “step-aside” mode when you start the application. In this mode, all but the essential parts of the Desktop temporarily leave memory to make as much room as possible available to the application. Because this slows down Desktop operations, you should only indicate that the application “Needs full memory” if this is truly the case. See your application manual.

6. In the “Icon type” window, you see the application and document icons the GEM Desktop currently uses to represent these items. If you don’t want to use a different set of icons, skip ahead to step 7.

The window contains a scroll bar, slider, and scroll arrows, just like a Desktop window. Scroll the window contents until the window displays the set of icons you want to use. If none of the icons suits you, leave the “Generic” icons in the window.

7. When everything in the CONFIGURE APPLICATION dialog is set the way you want, click on the Install button. If you want to leave the dialog without making any changes, click on the Cancel button.

Saving an Application’s Configuration

When you configure an application, it remains configured only until you stop the GEM Desktop unless you use the Save desktop command to save the configuration. Be sure to read the description of Save desktop in Section 9 before you use the command; it also saves other settings that affect the operation of the Desktop.

The GEM Desktop limits the number of applications you can configure to about fifty.

Removing an Application’s Configuration

Removing an application's configuration breaks the association between the application and any document types you specified in the CONFIGURE APPLICATION dialog. Once you remove the configuration, you can’t
start the application by opening one of its documents. Furthermore, the GEM Desktop uses the generic set of icons to represent the application and its documents. However, you can still start the application by opening its icon.

Follow these steps to remove an application's configuration:

1. Select the application's icon.
2. Choose the **Configure application** command from the Options Menu.
3. When the CONFIGURE APPLICATION dialog appears, click on the **Remove** button.

**Search Paths**

A "search path" tells the GEM Desktop where to look for an application when you open a document icon.

Unless you change it, the GEM Desktop goes through a standard search path to find your applications. The standard search path includes the following:

1. the folder or the root directory where the document icon you opened is located (the "current" folder)
2. the GEMAPPS folder on the disk where your GEM software is located
3. the GEMSYS folder on the disk where your GEM software is located
4. the root directory of the disk where your GEM software is located

If you want the GEM Desktop to search other locations before searching the GEMAPPS and GEMSYS folders, you can insert a DOS **Path** command in your AUTOEXEC.BAT or GEM.BAT document. Refer to your DOS operating system manuals for complete instructions.
Desk Accessories

Desk accessories are a special type of application. The GEM Desktop comes equipped with clock, calculator, and print spooler desk accessories. Other desk accessories are available from Digital Research and other software development companies.

Desk accessories are unique because you can run them at the same time you're running other GEM applications. For example, if you're using GEM Draw Plus and want to make some calculations for your picture, you can use the calculator desk accessory without leaving the GEM Draw Plus application.

Using Desk Accessories

You start every desk accessory the same way—by choosing its name from the DESKTOP Menu.

(To start a desk accessory from a GEM application, you make your choice from a different menu, although the menu is always located in the same place as the DESKTOP Menu. See the application's manual for details.)

Desk accessories appear in their own window on the GEM Desktop. All desk accessory windows have a title bar and a close box.

If you click in a Desktop window while a desk accessory is on your screen, the accessory's title bar dims and the accessory goes behind the Desktop windows. If you click on the visible part of the accessory, it comes back in front of the windows and is active again.

It is possible for a desk accessory to be entirely covered by a Desktop window. If this happens, choose the accessory again from the DESKTOP Menu to bring its window back on top of the Desktop windows.

You can use the accessory's title bar (while the accessory is active) to drag it to a different location.
If you are using several desk accessories at the same time, only one can be active. To put an accessory away, click on its close box.

Calculator

The GEM Desktop calculator resembles a standard calculator.

You “press” the calculator’s keys with the mouse pointer or keyboard keys in the following ways:

• Click on any of the keys with the mouse button.
• Enter numbers using your keyboard's standard number keys or the numeric keypad.

If typing on the numeric keypad moves the pointer rather than entering numbers, press the Ctrl key to take the keypad out of its cursor control function. If you still can’t enter numbers, press the Num Lock key.

You can use the keyboard keys for all remaining functions. For example, you can either click on the “+” key or type the “+” character. Similarly, you can either click on the “M+” key or type the “M” and “+” characters.

The “+\-” key on the calculator changes the sign of the amount in the value window to its complement. The keyboard equivalent for this function is a back-slash (\).
**Memory Keys**

You can use the memory keys (M+, M-, MR, and MC) to add, subtract, recall, and clear values from a memory location in your calculator.

**M+** Adds the amount in the value window to memory. A small “M” appears at the left side of the window to let you know you have stored a result.

**M-** Works like M+ except that it subtracts the value from memory.

**MR** Recalls the present value from memory and displays it in the value window.

**MC** Clears the value from memory. It does **not** clear the value from the value window, so you can use it in further calculations.

**EC and C Keys**

**EC** Clears your last entry from the value window. You can continue your current calculations.

**C** Clears the value window and terminates your current calculations.
Clock

When you choose the Clock desk accessory, the GEM Desktop displays the first window shown below:

To reset the time or date in the clock, you must change each individual value (hour, minute, month, day, and year) separately.

For example, to reset the hour, begin by clicking on it. Then type two digits to set the hour; that is, type "01" rather than just "1".

Click on “am” or “pm” to toggle between the two.

The clock has an alarm. Follow these steps to set it:

1. Click on the mode indicator. It changes from a clock symbol to a bell to let you know the clock is now in alarm mode.

2. Set the time you want the alarm to sound by changing the hour, minute, and “am/pm” indicator as explained above for resetting the time.

3. Click on the musical note at the far right side of the clock to turn the alarm on. When the musical note is dimmed, the alarm is not set.

Print Spooler

The Print Spooler accessory prints documents in the background, that is, while you are using the computer for other purposes.

The Print Spooler uses a print queue to start and control background printing jobs. A print queue is an ordered list of the documents waiting to be printed.
With the Print Spooler you can:

- add or delete names in the print queue while documents are printing in the background (see “Print in background” on page 14-8.)

- send a file from the GEM Desktop or a GEM application and begin printing immediately, bypassing GEM Output. However, this method works only with “pure ASCII” files. See “Non-Graphic Document Reproduction” in Section 10 for more information.

**Background Printing**

If you choose the **Print Spooler** accessory from the GEM Desktop or from a GEM application, the Print Spooler window appears. This window lists the documents currently being printed in the order they are being printed.

**Adding a Name to the Print Queue**

First click on the **Add Name** button and when the ITEM SELECTOR appears, enter a document name. This name is added to the queue. See page 12-9 for more information.

Printing is suspended while the ITEM SELECTOR is displayed on your screen.

**Deleting a Name from the Print Queue**

Click on the document name you want to delete, then click on the **Delete Name** button.

**Note:** If you delete the name of a document that is currently printing, printing stops, the paper advances to the top of the next page, and printing resumes with the next document in the print queue.

You can add and delete names as long as the print spooler is active. To close the print spooler, click on the close box.
Dialogs appear on your screen when the GEM Desktop needs to communicate with you. The dialog conveys information you need or asks you for information the GEM Desktop needs to complete your instructions. Dialogs are of two types:

- information
- data entry

Before discussing the dialog types, we'll describe exit buttons, a component found in all dialogs.

Exit Buttons

Every dialog has at least one exit button. In its simplest form, an exit button provides a way to remove a dialog from your screen.

The dialog in the next illustration has one exit button labeled “OK.”

This disk does not have enough room for the information you are trying to copy. Some items, however, may have been copied to the disk.

After reading the dialog's message, put the pointer on the exit button and click. The dialog disappears and you can resume work where you left off.
Many dialogs contain more than one exit button. Each button may provide a different option as to what to do about the situation.

The next dialog illustrated has two exit buttons, “Cancel” and “Retry.”

![Dialog]?

Drive A: is not responding. You must [Cancel] use the right kind of disk, insert it correctly, and close the door. If the problem is with a hard disk, check the disk's connections.

Note that the “Retry” button has a heavier border than the “OK” button. When an exit button has a thick border like this, pressing Enter is the same as clicking on that button.

Information Dialogs

Information dialogs enable the GEM Desktop to obtain or provide information. An example of an information dialog is the one you see when you choose the Info/Rename command after selecting a folder icon. This dialog is shown below:

![Folder Information]

Folder name: [FONTS___.__] Created: 10-20-87 04:23 pm
Number of folders: [____0]
Number of items: [___12]
Bytes used: [___39526]

[OK]

Many information dialogs contain only one exit button. After you read the message, click on the exit button to remove the dialog and continue your work.
Some information dialogs warn you of a problem that has occurred or might occur if you continue what you are doing. Most dialogs of this type contain one of the following icons:

This icon indicates you should make note of the message inside the dialog and then continue with your work.

This icon means that if you continue what you are doing, you could run into a problem. These dialogs usually contain a “Cancel” exit button so you can abort the procedure if necessary.

This icon usually means you should stop what you are doing because an error has occurred.

(The foregoing are general descriptions of how these icons are used. In practice, you may see them used differently.)

Data Entry Dialogs

Data entry dialogs appear when the GEM Desktop needs information from you to complete an operation.

Most data entry dialogs contain areas where you type the required information. These areas are called data entry fields. The dialog might also ask you to enter the information by clicking on various buttons. (These are not exit buttons, in most cases.) For example, if you select a document icon and then choose the Info/Rename command, you see the ITEM INFORMATION / RENAME dialog, as shown on the next page.
The ITEM INFORMATION/RENAME dialog is a combination information and data entry type; it contains some information you can change and some you can't.

The "Name" field is a data entry field, as indicated by the text cursor (a vertical bar) at the end of the field. The field contains the name of the icon you selected.

Press the Backspace key to move the text cursor back one space at a time and erase that character. Press the Esc key to erase all characters in the field.

You can enter information only in the field where the text cursor is located. To move the text cursor to a different field, place the pointer anywhere in the field and click. If the text cursor doesn't appear in the field, you cannot enter information.

The next two fields in the dialog ("Size in bytes" and "Last modified") are not data entry fields. You can't change the information they contain.

Next to the "Attributes" message are two buttons labeled "Read/Write" and "Read/Only." These are also data entry fields, because they allow you to enter information about an icon. If you click on the Read/Write button, it tells the GEM Desktop you will allow the document to be read from and written to the disk. If you click on the Read/Only button, the document can be read but information cannot be written into it nor can it be deleted.
Buttons like Read/Write and Read/Only are similar to buttons on a car radio because you can select only one at a time. When you select one, the other "toggles" off and becomes de-selected. You'll see these types of radio buttons in various other dialogs.

At the bottom of the dialog are the exit buttons. If you make a change in the dialog, click on the OK button (or press Enter) and the GEM Desktop saves your changes. If you don't make any changes, or if you make changes but don't want them saved, click on the Cancel button.

The following table lists the keys you can use to move the text cursor and enter information in data entry dialogs.

<table>
<thead>
<tr>
<th>Key</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Moves the text cursor left one character at a time without deleting</td>
</tr>
<tr>
<td>→</td>
<td>Moves the text cursor right one character at a time without deleting</td>
</tr>
<tr>
<td>↓ or Tab</td>
<td>Places the text cursor in the next data entry field</td>
</tr>
<tr>
<td>↑ or Shift-Tab</td>
<td>Places the text cursor in the previous data entry field</td>
</tr>
<tr>
<td>Del</td>
<td>Deletes the character to the right of the text cursor</td>
</tr>
<tr>
<td>Backspace</td>
<td>Deletes the character to the left of the text cursor</td>
</tr>
<tr>
<td>Esc</td>
<td>Erases all characters from the data entry field</td>
</tr>
</tbody>
</table>

Note that except for Esc, a key's effect is continuous while you keep it pressed.
Menus and Commands

When you place the pointer on one of the titles in the menu bar (File, Options, Arrange, or DESKTOP), a menu drops down. These menus list the commands you can use to make things happen on the GEM Desktop. While a menu is visible, move the pointer through it to highlight each of the commands. To choose a command, highlight the one you want and click.

This section describes the commands that appear in each GEM Desktop menu. Pictures of the menus follow with brief descriptions of each command. Page references tell you where to find additional information about a command.

Keyboard Shortcuts

Some menu commands have a keyboard shortcut; typing a certain sequence of keys is the same as using the pointer to display a menu and choosing a particular command.

If a command has a keyboard shortcut, you see the key sequence indicated at the right side of the menu, opposite the command. For example, opposite the Info/Rename command in the File Menu is a diamond symbol (♦) followed by the letter “I.” The diamond symbol represents your keyboard’s Alt key. Holding down the Alt key while typing “I” is the same as displaying the File Menu and choosing Info/Rename.
## File Menu

Opens the currently selected icon (page 9-6).

<table>
<thead>
<tr>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open</strong></td>
</tr>
<tr>
<td><strong>Info/Rename...</strong> ▼I</td>
</tr>
<tr>
<td><strong>Delete...</strong> ▼D</td>
</tr>
<tr>
<td><strong>Format...</strong></td>
</tr>
<tr>
<td><strong>To Output</strong> ▼U</td>
</tr>
<tr>
<td><strong>Exit to DOS</strong> ▼Q</td>
</tr>
</tbody>
</table>

- **Open**
  - Shows you information about the currently selected icon. If an application or document icon is selected, you can rename it (page 9-6).

- **Info/Rename...** ▼I
  - Deletes all currently selected icons. Once deleted, you cannot recover them.

- **Delete...** ▼D
  - Formats your currently selected floppy disk (page 9-7).

- **To Output** ▼U
  - Starts the GEM Output application (see Section 10).

- **Exit to DOS** ▼Q
  - Stops the GEM Desktop and returns you to your operating system.
Options Menu

- **Install disk drive...**
  - Adds or removes a disk drive icon on the GEM Desktop (page 9-8).

- **Configure application...**
  - Lets you specify how you want an application to work with the GEM Desktop (page 7-5).

- **Set preferences...**
  - Lets you specify how you want some aspects of the GEM Desktop to work (page 9-9).

- **Save desktop**
  - Saves your current preferences and window arrangement for the GEM Desktop (page 9-11).

- **Enter DOS commands**
  - Lets you to enter commands at your operating system prompt without stopping the GEM Desktop. Type: 
    
    `EXIT` + Enter

    at the prompt to return to the GEM Desktop.
Arrange Menu

This command “toggles” between **Show as text** and **Show as icons**. Use it to specify how you want information to appear in your windows (page 9-12).

- **Sort by name**  
  Sorts the information in a window by icon names (page 9-13).

- **Sort by type**  
  Sorts the information in a window by icon types (page 9-13).

- **Sort by size**  
  Sorts the information in a window in descending order according to the size of the icon in bytes (page 9-14).

- **Sort by date**  
  Sorts the information in a window according to the date the icon was created or last changed (page 9-14).
DESKTOP Menu

Shows you information about the GEM Desktop, such as its version number, author names, and copyright information.

Please read "Desk Accessories" in Section 7 for complete details on choosing and using accessories.
File Menu Commands

Open Command

The results of the **Open** command depend on the type of icon that is selected when you choose the command. The following table describes what happens for each type of icon:

<table>
<thead>
<tr>
<th>Icon Type</th>
<th>Command Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk icon</td>
<td>Displays the disk's contents in the window.</td>
</tr>
<tr>
<td>Folder icon</td>
<td>Displays the folder's contents in the window.</td>
</tr>
<tr>
<td>Application icon</td>
<td>Starts the application on your computer.</td>
</tr>
<tr>
<td>Document icon</td>
<td>If you have configured the application that created this document, the application starts and opens to the document you've selected. If you have not configured the application, the GEM Desktop displays a dialog that tells you the selected document type is not configured to work with a specific application.</td>
</tr>
</tbody>
</table>

Info/Rename Command

When you choose this command, you see one of three dialogs, depending on what type of icon is currently selected.

**Disk icon:**

![DISK INFORMATION]

- Drive identifier: C:
- Disk label: GEM DISK
- Number of folders: 31
- Number of items: 482
- Bytes used: 6571739
- Bytes available: 1290240

OK
Folder icon:

```
FOLDER INFORMATION

Folder name: GEMSYS_
Created: 10-20-87 04:23 pm
Number of folders: 0
Number of items: 13
Bytes used: 250071
```

Application or Document icon:

```
ITEM INFORMATION / RENAME

Name: OUTPUT .APP
Size in bytes: 71840
Last modified: 11/02/87 05:44 pm
Attributes: Read/Write Read-Only
```

Format Command

To format a floppy disk, do the following:

1. Insert the disk you want to format in one of your floppy disk drives.
2. Click on the Desktop icon for the drive that contains the disk you want to format.
3. Choose the **Format** command from the File Menu.

**Note:** The GEM Desktop does not allow you to format a disk that has a hard disk icon.
Options Menu Commands

Install Disk Drive Command

Use this command to make the disk icons shown on the GEM Desktop exactly match your computer system. Follow these steps to add a new disk drive icon, change an icon's label or drive identifier, or remove an existing icon:

1. Click on one of the existing disk drive icons on the GEM Desktop.

2. Choose the **Install disk drive** command from the Options Menu. The INSTALL DISK DRIVE dialog appears.

3. If you are removing the disk drive icon, click on the “Remove” button; you'll return to the GEM Desktop.

4. Type the letter you want to use to identify the disk drive. Normally, floppy disk drives use the identifying letters “A” and “B.” Hard disk drives use the letters “C” and “D.”

5. You can also change the icon's label and specify its type as Floppy Disk or Hard Disk using this dialog.

6. When all of the information in the dialog is correct, click on the “Install” button. You return to the GEM Desktop and the new disk drive icon appears.

If you want to make your changes a permanent part of the GEM Desktop, use the **Save desktop** command to save them. Be sure to read about **Save desktop** later in this section before using it—the command saves other settings that affect the operation of the Desktop.
### Set Preferences Command

When you select this command, the GEM Desktop displays the SET PREFERENCES dialog:

![SET PREFERENCES](image)

Click on the preferences you want as explained below:

**Confirm deletes?**

"Yes" tells the GEM Desktop to always display the DELETE FOLDERS / ITEMS dialog when you do a delete operation. "No" tells the GEM Desktop to bypass the dialog and begin the delete operation immediately without waiting for your confirmation.

**Confirm copies?**

Same as "Confirm deletes?" except that it pertains to copy operations.
Confirm overwrites  "Yes" tells the GEM Desktop to always display the NAME CONFLICT DURING COPY dialog when the copy operation you are about to perform will cause an existing document to be overwritten. This setting warns you that the information in a previous version of a document may be lost if you continue with the copy operation.

If you select "No," the dialog is not displayed and the copy operation is performed without your confirmation.

Double-click speed  Sets a relative speed for how quickly you must double-click the mouse button.

To drop down menus  Select "Click" if you want the GEM Desktop menus to drop down from the menu bar only when you place the pointer on a menu name and click the mouse button.

Select "No click" if you want the menus to drop down when the pointer touches the menus' names. This is the standard or "default" setting.

Sound effects  "On" causes the GEM Desktop to sound the audible beeper on your system under certain conditions. "Off" suppresses the audible beeper in all cases.

Time format  The "12 hour" preference displays time in an am/pm format; for example, 3:00 am or 3:00 pm. The "24 hour" preference displays time in a military or international format; for example, 0300 or 1500 hours.

Date format  This preference is for internationalization of dates. You can display the date in the format MM/DD/YY (02/14/86) or YY/MM/DD (86/02/14).
After setting the preferences the way you want, click on OK to return to the GEM Desktop. Your preferences take effect immediately and remain so until you quit the GEM Desktop. If you don't make any changes or do not want to save those you have made, click on the Cancel button.

If you want to make your preferences a permanent part of the GEM Desktop (that is, so they take effect every time you start the Desktop), use the Save desktop command to save them. However, read the following description of the command before using it because it also does other things.

Save Desktop Command

This command tells the GEM Desktop to remember how you currently have the Desktop set up to operate, and to always start the Desktop as you now have it. You can use the command at any time and it remembers the following Desktop characteristics:

- the current size of the Desktop windows
- the object currently opened into each Desktop window; for example, if one of the windows is displaying the contents of disk drive A when you save the Desktop, it displays the contents of that drive every time you start the GEM Desktop, assuming there is a disk in the drive
- the way you currently have any applications configured (see “Configuring an Application” on page 7-5 for details)
- the current arrangement of disk drive icons on the GEM Desktop (see the description of the Install disk drive command on page 9-8 for more information)
- your current preference settings (see the description of the Set preferences command immediately preceeding this command description)
Arrange Menu Commands

Show as Text/Icons Command

You can display window contents in text form as well as in icon form. The text display provides additional information about the icons in the window. The following illustrations show the differences in the two types of displays:
Sort by Name Command

This command arranges the icons in each window by their names.

Sort by Type Command

This command arranges the icons in each window by their types.
Sort by Size Command

This command arranges the files in each window by their size in bytes. The largest files are listed first.

Sort by Date Command

This command arranges the files in each window according to the date they were created or last modified. Files with the most recent dates appear at the beginning of the list.
GEM Output is a versatile application that gives you control over how your documents appear on your printer, plotter, screen, or other output device. The output list feature organizes separate documents or graphics into a sequence that you can save as a file—useful for demonstrations and presentations. GEM Output allows you additional control over the placement of text or graphics on the screen or on the page. You can also redirect your output and capture it in a file which you can transport to another system or send over a network for production on a remote device.

GEM Output is supplied under the name OUTPUT.APP. In the GEM Desktop, it's represented by the icon shown here. The installation program GEM Setup places OUTPUT.APP in the GEMAPPS folder on either your hard disk or your GEM DESKTOP floppy disk. GEM Output is ready to use as soon as you complete GEM Setup. See the GEM/3 Desktop Installation Guide for more information.
Output Processing Modes

You can run GEM Output in either Batch or Auto Display mode.

Batch Mode

In this mode, you assemble a group of documents in the form of a list. The list can contain 1-36 document names. GEM Output prints or displays each document in your list on the device you specify. Section 12 explains how to save output lists.

Auto Display Mode

In Auto Display Mode, you can produce one or more documents without placing their names in a list. This is a "shortcut" to GEM Output because as soon as you start, your documents are sent to the output device.

**Note:** The instructions in Sections 11 through 14 assume you’re running GEM Output in Batch Mode.

When you run GEM Output in Auto Display Mode, it produces your document(s) and then returns to where you started. Auto Display Mode is used differently, depending on the application:

GEM Desktop 
Select those documents you want to produce from your Desktop before you start GEM Output. (See “Preselecting Documents” in Section 12.)

GEM Draw Plus 
GEM Output automatically produces the picture in your current drawing window. If you have two windows open, it produces both pictures.

Other GEM applications 
GEM Output produces only the document in the active window. Before starting GEM Output in Auto Display Mode, be sure to save your document because GEM Output always uses your most recently saved version.
Here's how you set Auto Display Mode:

1. Start GEM Output from the GEM Desktop as explained in Section 11, “Starting and Using GEM Output.” Do not select any documents at this time. When the GEM Output screen appears, display the Global Menu and choose the Global command.

2. When the GLOBAL PREFERENCES dialog appears, click on the “On” button following “Auto display.” Then click on “OK.”

3. Click on one of the device icons on the right side of the screen to indicate where you want to produce your document(s).

4. From the Global Menu, choose the Save Preferences command.

5. Display the File Menu and choose the Quit command to return to the GEM Desktop.

To turn Auto Display Mode off and return to Batch Mode, follow the preceding steps again except click on the “Off” button following “Auto display.” Then go to the Global Menu and click on "Save Preferences."

Types of Documents You Can Print or Display

GEM Output can be used for producing graphic documents or non-graphic documents.

The table on the next page lists the document types you can and cannot use with GEM Output.
Types of Documents You Can Print or Display

Non-Graphic Document Reproduction

Almost all DOS applications produce "ASCII-type" documents. However, some documents are "pure ASCII" whereas others contain application-specific control characters.

You can use GEM Output to print or display documents that contain pure ASCII information. When you produce these documents on your screen, GEM Output displays one screen of information at a time. Press any key to display subsequent screens. Press the Escape key to stop the display.

Producing a document that contains control characters yields unpredictable results. Therefore, you should not use GEM Output to produce a document of this type. Instead, use the application program that created the document to produce it. Two exceptions to this are GEM Write and GEM First Word Plus.

(* - When producing GEM Paint documents with GEM Output, both the .IMG and .GEM files must be in the same folder.)

<table>
<thead>
<tr>
<th>GEM Application</th>
<th>Can be used with GEM Output?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>GEM Draw Plus</td>
<td>GEM</td>
</tr>
<tr>
<td>GEM Graph</td>
<td>GEM</td>
</tr>
<tr>
<td>GEM Paint</td>
<td>IMG/GEM*</td>
</tr>
<tr>
<td>GEM Desktop</td>
<td>GMP</td>
</tr>
<tr>
<td>Publisher</td>
<td>ASC</td>
</tr>
<tr>
<td>GEM WordChart</td>
<td>GEM</td>
</tr>
<tr>
<td>GEM Write</td>
<td>OUT</td>
</tr>
<tr>
<td>GEM First Word Plus</td>
<td>OUT</td>
</tr>
</tbody>
</table>

(*) - When producing GEM Paint documents with GEM Output, both the .IMG and .GEM files must be in the same folder.)
Starting and Using GEM Output

This section describes how to start GEM Output and provides an overview on how to print documents.

Starting GEM Output

There are several ways to start GEM Output:

- The GEM Desktop File Menu contains the To Output command. You can start GEM Output by choosing this command.

- You can also start GEM Output from most GEM applications programs. For example, if you’re using GEM Paint, display the File Menu and choose the To Output command. When you start GEM Output from a GEM application, you have the option of returning either to that application or to the GEM Desktop.

- Because GEM Output is a GEM application, you can load it by opening one of its document icons. For example, if you create a list of document names and save it as DEMO.LIS, you’ll see it on the GEM Desktop as the icon shown below.

If you double click on this icon, you’ll load GEM Output and it can begin producing the documents named in DEMO.LIS.
Printing a Document

This section contains a step-by-step overview on how to print a document with GEM Output. This overview is not intended for use as a tutorial—its purpose is to demonstrate the basic steps required to produce your documents.

Step 1: Select Document(s) to Print

Suppose you've created two GEM Draw Plus pictures named CAR.GEM and TRUCK.GEM and you now want to produce them on your printer.

While the GEM Desktop is on your screen, select both the CAR.GEM and TRUCK.GEM icons by Shift-clicking—hold down the shift key while clicking on each icon.

Step 2: Start GEM Output

Display the GEM Desktop File Menu and click on the To Output command.

GEM Output starts; its screen looks like the one shown on the following page.
Like the GEM Desktop screen, at the top of the GEM Output screen is the menu bar. It lists the titles of the GEM Output menus: File, Global, Preferences, and OUTPUT.

The left side of the screen contains the tool kit. GEM Output tools are described in Section 12.

The center portion of the screen is the output list box. It contains the names of the documents you selected from the GEM Desktop in Step 1: CAR.GEM and TRUCK.GEM.
On the right side of the screen are icons that represent the output devices attached to your computer. Typically, a screen and a printer are shown. There might be more icons shown, depending on your system's configuration. Beneath each device icon is the name of that device. In the example shown above, the name "Hercules" is displayed beneath the screen icon; this indicates that a Hercules Graphics Card™ is installed in the computer.

GEM Output highlights the default icon; this is the device it will use unless you select a different one. Click on a different icon to select its device. Use Save Preferences from the Global Menu to make that device the default.

Step 3: Start Printing

To print the two pictures, click on the "Start" icon (the keyboard shortcut is Alt-S). This dialog appears to indicate which document is printing:

The dialog disappears from your screen when printing is completed.

Step 4: Return to GEM Desktop

Display the File Menu and choose Quit or use the keyboard shortcut (Ctrl-Q) to return to the GEM Desktop.

You now know the basic steps for printing using GEM Output. Next you'll learn about other features and other ways to use GEM Output in the following sections.
Section 12

Output Lists

This section explains how to create, edit, and use output lists to print or display your documents. It contains detailed screen and dialog information.

Output lists let you print or display multiple documents in the order you want. For instance, chapters in a book or sections in a report might make up an output list. You can save these lists and revise them.
Output List Box

When you start GEM Output, it displays the output list box on your screen, as shown below:

The output list box, like a Desktop window, contains a title bar, full box, scroll bar, slider, and scroll arrows. It also contains a size box and tool kit icons.
Size Box

Use the size box to change the dimensions of the output list box. This is useful when:

- the document names in your output list extend beyond the right edge of the output list box
- you want to make room on the screen for a desk accessory
- a desk accessory disappears behind the output list box and you want to bring it back in view

Place the pointer on the size box and drag in any direction. As you drag, you'll see the outline of a rectangle that previews the new dimensions of the output list box. When the rectangle is the size and shape you want the new list box to be, release the mouse button.

Tool Kit Icons

The tool kit icons and their keyboard shortcuts are briefly described below. Please refer to pages 12-5 through 12-7 for more details.

Click on the START icon to begin producing the documents whose file names are listed in the output list box. GEM Output produces these documents on the output device whose icon is highlighted. To use a different output device, click on its icon before selecting Start. The keyboard shortcut for START is Alt-S: hold down the Alt key and press the S key.
Tool Kit Icons

Click on this icon to add one or more document names to an output list. You can add document names to an empty list or to an existing list. The ITEM SELECTOR dialog appears, from which you select the documents to be added (see page 12-9). The keyboard shortcut for Add Name is Alt-A.

To remove a document name from the output list, select its name and then click on this icon. You can select more than one document to be removed with the drag or Shift-click techniques. Remove Name deletes the document only from the output list, it does not affect the document itself. The keyboard shortcut for Remove Name is Alt-D.

To produce more than one copy of a document, duplicate the document name in the output list as many times as needed. You do this by selecting the name to be duplicated and then clicking on this icon. Use the drag or Shift-click technique to select multiple document names for duplication. The keyboard shortcut for Duplicate Name is Alt-C.

To tell GEM Output to produce more than one copy of the documents in the output list, place the pointer near the number 01 in the Copies icon and click. When GEM Output displays the text cursor behind the number, press the Backspace key or the Escape key. This erases the current number so that you can type the number of copies you want GEM Output to produce. You can enter any number from 1 to 99.

GEM Output sounds a tone and returns the copies setting to 01 when:

- Two minutes have elapsed since it processed the last document
- Two minutes have elapsed since you moved the pointer or issued a command
Rules for Selecting Documents

Keep the following rules in mind when selecting document names for an output list:

• You can combine documents from different folders (subdirectories) in the same output list.

• You can also combine documents from different disks in the same output list. However, you must have all disks available when producing the documents and you must specify which disk each document is on. For example, some documents can be on your hard disk and others on a floppy disk so long as the floppy disk is inserted in a disk drive when you create the output list and start the production process. Also, your documents can be on two separate floppy disks so long as both floppy disks are inserted in disk drives. However, you cannot swap floppy disks while running GEM Output.

• GEM Output does not produce certain document types. See “Types of Documents You Can Print or Display” on page 10-3.

Preselecting Documents

You can “preselect” the document(s) you want in your output list by selecting them from the GEM Desktop before you choose the To Output command from the Desktop's File Menu. When the output list appears, it contains the names of the documents you preselected.

You can preselect up to ten documents at a time, depending on the combined number of characters in the folder and document names. The maximum number of characters GEM Output can accept is 128.

Another way to preselect a document for an output list is to start GEM Output directly from a GEM application. The application passes the name of your current document to GEM Output.
Adding Document Names

You can add one or more document names to an empty ITEM SELECTOR or to an existing list. (To start with an empty list, click on the **New** command from the GEM Output File Menu.)

To add one or more names, either click on the Add Name icon in the tool kit or hold down the Alt key and press the A key. The ITEM SELECTOR dialog appears on your screen (see page 12-9). Use the ITEM SELECTOR to select the document(s) you want to add to your output list.

To add a name to the list from the ITEM SELECTOR dialog:

- Double-click on the document's name in the directory window. This is the fastest method.
- Click on the name when it appears in the directory window. The name appears on the line following “Selection.” Click on the OK button or press the Enter key.
- Type the document name on the Selection line. Click on the OK button or press the Enter key.

To add more names, repeat the procedure as many times as necessary.

To add all of the documents contained in the ITEM SELECTOR to your list (up to a maximum of 36), leave the Selection line empty and click on the OK button or press the Enter key.

**Note:** When the ITEM SELECTOR appears, it covers a portion of the output list box. Therefore, you should make note of the document names you already have in the box before you click on the Add Name icon.
Removing Document Names

To remove a name from the output list:

1. Click on the name you want to remove. To remove more than one name, use the drag or Shift-click technique.
2. Click on the Remove Name icon in the tool kit or hold down the Alt key and press the D key.

Duplicating Document Names

To duplicate document names already in an output list:

1. Select the name you want to duplicate. If you want to duplicate multiple names, use the drag or Shift-click technique.
2. Click on the Duplicate Name icon in the tool kit or hold down the Alt key and press the C key.

Moving Document Names

To move a document name to a different place in the output list, select it, then drag it to the desired location. When you release the mouse button, GEM Output inserts the name and rearranges the list, if necessary. You can move only one name at a time.

Saving an Output List

You may have an output list that includes a sequence of documents and graphics to be used in a presentation. You might want to save this sequence and perhaps modify it and run it again for a different audience.
To save a new output list:

1. Choose **Save as** from the GEM Output File Menu. The ITEM SELECTOR dialog appears.

2. Type a name for your list (up to eight characters) and add the filename extension .LIS (it's automatically supplied if you forget). The name you type appears on the Selection line.

3. Click on **OK** or press the ENTER key to save your list.

Note that the File Menu also contains a **Save** command. Use this command to save an existing output list after you make changes to it.

---

**Opening Output Lists**

When you open an output list, GEM Output places its document names in the output list box. You can use the list as is—you can also add, duplicate, move, or remove names from it. The title bar shows you the name and location of the output list.

GEM Output allows you to open only **LIS-type** documents, that is, files with the .LIS filename extension.

Here are two ways to open an output list:

- Double-click on the output list icon from within the Desktop—GEM Output starts automatically.

- Choose the **Open** command from the File Menu after you've started GEM Output.

When you use the latter method, the ITEM SELECTOR dialog appears—it shows you the LIS-type documents in your current disk folder.

If you open an existing list, make changes to it, and then want to save both the original and revised versions, select the **Save as** command from the File Menu to preserve the revised version under a different name. Your original version remains unchanged.
Starting Production

If you want to change either the global or device preferences, do so before completing the following steps. (These preferences are described in Section 14.)

When your output list is complete:

1. Click on the icon representing the device on which you want to produce your document(s). If the correct icon is already highlighted, skip this step.

2. Click on the Start icon in the tool kit or (hold down the Alt key and press the S key.)

ITEM SELECTOR Dialog

The ITEM SELECTOR dialog, shown on the next page, is used to:

- add one or more document names to your output list
- save an output list on disk
- retrieve an output list
Directory Line

The directory line shows the disk and folders that contain the items listed in the directory window. You can change the information on this line to:

- choose the folder that contains the document(s) you want to add to your output list
- name a folder in which you want to save an output list
- name a folder from which you want to retrieve an output list

To change the information on the directory line, place the pointer anywhere on the line and click. The text cursor appears after the last character on the line. Press the Backspace key to erase individual characters or press the Esc key to erase the entire line. Type the name of the disk and folder or folders you want to use.
After you enter the information on the directory line, click inside the directory window or press the Enter key to update the window with a list of items in that folder.

**Wildcard Characters**

You can use asterisks (*) or question marks (?) in the directory line as "wildcard" characters. Question marks replace individual characters; asterisks replace entire filenames. For example, "C:\PICTURES\* .GEM" means all GEM-type documents in a folder named PICTURES on disk drive C.

You can also combine wildcard expressions in the directory line as follows:

```
C:\* .GEM, * .OUT, * .GMP
```

In this case, you must separate each element with a comma.

Refer to your operating system manual for more information about wildcard characters.

**Close Box**

You can also change the information in the directory line by clicking on the directory window's close box. Each time you click on the close box, the directory window displays the contents of the next higher level in the directory path (back toward the root directory). For example, if the directory line reads "C:\IMAGES\* .IMG" and you click on the close box, this is what happens:

- The directory line changes to "C:\* .IMG."
- The directory window lists the folders in the root directory, plus documents with the .IMG type. Folders are identified with a diamond character (♦).
Selection Line

You can enter the following information on the selection line:

- the name of a document you want in your output list
- the name for an output list you want to save on disk
- the name of an output list you want to retrieve from disk

Directory Window

The directory window lists the folders and items in the location specified on the directory line. The window can display nine folders and document names at a time. Use the scroll bar, arrows, and slider to scroll through the window if it contains more than nine entries.

Use any of the following methods to select an item from the directory window:

- Double-click on the document or output list name in the directory window—this is the fastest method.
- Click on the document or output list name in the directory window. The name appears on the selection line, as does the text cursor. Click on the “OK” button or press Enter.
- Click on the selection line and the text cursor appears at the beginning of the line. Type the name of the document or output list, then click on the “OK” button or press Enter. (The name need not be displayed in the directory window.)

Folder Indicators

Names listed in the directory window with a diamond (♦) to the left are folders (“subdirectories” in DOS). Click on a folder’s name to display its contents.
Directory Window Close Box

The directory window has a close box in the upper left corner. Click on the close box to move back to the previous folder.

If there is no previous folder, the directory window shows you the drive letter(s) for your computer. Click on the drive letter to display the contents of its root directory in the directory window.
This section illustrates and describes the GEM Output menus and commands. Commands descriptions include the keyboard shortcuts. Page references tell you where to find more information.

When you place the pointer on one of the titles in the menu bar, a menu drops down. The entries in each menu are the commands that you use in GEM Output. To select a command, touch the pointer to that entry so that it becomes highlighted and click the mouse button.

To use a command's keyboard shortcut, hold down the first key indicated while you press the second. For instance, the keyboard shortcut for the New command in the File Menu (shown on the next page) is ^W: hold down the Ctrl key while you press the W key.

Function keys are exceptions; they are single keystrokes. For example, the shortcut for the Global command from the Global Menu is F2—function key number 2.
GEM Output File Menu Commands

Clears all names from your current output list (without saving them) and displays an empty, untitled list. To use the keyboard shortcut, hold down the Ctrl key while you press the W key.

**New**  ^W

Displays the ITEM SELECTOR so you can select an existing output list (pg. 12-9). The keyboard shortcut is Ctrl-O.

**Open...**  ^O

Saves your current output list under its present name (pg. 12-7). The keyboard shortcut is Ctrl-V.

**Save**  ^V

Displays the ITEM SELECTOR so you can save and name a new output list, or save an existing list under a different name (pg. 12-7). The keyboard shortcut is Ctrl-M.

**Save as...**  ^M

If you start GEM Output from a GEM application, the name of that application appears here. You can select the name to return to the application. The keyboard shortcut is Ctrl-R. (If you start GEM Output from the GEM Desktop, this entry does not appear.)

**To (application)**  ^R

**Quit**  ^Q

Stops GEM Output and returns you to the GEM Desktop. The keyboard shortcut is Ctrl-Q.
Global Menu Commands

<table>
<thead>
<tr>
<th>Global</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Shortcuts...</strong></td>
<td><strong>F1</strong></td>
</tr>
<tr>
<td><strong>Global...</strong></td>
<td><strong>F2</strong></td>
</tr>
<tr>
<td>Save preferences</td>
<td><em>Alt-V</em></td>
</tr>
</tbody>
</table>

Displays a two-part dialog explaining certain shortcuts available in GEM Output. The keyboard shortcut is F1.

Sets certain global preferences in GEM Output. The keyboard shortcut is F2.

Saves global and device preferences as currently set. The keyboard shortcut is *Alt-V*.

Preferences Menu Commands

Screen Preferences

<table>
<thead>
<tr>
<th>Preferences</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Screen...</strong></td>
<td><strong>F3</strong></td>
</tr>
</tbody>
</table>

Controls how long images are displayed on your screen (pg. 14-3). The keyboard shortcut is F3.
Preferences Menu Commands

Printer/Plotter Preferences

Note: Select either the printer or plotter device icon before choosing one of the commands in this menu.

<table>
<thead>
<tr>
<th>Preferences</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page...</td>
<td>F4</td>
<td>Displays a dialog so you can choose page output settings (pg. 14-5). The keyboard shortcut is F4.</td>
</tr>
<tr>
<td>Paper size...</td>
<td>F5</td>
<td>Displays a dialog so you can select the correct size paper for your output (pg. 14-6). The keyboard shortcut is F5.</td>
</tr>
<tr>
<td>Paper tray...</td>
<td>F6</td>
<td>Displays a dialog so you can select the correct paper tray or paper feed setting for your printer (pg. 14-7). The keyboard shortcut is F6.</td>
</tr>
<tr>
<td>File redirect...</td>
<td>F7</td>
<td>Displays a dialog that lets you send your output to another file or to a remote printer (pg. 14-8). The keyboard shortcut is F7.</td>
</tr>
</tbody>
</table>

Camera Preferences

<table>
<thead>
<tr>
<th>Preferences</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Film...</td>
<td>F8</td>
<td>Displays a dialog (pg. 14-9) that lists the types of film suitable for use with GEM Output, and contains a lightness (exposure) scale. The keyboard shortcut is F8.</td>
</tr>
<tr>
<td>Color...</td>
<td>F9</td>
<td>Displays a dialog (pg. 14-10) that lists an index of color values, basic colors, and an intensity scale for use with GEM Output. The keyboard shortcut is F9.</td>
</tr>
</tbody>
</table>
OUTPUT Menu Commands

Displays a dialog about GEM Output. This dialog lists the release number and copyright information.

This menu also lists the desk accessories (if any) that are installed in the system. You can activate an accessory from within GEM Output by clicking on its name in the OUTPUT Menu. If your computer does not have enough memory, this part of the menu is omitted.

You'll find instructions for using the Snapshot accessory in your GEM Paint User's Guide. The Calculator, Clock, and Print Spooler are described in Section 7 of this guide.
Device Preferences

The commands in the Global Menu and Preferences Menu make it possible for you to "customize" GEM Output. The Global Menu commands affect GEM Output as a whole. The Preferences Menu commands affect specific output devices.

Global Menu

The Global Menu contains the following commands:

**Shortcuts**
This command displays a dialog that describes keyboard shortcuts for entering certain commands.

**Global**
This command offers choices that affect your entire system. They are described below, under "GLOBAL PREFERENCES Dialog."

**Save Preferences**
This command saves the choices you made with the **Global** command and the commands in the Preferences Menu.

When you save preferences, they are installed automatically every time you start GEM Output. You can change preferences during a session, but if you do not save them, the new settings are lost when you quit GEM Output or turn off the computer.
GLOBAL PREFERENCES Dialog

Global preferences apply to GEM Output as a whole and are not specific to a particular type of device. When you choose the Global command, GEM Output displays the GLOBAL PREFERENCES dialog, shown below.

GLOBAL PREFERENCES

- Confirm .LIS changes: Yes or No
- Auto display: On or Off
- Print pages numbered 001 through 999

OK or Cancel button

If set to Yes, you are asked to confirm changes you make to an output list.

Starts the output process automatically when you come from the GEM Desktop or a GEM application. See Section 10, “GEM Output Overview,” for a description of Auto Display Mode.

Click on a number to put the text cursor there. Use the Backspace key to erase numbers so you can type page numbers in the desired range. This way you can print selected pages of a document.
Preferences Menu

The Preferences Menu allows you to choose how you want your output devices (screen, printer, plotter, etc.) to work with GEM Output. You can choose:

- GEM Output display preference
- paper size/paper tray options
- page layout options
- printer functions
- plotter functions
- camera functions

To display the options available for a device, first select the device by clicking on its icon and then move the pointer to Preferences in the menu bar. The menu drops down and the appropriate options are shown for the device that you selected.

Note: Output devices must first be installed with GEM Setup before GEM Output can customize them for you. Once they're installed, you can adjust how your output will look and how it will be produced. See the GEM/3 Desktop Installation Guide for instructions on using GEM Setup.

Screen Preferences

The SCREEN PREFERENCES dialog, shown on the next page, can be displayed either by clicking on the Screen command in the Preferences Menu or pressing the F3 function key. GEM Output lets you cycle either graphics or text for display purposes. This would typically be used at exhibits or conventions where a presentation could be running unattended for some time.
Repeat list until Esc key?

"Yes" means GEM Output continuously cycles through the documents in your output list. You set the time to pause between pages (pictures) by setting the number of seconds below.

Pause between pictures until:

"Key" means that you must press a key or the mouse button to display the next file in the output list. "Time" means that GEM Output will automatically cycle through the output list, displaying each document for the time specified in "Time to pause," described next.

Time to pause: When you click on the number, the text cursor appears. Use the Backspace key to erase the previous number and then type in the number of seconds to pause between document pages.

Note: Press the Escape key to stop the display and return to the main GEM Output screen.
Printer and Plotter Preferences

GEM Output uses dialogs so you can set preferences for your printer or plotter's page layout, paper size, paper tray, and file redirection settings. You display these dialogs by clicking on the appropriate command in the Preferences Menu or by pressing the appropriate function key.

Page Preferences

Scale:  "True size" prints documents in their actual size and scale. "Make fit" scales documents to fit the paper size you select with Paper Size.

Final Form Feed?  Select "Yes" to tell the printer to advance a blank sheet after the last printed page. (This is not an option for plotters and most stacked-paper printers—printers that do not use continuous, "fan-fold" paper.)

Position:  Position the small black rectangle in the larger rectangle to select the boundaries of printed text on the page.
Paper Size Preferences

Units: These buttons let you switch from inches to centimeters in measuring the sheet sizes listed.

Sheet Sizes Popular paper sheet sizes are listed. Click on a specific size to specify the length of your document. For example, if you are printing on legal paper, choosing the "Legal" paper size ensures that text and graphics are positioned correctly on the paper.
Paper Tray Preferences

For printers and plotters with one or more paper trays, choose this setting to use the paper tray designated by the printer as the default.

Continuous Form
Choose this setting to print documents on continuous form or roll paper.

Manual Feed
Choose this setting if your printer or plotter has a manual feed option or if you want it to pause between pages. This option is useful with single-sheet printers and most plotters.

Optional Tray #1
Use this option for printers or plotters with more than one paper tray. To specify a tray, use the Backspace key to erase the current number and then type the new number.
File Redirection Settings

Send output to: Use this option to redirect your output files from one destination to another. For example, instead of sending your output files to your printer port, you can redirect them to a file, which you can then send to a remote printer over a network.

Print file in background: Select "Yes" to work in GEM while printing. If you select "No," you cannot exit GEM Output while printing. (Only parallel printers have this option.)

Delete file after printing in background: Select "Yes" if you want the temporary output file created for each document to be deleted automatically after printing. Select "No" if you want it to be saved. (This option is available only for parallel printers.)

Directory: This is where you can specify a directory in which you want output files saved. Enter the full path name of the directory.

File: Shows the name you assign to files that you create.
Camera Preferences

If you select a camera device icon and then display the Preferences Menu, GEM Output makes the **Film** and **Color** commands available. The dialogs displayed when you choose these commands are described below.

Film

GEM Output displays the CAMERA PREFERENCES: Film dialog when you select the **Film** command. This dialog allows you to specify the type of film you are currently using.

---

### Film Preferences

<table>
<thead>
<tr>
<th>Film Type</th>
<th>Lightness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polaroid Type 669</td>
<td>-3</td>
</tr>
<tr>
<td>Polaroid Polachrome</td>
<td>-2</td>
</tr>
<tr>
<td>Ektachrome - ASA 100</td>
<td>-1</td>
</tr>
<tr>
<td>Agfachrome - ASA 100</td>
<td>0</td>
</tr>
<tr>
<td>Fujichrome - ASA 100</td>
<td>+1</td>
</tr>
<tr>
<td>Reserved for future use</td>
<td>-2</td>
</tr>
<tr>
<td>Reserved for future use</td>
<td>+3</td>
</tr>
</tbody>
</table>

**Film Type**

Select the film type you are using by clicking on the box next to the film type name. The film types listed in this dialog are device-dependent. Other film types may appear on your system.

**Lightness**

This setting allows you to vary the exposure of your pictures. The 0 setting is average for most films. Experiment with your own equipment to decide which settings are best for you.
Color

You can change the colors your camera produces by changing the settings in the CAMERA PREFERENCES: Color dialog. Note however, that the results you get depend on many factors in addition to these settings. Film type, speed rating, film age, ambient temperature, and humidity all contribute to color quality.

Color index:
By clicking on a number, you can identify the color associated with one of the color code numbers used in GEM applications. For example, the default color associated with the number 6 is yellow.

Basic color:
To change the color associated with a selected color index number, click on the color of your choice. For example, you could change color 6 from yellow to blue.

Intensity:
To make a color darker or lighter, select a higher or lower intensity value.

You can also change the amount of red, green, or blue in a selected color by changing the percentage "counters" in the lower left corner of the dialog. Use the Backspace key to delete the current setting and enter your new setting. The chart on the following page shows some basic settings and their results.
You create new colors by specifying percentages of red, green, and blue. However, the existing Basic color and Intensity settings may become irrelevant since they are based on standard values. Also, since cameras and films vary, you may have to experiment to get the exact colors you want.

<table>
<thead>
<tr>
<th>Red</th>
<th>Green</th>
<th>Blue</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>100%</td>
<td>0%</td>
<td>0%</td>
<td>Pure Red</td>
</tr>
<tr>
<td>0%</td>
<td>0%</td>
<td>100%</td>
<td>Pure Blue</td>
</tr>
<tr>
<td>0%</td>
<td>0%</td>
<td>0%</td>
<td>Black</td>
</tr>
<tr>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>White</td>
</tr>
</tbody>
</table>
Index

A

.APP type, 7-3, 7-6
Applications, 7-1
  configure, 7-5
DOS, 7-1
GEM, 7-2
icon, 6-2
name, 7-3
  remove configuration, 7-8
  save configuration, 7-8
start, 7-4
type, 7-3, 7-7
Arrange Menu, 9-4
ASCII files, 7-14, 10-4
Auto display mode (GEM Output), 10-2, 14-2
AUTOEXEC.BAT, 7-9

B

Background printing, 7-14
.BAD type, 7-3, 7-6
Batch mode, 10-2

C

Calculator, 7-11
Click, 3-4
Clock, 7-13
Close box, 4-4
COM type, 7-3, 7-6

Commands (GEM Desktop), 9-1
  Configure application, 9-3
Delete, 5-5, 9-2
Desktop info, 9-5
Enter DOS commands, 9-3
Format, 9-2, 9-7
Info/Rename, 9-2, 9-6
Install disk drive, 3-3, 9-3, 9-8
Open, 9-2, 9-6
Quit, 9-2
Save desktop, 9-3, 9-11
Set preferences, 9-3, 9-9
Show as icons, 9-4, 9-12
Show as text, 9-4, 9-12
Sort by date, 9-4, 9-14
Sort by name, 9-4, 9-13
Sort by size, 9-4, 9-14
Sort by type, 9-4, 9-13
To Output, 9-2

Commands (GEM Output), 13-2 - 13-5
Configure application command, 6-3, 7-5, 9-3
Confirm copies?, 9-9
Confirm deletes?, 9-9
Confirm overwrites?, 9-10
Copying
  folders, 5-3
  icons, 3-8, 6-3
  multiple icons, 3-8
COPY FOLDERS / ITEMS dialog, 3-8, 6-3, 9-9
Creating folders, 5-1
Index

D

Data entry fields, 8-3
De-selecting icons, 3-4, 3-6 - 3-7
Delete command, 5-5, 9-2
Deleting folders, 5-5
Deleting icons, 3-10, 5-5
DELETE FOLDERS / ITEMS dialog, 9-9
Desk accessories, 7-10, 9-5
   calculator, 7-11
   clock, 7-13
   print spooler, 7-13
Desktop info command, 9-5
DESKTOP Menu, 9-5
Device icons, 11-4
Dialogs, 8-1
   COPY FOLDERS / ITEMS, 3-8, 6-3, 9-9
data entry type, 8-3
DELETE FOLDERS / ITEMS, 9-9
DISK INFORMATION, 9-6
FOLDER INFORMATION, 9-7
icons, 8-3
information type, 8-2
ITEM INFORMATION / RENAME, 6-5, 9-7
ITEM SELECTOR, 12-9
keystroke table, 8-5
NAME CONFLICT DURING COPY, 6-4
OPEN APPLICATION, 7-4 - 7-5
SET PREFERENCES, 9-9
Directories, 5-1
   See also “Folders”

Disk drives
   icon, 3-3, 6-1
   identifier, 6-1, 6-4, 9-8
   label, 6-1, 9-8
   name, 6-4
   remove, 9-8
   type, 9-8
DISK INFORMATION dialog, 9-6
Disk size, 4-5
Displaying menus, 3-9
Documents
   adding names (GEM Output), 12-6
   duplicating names (GEM Output), 12-7
   icon, 6-2
   LIS-type, 11-1
   moving names (GEM Output), 12-7
   name, 7-3
   output selection, 12-5
   preselecting (GEM Output), 12-5
   removing names (GEM Output), 12-7
   type, 7-3, 7-7
DOS applications, 7-1
Double-click, 3-4 - 3-5
Double-click speed, 9-10
Drag, 3-4 - 3-5, 3-8
Drop-down menu control, 9-10

E

Enter DOS commands command, 9-3
.EXE type, 7-3, 7-6
Exit buttons, 8-1
F

File Menu, 9-2
Folders, 5-1
  copy, 5-3
  create, 5-1
  delete, 5-5
  delete icon, 5-5
  icon, 6-1
  insert icon, 5-4
  inside folder, 5-2
  limits, 5-3
  order of icons, 6-1
  rename, 5-5
  size, 4-5
FOLDER INFORMATION dialog, 9-7
Format command, 9-2, 9-7
Full box, 4-4

G

GEM applications, 7-2
GEM Desktop
  floppy disk startup, 2-2
  hard disk startup, 2-2
  starting, 2-1
GEM DESKTOP disk, 2-2
GEM Output, 10-1
  acceptable document types, 10-3
  auto display mode, 10-2
  batch mode, 10-2
  demonstration, 11-2
  document selection, 12-5
  output list, 12-1
  printing extra copies, 12-4
  size box, 12-3
  starting, 11-1
  tool kit, 12-3
GEM Setup, 10-1
GEM STARTUP disk, 2-2
GEM.BAT, 2-1, 7-9
GEMAPPS folder, 7-9, 10-1
GEMDESK folder, 7-9
GEMSYS folder, 7-9
Global command, 10-3
Global Menu, 14-1

I

Icons, 6-1
  application, 6-2
  copy, 3-8, 6-3
  copy multiple, 3-8
  de-select, 3-4, 3-6 - 3-7
  delete, 3-10, 5-5
  disk drive, 6-1
  document, 6-2
  folder, 6-1
  in folder, 5-4
  open, 3-5
  rename, 3-9
  select, 3-4
  select multiple, 3-5, 3-7
  type, 6-2, 7-8
Info/Rename command, 6-5, 9-2, 9-6
Install disk drive command, 3-3, 6-1,
  9-3, 9-8
INSTALL.APP, 7-6
ITEM INFORMATION / RENAME dialog,
  6-5, 9-7
ITEM SELECTOR, 12-6, 12-8 - 12-9
   Directory line, 12-10
directory window, 12-12
Selection line, 12-12

K
Keyboard
   using instead of mouse, 3-3

L
.LIS changes, 14-2
LIS-type document, 11-1, 12-8

M
Menu Bar, 9-1
Menus (GEM Desktop), 9-1
   Arrange, 9-4
   DESKTOP, 9-5
displaying, 3-9
File, 9-2
Options, 9-3
Menus (GEM Output), 13-1
   File, 13-2
   Global, 13-3
   OUTPUT, 13-5
   Preferences, 13-3 - 13-4
Mouse, 3-3

N
NAME CONFLICT DURING COPY
dialog, 6-4
Needs full memory?, 7-7
New command, 12-6
NEW FOLDER dialog, 5-2
New Folder icon, 5-1 - 5-2
Non-graphic documents, 7-14

O
Open command, 7-4, 9-2, 9-6
Opening icons, 3-5
OPEN APPLICATION dialog, 7-4 - 7-5
Options Menu, 9-3
Output lists, 12-1
   opening, 12-8
   saving, 12-7
   selecting all documents, 12-6
OUTPUT.APP icon, 10-1

P
Pointer, 3-3
Preferences Menu, 14-1, 14-3
Printing pages (GEM Output), 14-2
Print queue, 7-13 - 7-14
Print Spooler, 7-13 - 7-14
   adding to, 7-14
   deleting from, 7-14
Printer Preferences, 14-5
Printing documents, 10-1
Q
Queue, 7-14
Quit command, 9-2

R
Removing application configuration, 7-8
Removing disk drive, 9-8
Renaming
disk drives, 6-4
documents, 6-5
folders, 5-5
icons, 3-9
Root directory, 5-1, 7-9
Rubber rectangle, 3-5

S
Saving application configuration, 7-8
Saving output lists, 12-7
Save as command, 12-8
Save desktop command, 7-8, 9-3, 9-8, 9-11
Screen Preferences, 14-3
Scrolling, 4-4 - 4-6
Search path, 7-5, 7-9
Selecting icons, 3-4 - 3-5, 3-7
Selecting pages for printing, 14-2
Set preferences command, 3-5, 9-3, 9-9
SET PREFERENCES dialog, 9-9
Shift-click, 3-4, 3-7
Shortcuts, 9-1
Show as icons command, 9-4, 9-12
Show as text command, 9-4, 9-12
Size box, 12-3
Slider, 4-5
  position, 4-6
  size, 4-5
Sort by date command, 9-4, 9-14
Sort by name command, 9-4, 9-13
Sort by size command, 9-4, 9-14
Sort by type command, 9-4, 9-13
Spooler, 7-14
Subdirectories, 5-1
Suspended printing, 7-14

T
Title bar, 4-1
To drop down menus, 9-10
To Output command, 9-2, 11-1
Tool kit, 12-3

W
Wildcards, 12-11
Window, 4-1
  close box, 4-4
  full box, 4-4
  scrolling, 4-4 - 4-6
  title bar, 4-1
Keyboard Equivalents to Mouse Techniques

Click
Press and release Home key.

Double-click
Press and release Home key twice, quickly.

Drag
1. Press and release End key.
2. Use arrow keys to move pointer.
3. When finished dragging, press Home key.

Shift-click
1. Use arrow keys to place pointer on first icon you want to select.
2. Press and release Home key to select icon.
3. Use arrow keys to move pointer to next icon you want to select.
4. Press Shift and Home keys to select icon.
5. Repeat steps 3 and 4 to select any additional icons.

If arrow keys do not move the pointer, press the Ctrl key and try again.
Dialog Editing Techniques

Moves text cursor left one character without deleting.*

Moves text cursor right one character without deleting.*

Moves text cursor to next field in which you can enter or change information.*

Moves text cursor to previous field in which you can enter or change information.*

Deletes character to right of text cursor.*

Deletes character to left of text cursor.*

Erases all characters in field where text cursor is located.

* - Effect is continuous if key is held down.
Trademarks

GEM, GEM Desktop, and GEM Output are trademarks of Digital Research Inc.
GEM/3 Release Note
Release 3.1

October 1989

Digital Research Inc.
The information that follows was not available when the GEM®/3 Release 3.1 documentation went to press. The updated information includes:

- General information
- GEM Setup
- Hewlett-Packard® LaserJet® printers
- Dual-floppy disk computers
- GEM Output
- Ventura Publisher®

Note: The GEM/3 System Master Disk may include a README.DOC file that contains important information not in the documentation or this release note. You can display README.DOC on the screen by using the DOS TYPE command and print it by using the DOS PRINT command or the GEM Output program.

General Information

Printer Configuration Files

Printer configuration files for PostScript® and LaserJet printers (.CNF) now accompany the printer drivers and must be located in the \GEMAPPS\GEMSYS subdirectory (folder). If they are not in \GEMAPPS\GEMSYS, your output can be affected adversely—for example, the printer may produce incorrect margins or may not be able to find your printer fonts. The GEM Setup program normally handles this for you automatically.
Image Files and Screen Resolution

If you use an image file created on another system (for example, a GEM Paint illustration on an EGA monitor) in a GEM application, the image may appear slightly distorted, vertically or horizontally, when displayed on your system. The distortion is caused by a difference in screen resolution of the two systems. If the screen resolution of the two systems is different, the GEM application may display the image with one or more rows of pixels added or deleted. (Pixels are the rows/columns of dots that make up the screen image.)

The imported file is not affected unless you save it under the new screen resolution. The file is saved with the resolution of the system on which it is currently displayed. You can avoid undesirable resolution changes by working with image files under a single resolution such as EGA or VGA.

GEM Setup

During GEM Setup you can press <Esc> to cancel a selection. However, if you select a device to remove from your setup and then change your mind, you must quit and restart GEM Setup before selecting another device to remove. If you select another device without first quitting and restarting, both devices are removed.

Hewlett-Packard Laser Printers

The font information that follows pertains to the printers listed below:

- HP LaserJet
- LaserJet PLUS
- LaserJet II series
- 100% HP LaserJet compatible printers
GEM/3 Release 3.1 uses soft fonts and bit-mapped fonts for printing text on LaserJet printers. Soft fonts offer faster printing of text pages but have some restrictions (see below). Printer drivers for printing bit-mapped fonts are available in a device driver pack that can be purchased separately from Digital Research. (External font cartridges and built-in fonts are not used by GEM applications except GEM 1st Word Plus™.)

If you intend to use GEM/3 with applications other than GEM Artline™ GEM Paint™, and GEM 1st Word Plus, you can use the printer driver for the application or the GEM/3 driver.

If you use the GEM/3 soft font driver, you must use Fontware™ (included with GEM/3) to generate soft fonts before you can print text.

In addition, soft fonts:

- Cannot be obscured, partially or completely, by an object.
- Must be black-on-white (no white text on a black background).
- Must match exactly the required style and point sizes, for example, 12-point Dutch italic.
- Require a hard disk.
- Print in portrait or landscape orientation, but cannot both be printed on the same page. (The bit-map printer drivers can print both portrait and landscape fonts on the same page.)

Please refer to the Fontware Installation Guide for more information.

**Dual-Floppy Disk Computers**

Note: The following information does not apply to hard-disk computers.

GEM/3 can be installed and run on a system that consists of two floppy disk drives. GEM Setup detects that your system does not include a hard disk and prompts you to create a set of floppy disks from the GEM/3 masters. However, the GEM Desktop floppy disk that is created may not
have sufficient space to hold all the necessary files, depending on the printer you select.

While you are running GEM Setup, a message is displayed that GEM Setup cannot copy one or more files to the GEM Desktop disk. Since the files are invariably printer font files, you lose the ability to print those fonts. You can include the fonts by taking the following steps:

1. When GEM Setup reports that it cannot copy one or more files, make a note of the last three characters in the file names that are listed. For example, for AI360GBP.EPS you need to note the letters EPS. Note also the name and number of the disk in Drive A.

2. After GEM Setup is finished, use the DISKCOPY command to make a copy of the GEM Desktop disk that you created. For example:

   DISKCOPY A: B:

   copies all the files on the floppy disk in Drive A to the floppy disk in Drive B. (See your DOS documentation for details of the DISKCOPY command if you are unfamiliar with it.)

   Label the copy "GEM Print Disk."

3. Delete files that are on the Desktop disk from the GEM Print Disk. Insert the GEM Print Disk in Drive B and enter the following command:

   DEL B:\GEMAPPS\GEMSYS\DESK*.*

   All files whose name begins with DESK are deleted from the GEM Print Disk.

4. Now you can add the missing font files to the GEM Print Disk. Insert the disk whose name and number you noted in Step 1 (for example, GEM/3 Printer Disk #2) into Drive A (leave the GEM Print Disk in Drive B). Enter the appropriate COPY command. For example, if the missing files have the extension .EPS the correct command is:

   COPY A:\*.* EPS B:\GEMAPPS\FONTS
Printing from Your GEM Print Disk

Printing from GEM/3 is done by accessing Output from GEM Desktop™. You can start Output from GEM Desktop as described in the GEM Desktop User's Guide. Although Output can also be started directly from many applications on hard disk systems, on a dual-floppy system, you must start Output from GEM Desktop.

1. Before starting, remove the GEM Desktop disk from Drive A and replace it with the GEM Print Disk.

2. Use Output to print your document.

When you quit Output, you are prompted to remove the GEM Print Disk from Drive A and replace it with the GEM Desktop disk.

GEM Output

The following changes have been made in the GEM Output program:

- Fill pattern rotation
- Paper Size dialog (PRINTER PREFERENCES)
- Page dialog (PRINTER PREFERENCES)

Fill Pattern Rotation

GEM Output now automatically rotates fill patterns to print accurately in landscape orientation.

Paper Size Dialog

The "Paper size" dialog (Paper Size command in the Preferences menu for printers and plotters) now allows you to specify a custom paper size for output.
To set a custom paper size, click on the Custom button and then set the page width and height with the slider bars under the button. The minimum width/height setting is 2 inches; the maximum is 25 inches (5 to 65 centimeters). You can change values by:

- Moving the slider—point to the slider box and, holding the mouse button down, move the pointer left (decrease) or right (increase). Clicking on the bar increases or decreases the value by half an inch (or 0.5 centimeters, if that is the selected unit of measure).

- Clicking on the left or right arrow of the appropriate slider increases or decreases the value by 0.01 inch or 0.01 centimeter.

The “Paper size” dialog is discussed in detail in the GEM/3 Desktop User’s Guide.
The Page dialog (Page command in the Preferences menu for printers and plotters) no longer allows you to insert final form feed.

In addition, the dialog has replaced the “True size” and “Make fit” scaling options with three options:

- **Crop to one page**
  Maintains the image and/or text in actual size and centered on a single page. Any portion that does not fit on the page is cropped (not printed—the image/text remains unchanged in the file).

- **Scale to one page**
  Enlarges or reduces the image/text to fit on one full page—equivalent to the former “Make fit” choice. The “Position” indicator at the left bottom of the dialog is used with this option.

- **Mosaic**
  Maintains the image/text in actual size and prints as many pages as necessary to complete the total image/text. You can use this option to print oversize pages in segments on several sheets and then attach the segments to form the whole.
Ventura Publisher

The following information pertains to:

- Ventura 1.1 conversion
- Screen driver compatibility
- Font compatibility

Ventura 1.1 Conversion

GEM 3.1 supports applications, such as GEM Artline, that produce illustrations containing Bézier curves. Release 2.0 of Ventura can display and print the curves but Release 1.1 cannot. In a default Ventura 1.1 installation, Bézier curves in GEM Artline illustrations appear as straight line segments instead of smooth curves.

To upgrade your Ventura 1.1 system to accept Bézier curves, run the VCONV.EXE program located on Printer Disk #1. VCONV can be run from the floppy disk or you can copy it to your hard disk. To run the conversion, enter VCONV on the DOS command line of the root directory.

Note: You cannot use Ventura 2.0 drivers with Release 1.1 to obtain Bézier curves—you must upgrade Ventura 1.1 with the VCONV program.

When you run VCONV.EXE, the following steps are taken:

- The Ventura printer drivers are renamed—PD_drivename to XX_drivename. If the PostScript auxiliary file PS2.PRE is present, it is renamed to PS2.XXX.

- The GEM screen and printer drivers are copied, as well as GEMVDI, to the \VENTURA directory. GEM files PS2.PRE and PRTRERR.STR are copied from \GEMAPPS\GEMSYS to \VENTURA.

- If there is a POSTSCR.CNF file in \VENTURA, a copy is made and renamed as PST.CNF. If there is an HPLJPLUS.CNF, two copies are made and renamed HPH.CNF and HPU.CNF.
To run the upgraded version of Ventura, enter VPX on the command line. Ventura can then process Bézier curves correctly. If you enter VP, you can still run Ventura but Bézier curves are not rendered correctly.

**Restoring Ventura 1.1**

To restore your Ventura 1.1 system to its original state:

1. Delete the newly created GEM printer driver files PD_drivername.
2. Rename the XX_drivername printer drivers back to PD_drivername.
3. Rename PS2.XXX to its original name, PS2.PRE.
4. The newly created files HPH.CNF, HPU.CNF, PST.CNF, GEMVDI.EXE, and the GEM screen drivers SD???9.??? may be deleted if desired.

**Screen Driver Compatibility**

Ventura 2.0 and 1.1 screen drivers have two limitations on their compatibility:

- Using Release 2.0 drivers with Release 1.1 does not give you Bézier capability.
- The VCONV conversion applies only to GEM 3.1 drivers installed by GEM Setup. It may not work on third-party Ventura 1.1 drivers.

**Creating Soft Fonts for Ventura Publisher**

You can use the version of Fontware that is included with your GEM application to create soft fonts for use with Ventura Publisher. If you do, however, be aware of the following:

- If you merge OUTPUT.WID with a width table created by Fontware, you may see an alert telling you that you are merging width tables for different devices. (The Ventura driver calls the printer "HP LJ+, 300
dpi" and the GEM/3 driver calls it "HP LaserJet+, 300 dpi." They are both the HP LaserJet PLUS.)

As long as the fonts you have made are truly for the LaserJet PLUS, you can click on the alert's Ignore button and allow Ventura to complete the merge.

- If you merge the Swiss and Dutch fonts created by the default Ventura installation with fonts created with GEM Fontware, you will encounter the following differences in character positions:

<table>
<thead>
<tr>
<th>GEM</th>
<th>Ventura</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Alt&gt;-155</td>
<td>ø</td>
</tr>
<tr>
<td>&lt;Alt&gt;-157</td>
<td>Ø</td>
</tr>
<tr>
<td>&lt;Alt&gt;-178</td>
<td>¥</td>
</tr>
<tr>
<td>&lt;Alt&gt;-179</td>
<td>c</td>
</tr>
</tbody>
</table>

For example, if you insert <Alt>-155 into your document, ø appears on your display and c on your printed output. If you use GEM Fontware fonts, ø appears both on the screen and in printed output.

Note: To enter ASCII characters, hold down <Alt> and enter the decimal equivalent with the numeric keypad. (The number keys at the top of the keyboard do not work for entering ASCII characters with the <Alt> key.)
Foreword

Welcome to Bitstream® Fontware™ for GEM®/3. The Fontware Installation Kit lets you create high-quality matching display and printer fonts to use with your Digital Research® GEM® applications and Xerox® Ventura Publisher Edition®, commonly referred to as "Ventura." This kit is supplied with typeface outlines from which you can generate fonts in the sizes you need.

Once your fonts are made, you can start using them immediately, except in applications that use printer font width tables, such as Ventura Publisher and GEM® Desktop Publisher™. To add your fonts for use with Ventura, follow the instructions in Section 5 of this guide. To add your new fonts for use with GEM Desktop Publisher, use the Font Merge utility, which is supplied with the GEM Desktop Publisher Release 1.1 package. Preceding releases of Publisher do not include this utility. Contact your dealer for upgrade information.

What's In this Kit

In addition to this guide, your Fontware Installation Kit includes:

- two 5.25" disks (or one 3.5" disk) containing the Fontware installation program and the Charter™ Roman typeface
- 3.5" disk version: one Fonts disk containing the Swiss and Dutch typefaces
- 5.25" disk version: one disk containing the Swiss typefaces and another containing the Dutch typefaces
- a Bitstream Fontware brochure, presenting the current library of available typefaces and suggestions for using typefaces

Other Fontware typefaces are available directly from Bitstream Inc. in packages of at least one typeface. Refer to the Bitstream Fontware brochure for information about the typefaces currently available in the Fontware Library.
What You Need to Use Fontware

You need the following items to make and install Fontware fonts:

- One or more Fontware typefaces. Each Fontware typeface package, available separately, contains the source designs for at least one typeface—often a family of typefaces in four styles.

- An IBM® PC AT™, PC/XT™, Personal System/2™ or compatible with at least 512K bytes of memory, a hard (fixed) disk drive with approximately 900K bytes to store the Fontware Installation Kit, a high-density or double-density disk drive, and a display monitor.

- MS-DOS or PC-DOS, version 2.1 or later.

- GEM/3 or GEM 3.01 system software installed on the hard disk.

- If you're using Ventura Publisher under GEM 3.01, it should already be installed per the instructions in the GEM 3.01 Application Note supplied with this package.

Getting the Best Performance

You can optimize the performance of the installation kit by:

- installing a math coprocessor computer chip

- increasing the RAM available on your system to 640K bytes
How to Use this Guide

If you're impatient to begin, read Section 1, "Getting Started." It tells you how to install the Fontware Kit. Then follow the instructions on your display. If you need help, see Section 3, "Making Fonts."

To learn more about Fontware fonts, read Section 2, "Choosing Your Fonts," then follow the instructions in Sections 1 and 3.

Section 4, "Ventura Publisher Font Installation," explains the steps needed to install fonts for use with Ventura Publisher. Read this section before making fonts.

Once you've made your fonts and are using them with your GEM applications, use the rest of this guide as a reference for font questions.

Assumptions

The presentation of information in this guide assumes that you are familiar with basic procedures in the DOS operating environment. If you have questions about DOS commands or the operation of your computer, refer to your system's manual.

The guide also assumes that your computer is equipped with the components outlined in "What You Need to Use Fontware" above.
Terminology

The term *point* means to press the up- or down-arrow key to highlight a menu option.

The symbol ↓ means “Press your computer’s Enter (or Return) key.”

*Choose* means to press ↓ after pointing to an option.

*Display* means your screen or monitor.

Both *kit* and *installation kit* refer to the Fontware Installation Kit.

The caret symbol (^) represents your keyboard’s Control key, usually labeled Ctrl.

Function keys are enclosed in angle brackets, for example, <F4>. 
Contents

Foreword

What’s In this Kit ....................................................... i
What You Need to Use Fontware ................................. ii
  Getting the Best Performance .................................. ii
How to Use this Guide ................................................. iii
  Assumptions .............................................................. iii
  Terminology ............................................................. iv

1 Getting Started

Setting Up ............................................................... 1-1
  Specifying Your Display and Printer ......................... 1-3
Adding Fontware Typefaces ....................................... 1-4
Starting a Kit That’s Already Set Up ......................... 1-5
Getting Help ........................................................... 1-5
Changing the Fontware Control Panel ......................... 1-6
Exiting Fontware ....................................................... 1-6

2 Choosing Your Fonts

What is a Font? ......................................................... 2-1
Choosing Fonts .......................................................... 2-1
Which Devices Are You Using? .................................. 2-2
Printer Font Considerations ....................................... 2-2
  HP Softfonts ............................................................ 2-3
  GEM Bit-Mapped Fonts .............................................. 2-4
  PostScript Fonts ....................................................... 2-4
Display Font Considerations ....................................... 2-5
How Many Fonts Do You Need? .................................. 2-5
  Typestyles ............................................................... 2-5
  Sizes ........................................................................... 2-6
  Zoom Factors for Displays ...................................... 2-7
  Disk Space Availability ............................................. 2-8
How Long Will It Take to Make the Fonts? ..................... 2-8
3 Making Fonts

Making Printer Fonts ........................................... 3-2
Making Display Fonts ........................................... 3-4
Making Matched Display and Printer Fonts ................. 3-5

4 Ventura Publisher Font Installation

Verifying Display Fonts in Ventura ......................... 4-1
Making New Ventura Printer Fonts ......................... 4-1
Loading New Fonts in Ventura .............................. 4-2
Merging Ventura Width Tables .............................. 4-3

5 Fontware File Management

Identifying Font Files ........................................ 5-1
Font File Extensions ....................................... 5-1
Display Font Extensions .................................. 5-2
Printer Font Extensions .................................. 5-2
Non-PostScript Fonts ........................................ 5-3
PostScript Printer Fonts .................................. 5-3
Storing Fonts on Floppy Disks ............................ 5-4
Removing Fontware Typefaces ............................. 5-4
Fonts Directory ............................................. 5-5
Deleting the Fontware Directory ......................... 5-5

6 Troubleshooting

A GEM International Character Set

B Typeface Key

C Device Key

D Fontware Installation Kit Messages
Getting Started

This section explains how to set up the Fontware Installation Kit on your hard disk and how to add typefaces. Adding a typeface copies its outline onto the hard disk. Fontware uses typeface outlines to make fonts. Copying the outline onto the hard disk makes it available for generating the font files that GEM uses to print and display text in that typeface.

These are the major steps for installing fonts:

1. **Set Up Fontware** to copy the installation kit onto your hard disk and specify your screen and printer types.

2. **Add Typefaces** to copy typeface outlines onto your hard disk.

3. **Make Fonts** to generate GEM font files from these outlines.

Topics discussed in this section include:

- setting up
- adding Fontware typefaces
- starting a Fontware Kit that's already set up
- getting help
- changing the Fontware Control Panel
- exiting the kit

Setting Up

Before you set up the installation kit on your system:

- Make sure that the GEM® Desktop™ is installed on your hard disk.

- Check to see if you have a file named README.DOC on Disk 1 of the installation kit. Using a word processor or text editor, read this file and follow its instructions. You can also **TYPE** or **PRINT** the file from the DOS command line, or print it with GEM Output.
When you're ready, 
1. Move to your operating system command line. 
2. When you see the DOS prompt, (C:\), insert Disk 1 of the installation kit into drive A. 
3. Type: 

   **A:FONTWARE ↓**

   The copyright notice and Bitstream Fontware banner appear on your display. 

   The program asks whether the Fontware banner is displayed in one or two colors. Your answer to this question tells the installation kit whether you have a color or monochrome monitor. Type **Y** or **N** accordingly. 

   The Fontware Main Menu appears on your display:

```
Fontware Main Menu

Options
Set Up Fontware
View Control Panel
Add/Delete Fontware Typefaces
Make Fonts

Messages
Guides you through first-time setup of your Fontware program.

Action
↑↓ to point  ← to choose  Ctrl-Q to quit
```

4. Press ↓ to choose the **Set Up Fontware** option, which is highlighted. The Fontware Control Panel is displayed.

You can change the information in the Control Panel any time you use the Fontware Installation Kit.

5. The options window displays the default directories for:

- the Fontware Kit and Fontware typefaces
  (C:\GEMAPPS\FONTWARE)

- your fonts (C:\GEMAPPS\FONTS)

Press ↓ after each directory name or type the **full pathnames** of the directories you want to use. Make sure to place the directories you choose within \GEMAPPS.

6. Type y to install the Fontware Installation Kit.

The kit copies program information into your Fontware directory. If you are using 5.25-inch disks, when the kit prompts you, insert Disk 2 of the installation kit. When the kit finishes copying, you are ready to specify your display and printer types.

**Specifying Your Display and Printer**

This step enables Fontware to generate the appropriate font files for each device. The Fontware Control Panel is displayed; it contains the Display Model selection panel.

1. Point to the name of the display graphics adapter for your display fonts and press ↓.

If your device is not listed, choose one that has the same resolution as yours.

If you aren’t making fonts for your display, choose **none**.

2. “GEM International character set” is highlighted. Press ↓ to select it.
3. To indicate the type of printer fonts you want made, point to the name of your printer type and press ↓.

If your printer is not listed, choose one that has the same resolution as your printer.

4. Choose the character set to be used for your printer. If you’re installing Helwett-Packard® Softfonts, select “GEM Character Set for HP Softfonts.” Otherwise, choose “GEM International character set.” Click on the character set name and press ↓ to make the selection.

5. If you are satisfied with your choices, press <F10>. To go back and change an entry, press <Esc>.

Once the Control Panel is complete, the installation kit displays the Make Fonts Menu. The Bitstream Charter typeface is displayed in the Typefaces Available panel. You can either make fonts for this typeface or add other typefaces.

Adding Fontware Typefaces

To add typefaces, first return to the Main Menu. Then follow these steps:

1. Move the cursor to Add/Delete Typefaces and press ↓.

2. Press <F3> when you see the Fontware Typefaces Menu.

3. Insert Disk 1 of a Fontware typeface package into drive A and press ↓. A pop-up menu of the typefaces appears on your display.

4. Point to a typeface you want and press ↓. An arrow appears to the left of the typeface. Repeat this step for each typeface you add.

5. Press <F10>. The kit begins copying the typefaces onto your hard disk.

6. If the kit prompts you, insert Disk 2 of the typeface package into drive A and press ↓. Usually, Disk 2 is necessary only if you are making fonts for a PostScript® printer.
Starting a Kit That's Already Set Up

If the Fontware Installation Kit is set up already on your hard disk, you can run Fontware from either the GEM Desktop or the DOS command line. Since running Fontware from the Desktop requires more of your computer's memory (RAM), we recommend using this method only on systems with 512K or more RAM, and only to generate a few fonts. If you're making several fonts or very large point sizes, you should run Fontware from the operating system command line.

To start Fontware from the GEM Desktop:
1. Place the pointer on the FONTWARE folder and double-click. This displays the contents of the folder.
2. Double-click on the file icon labeled FONTWARE.BAT. A dialog appears requesting parameter information. None is needed, so click on OK.

The Fontware banner is displayed, followed by the Main Menu.

To start Fontware from the operating system command line:
1. Change to the FONTWARE subdirectory. If you have included the FONTWARE subdirectory in your search path, skip this step.
2. Type:
   
   `FONTWARE ~`

The Fontware banner is displayed, followed by the Main Menu.

Getting Help

The message window in the lower half of each screen tells you your current options and suggests ways to proceed.

For a list of special keys and their functions, press the `<F1>` (Help) key in the Fontware Make Fonts Menu, described in Section 3.
Changing the Fontware Control Panel

You can change the Control Panel whenever you use the installation kit. There are several reasons you might change this information—for example, because you changed the printer or display that you are using.

To change the Control Panel:

1. Point to View Control Panel in the Main Menu and press .
2. Follow the instructions in the message window near the bottom of your display.

Note: If you change to or from a PostScript printer, you need to re-install your typefaces. This is because the kit installs a different set of font definition files for PostScript and non-PostScript devices.

Exiting Fontware

To quit or exit the installation kit without making fonts, type:

^Q

The kit returns you to the operating system prompt.

You can also stop the installation kit while it is generating and installing fonts. To do so, type:

^C

The fonts made before you interrupted font generation are listed in the \GEMAPPS\FONTS directory. See Section 5 for instructions on identifying and interpreting font file names.

Note: If Fontware issues a “Disk full” message while you're adding typefaces, exit Fontware. When you restart the program, the typefaces added up to that point are listed in the Available Typefaces Menu.
Choosing Your Fonts

You can save time and disk space by planning which fonts to make before running the Fontware installation.

This section discusses:
• what a font is
• how to choose the fonts you need
• printer font considerations
• display font considerations

What Is a Font?

Fonts exist as files on your system. A Fontware font is a file containing a set of characters in a specific size for a given model of printer or display device. For example, a 10-point Swiss font for a Hewlett-Packard LaserJet printer differs from a 10-point Swiss font for the IBM EGA screen driver.

You make font files using the installation kit and a Fontware typeface. Each font you make has a typeface design such as Swiss italic and a set of characters such as GEM International.

Choosing Fonts

To decide which fonts to make, consider the following questions:
• Which printer and display device will you be using?
• Which printer fonts will you be using?
• How many fonts do you need?
• Which type sizes do you need?
• How much disk space do you have for storing fonts?
• How much time will it take to make the fonts?
Which Devices Are You Using?

You should know the model names of the printer and display for which you are making fonts. Note that the name of your display type is not necessarily the same as the name on your monitor. If you are unsure which display device you have, consult your hardware documentation or the person who installed your system.

Often, several different display monitors are controlled by the same software, or screen driver. In GEM/3, devices are typed according to their drivers, not necessarily according to their brand names.

The actual devices don't have to be connected to your system when you run the installation kit.

Printer Font Considerations

Printer fonts are divided into three major types:

- HP Softfonts
- PostScript fonts (available from Bitstream, Adobe, and other developers)
- bit-mapped fonts (GEM Setup installs these automatically when you add a printer supported by GEM/3 to your setup)

GEM software applications handle HP Softfonts and PostScript fonts differently from bit-mapped fonts. For HP and PostScript fonts, you need to make each typestyle (Roman, Bold, Italic, and Bold Italic) in each font that you make, or they will print as Roman characters. HP Softfont and PostScript font considerations are outlined in following subsections.
HP Softfonts

For each Softfont you make, Fontware automatically generates a file having the extension .HFI. This file is an ASCII font description file. From the operating system command line, you can TYPE this file to find out typeface, style, and size information without deciphering the font file name codes. Do not delete .HFI files as they are required by the GEM software.

Font Substitution

GEM applications support Softfonts in Portrait mode only. GEM bit-mapped fonts are used automatically whenever the exact Softfont is not available. This may occur, for example, when you print text that has been rotated horizontally on the page, when you use white text on a colored background, or if you use the Best Fit print setting, which may cause the text to be scaled.

If you intend to use Softfonts in Landscape mode, and you have a 300 dots-per-inch (DPI) printer, your \GEMAPPS\FONTS folder must contain a corresponding GEM bit-mapped font (having the file extension .B30) in each typeface and size you use, to enable bit-mapped font substitution. If you installed a 150 DPI printer, you need to generate a corresponding .HPH bit-mapped file in each typeface and size.

If you know that you'll use Softfonts in portrait mode only, you can delete all but one .B30 or .HPH font file of any typeface and size from your \GEMAPPS\FONTS folder. However, as a precaution, we recommend leaving all of your GEM fonts intact. If after deleting them you find that you need them, rerun GEM Setup or make them individually in Fontware.

If you install Softfonts but bit-mapped fonts are used even in Portrait mode, you may have:

• exceeded the printer's memory
• exceeded the number of Softfonts allowed per page (see the limits below)
• installed the fonts incorrectly
The number of Softfonts that can be printed per page depends on the printer and the amount of memory it contains, but typically will be:

- **LaserJet**: eight fonts/page
- **LaserJet Plus**: 16 fonts/page
- **LaserJet Series II**: 32 fonts/page

**GEM Bit-Mapped Fonts**

GEM Setup automatically installs the GEM bit-mapped Swiss and Dutch fonts when you set up your device configuration at GEM/3 installation. As installed by GEM Setup, the Swiss and Dutch Bold, Italic, and Bold Italic typestyles are not true typestyles. For example, bolding is produced at output by printing a character twice, the second time slightly offset from the first.

When making bit-mapped fonts, you can save on disk space by making each font in the Roman typestyle only. The GEM software synthesizes Italic, Bold, and Bold Italic from the Roman typeface if the true typestyle is missing.

However, you may prefer to use true typestyles since they're of higher quality than synthesized versions. Make each typestyle by selecting them in the Fontware Make Fonts Menu. GEM applications automatically use true typestyles if they're available in \GEMAPPS\FONTS.

**PostScript Fonts**

If you are installing PostScript fonts, you need not generate the printer fonts that are resident in your printer. These include the Swiss and Dutch fonts.

If you choose either the Swiss or Dutch typeface in the Make Fonts Menu, you might see a message that says the font is unavailable for the printer. It should say that the font already exists as a resident printer font.
In GEM Desktop Publisher, you do not need matching screen fonts. Publisher displays an approximation of missing display fonts. Keep in mind, however, that matching display fonts are required in other GEM applications.

Display Font Considerations

You need to make display fonts that match your printer fonts. Without them, the printed results of your documents would be unpredictable.

Also, since GEM applications provide enlarged and reduced views, you need to consider view sizes, or zoom factors. These are explained in "Zoom Factors for Displays" later in this section.

How Many Fonts Do You Need?

Most documents use no more than three or four typefaces. For example, this manual uses Bitstream Charter for text, page headers, and page numbers; Zapf Calligraphic for titles and headings; Swiss for text used in illustrations, section number headers, and copyrights text; Courier is used to show user input.

When deciding how many fonts to make, keep in mind that each font you add to your system slows the loading of your applications as well as the printing of documents.

Typestyles

A typeface usually includes four related typestyles. For example, the Swiss font includes Roman, Italic, Bold, and Bold Italic styles based on the Swiss typeface design. Roman is sometimes called Normal.
Sizes

The Fontware typefaces included for use with GEM/3 are proportional—the character widths vary from one character to another. Certain Fontware typefaces, such as Courier, are monospace; the character widths are all the same.

You request type sizes in the Installation Kit in units of points. One point is equal to about 1/72 inch. The text you are reading is 10 points. If you need a 10-pitch monospace font (10 characters to the inch), request it as 12 points. If you need a 12-pitch monospace font (12 characters to the inch), request it as 10 points.

The smallest printer font size you can make with the Installation Kit is 6 points. The largest point size you can make depends on the printer. For a LaserJet® Plus™, the largest character is 36 points. For the LaserJet II™, the largest character is 72 points. For a dot matrix printer, the largest character is 99 points, and for PostScript printers and compatibles, there is no size limit. You may want to experiment to see which point size best suits your needs. Check your printer's manual for any other size limitations.

Note: If you are using HP Softfonts, 36 is the largest point size you can make, unless you are using an HP LaserJet II and GEM 3.01 system software.

For displays, the largest character you can make is 72 points. For all devices, except PostScript printers, the Fontware Make Fonts menu in the installation kit lets you request point sizes using whole decimal numbers. For example, 10, 16, and 20 points are all valid type sizes.

You don't need to enter sizes for PostScript fonts. Instead, you request sizes when you use a GEM application. Your printer then scales the fonts to size during printing.

Keep in mind that the GEM applications have varying point size limitations. These are listed in the GEM/3 README.DOC file on Disk 1 of your GEM/3 Desktop package. They are also documented in each application package.
Zoom Factors for Displays

Applications such as GEM Desktop Publisher can display documents at their actual size and at reduced and enlarged sizes. The amount of reduction or enlargement, sometimes called a zoom factor, is usually expressed in percentages—for example, 50% or 200% of the actual size.

You can make display fonts for each zoom factor, but note that when you make a given point size of a font, the GEM system software automatically creates a point size twice that of the original. For example, if you make the 7-point Dutch font, the software also generates 14-point Dutch.

This “doubling” affects the specific font requirements and point size limitations of the various GEM applications. These limitations are outlined in the README.DOC file on Disk 1 of your GEM Desktop package and in each application’s documentation.

Note that GEM Draw Plus and GEM Desktop Publisher use a scaling method that takes the size of the page into account. To ensure that your display reflects the printed results as closely as possible, always edit in normal size (x 1 scale).

Once you have made the appropriate sizes, the application selects the right one for your display. You need make only the actual size for your printer.

If your disk space allows, we suggest that you make display fonts in the following sizes for the normal style of any typeface: 6, 8, 10, 12, 16, 20, 24, 28, and 36 points. These sizes cover most of the zoom factors.
Disk Space Availability

Fontware tells you how much disk space is needed to make your fonts before it makes them. Here's an example of how much free storage space you need on your hard disk: four Swiss Roman font files in four sizes—6-, 8-, 10-, and 12-point in the GEM International character set, for the HP LaserJet Plus printer, take about 27K bytes. The matching fonts for a Hercules monochrome display take about 11K bytes.

If you plan to use several bit-mapped typefaces, we suggest that you do not create Italic, Bold, or Bold Italic zoom fonts for your display. This saves disk space and loading time for your GEM applications. GEM device drivers create italic, bold and bold italic versions of fonts if the true font style is unavailable. This option is not available for PostScript and HP Softfonts.

Once your fonts are made, they are listed in the \GEMAPPS\FONTS folder of your hard disk. See Section 5 for instructions on identifying and interpreting the font file names.

**Note:** You can use the **DIR** or **CHKDSK** command in DOS to find out how much free storage space you have, although the installation kit lets you know if you have enough disk space before it makes your fonts.

How Long Will It Take to Make the Fonts?

The installation kit makes the fonts you request and updates the files on your system so that your GEM applications can use the fonts. To make the four fonts described above for the LaserJet Plus and a screen display takes about 35 minutes on an IBM PC AT with 512K memory. If your system has 640K memory and a math coprocessor, the same job takes about 18 minutes.
Making Fonts

This section explains the procedure for making fonts, which typically, you do in two major steps:

1. Make printer fonts.
2. Make matching and/or additional display fonts.

You can make additional display fonts to accommodate zoom factors—the enlarged and reduced view functions of your GEM applications. See “Zoom Factors for Displays” in Section 2.

If the Fontware Installation Kit is not already set up in a directory on your hard disk, follow the instructions in Section 1, “Getting Started.” If you are not currently running the kit, follow the instructions for starting it in Section 1, “Starting a Kit That’s Already Set Up.”
Making Printer Fonts

First make sure that the Fontware Control Panel lists your printer and the appropriate character set by choosing **View Control Panel** from the Main Menu. Add any typefaces you need by choosing **Add/Delete Fontware Typefaces** from the Main Menu.

When you're ready to make fonts, follow the instructions below.

1. Start from the Make Fonts Menu for the printer. Get there by choosing **Make Fonts** from the Main Menu, or by pressing `<F10>` from either the Fontware Typefaces Menu or the Control Panel.
   
   The Make Fonts Menu lists the names of the Fontware typefaces on your hard disk.

2. Point to a typeface and press `.=`.
   
   For PostScript printer fonts, this is all you do. When the word **yes** appears, select another typeface or skip to step 5. For all other printer fonts, the kit highlights a bar in the Point Size Selection Menu next to the typeface. A cursor blinks at the beginning of the bar.

   The message window tells you the name of the typeface style. It also recommends a minimum point size and suggests a way to use the typeface in documents.

3. Type the sizes of the fonts you need. You can use either the number keys at the top of the keyboard or the numeric keypad. Press the spacebar to separate each size. When you're satisfied with the sizes, press `.=`.

   If you change your mind, choose the typeface again and change the sizes. The `<F1>` (Help) key tells you which editing keys are active.

4. (optional) Repeat steps 2 through 4, choosing a different Fontware typeface. To repeat the list of sizes you entered last, press `<F9>` (Paste) after you choose a typeface.
5. (optional) Press <F6> for an estimate of the time needed to make all
the fonts you have requested so far. The kit also tells you if you have
enough disk space.

When you're satisfied with your printer font sizes, select fonts for your
display. See "Making Matched Display and Printer Fonts" later in this
section.

6. When you're ready to make your fonts, press <F10>. The kit displays
an estimate of the time needed to make the fonts. It also tells you if
you have enough disk space. If you don't have enough space, go back
to the Make Fonts Menu and delete font sizes. Then press <F10>
again.

7. When you're ready, press y. Fontware generates your fonts.

When the kit finishes generating your fonts, you are ready to use them
within your GEM applications, with the exception of GEM Desktop
Publisher (Release 1.1 only). You need to add your new fonts for use
with Publisher using the GEM Desktop Publisher Font Merge utility. In-
structions on using Font Merge are supplied with the GEM Desktop
Publisher Release 1.1 package.
Making Display Fonts

Make sure that the Fontware Control Panel lists your display and choice of character sets by choosing View Control Panel from the Main Menu. Add the Fontware typefaces you need by choosing Add/Delete Fontware Typefaces from the Main Menu. When you're ready to make display fonts, follow the instructions below.

1. Start from the Fontware Make Fonts Menu for the display. Get there by choosing Make Fonts from the Main Menu, or by pressing <F10> in either the Fontware Typefaces or Fontware Control Panel Menu. If you selected a printer in the Control Panel, the Make Fonts Menu for the printer appears on your screen. Press <F2>. The Make Fonts Menu for your display appears on the screen.

   The menu lists the names of the Fontware typefaces on your hard disk.

2. Point to a typeface and press ..J.

   The kit highlights a bar in the Point Size Selection Menu next to the typeface. A cursor blinks at the beginning of the bar.

3. Type the sizes of the fonts you need. You can request any sizes between 6 and 72 points, the current upper limit for GEM application display fonts. You can use either the number keys at the top of the keyboard or the numeric keypad to type in the sizes. Press the spacebar to separate each size. When you're finished entering the sizes, press ..J.

   If you change your mind, choose the typeface again and edit the list of sizes. The <F1> (Help) key tells you which editing keys are active.

4. (optional) Press <F6> for an estimate of the time and storage space needed to make all of the fonts you have requested so far.
5. (optional) Repeat steps 2 through 4, choosing a different Fontware typeface. To repeat the list of sizes you entered last, press `<F9>` (Paste), after you choose a typeface.

6. When you're finished specifying fonts, press `<F10>` . The kit displays an estimate of the time needed to make the fonts. It also tells you if you have enough disk space. If you don't have enough space, go back to the Make Fonts Menu and delete sizes from the fonts. Then press `<F10>` again.

7. When you're ready, press `y` . The kit generates your fonts.

Making Matched Display and Printer Fonts

There are two ways to make display fonts that match your printer fonts. You can match all of the printer font sizes specified for a given typeface, or you can select individual display fonts in the Make Display Fonts Menu. If you are making display fonts for PostScript printer fonts, you can do the latter only.

The Make Fonts Menu for the printer is displayed.

- To copy all your printer font sizes for a typeface to the display fonts Menu, press `<F4>` , then follow steps 4 through 7 in “Making Display Fonts” above.

- To select individual point sizes for your display, press `<F2>` , then follow steps 3 through 7 in “Making Display Fonts” above.
Ventura Publisher
Font Installation

This section discusses how to:
• verify display fonts for use in Ventura Publisher
• make new Ventura printer fonts
• merge printer font width tables

Verifying Display Fonts in Ventura

The display fonts you created with Fontware are ready to use in Ventura Publisher. Choose Set Printer Info... in the Options menu. Ventura displays the SET PRINTER INFO dialog.

Make sure that the Screen Fonts line in the dialog contains the correct file name extension for your display device. These extensions are listed in Section 5, "Identifying Display Fonts." If the extension is incorrect, type the correct extension. This ensures that your fonts display correctly on-screen.

Making New Ventura Printer Fonts

Since the GEM International and Ventura font width tables differ, you need to make new Ventura printer fonts for use under GEM 3.01 or later releases. Unless you intend to use Ventura as a stand-alone application, delete your old Ventura fonts to free up hard disk space.

Ventura requires that the Swiss and Dutch fonts be available in at least one size (in 10-point for non-PostScript printers). Therefore, be sure to make them for your first font width table. For information about Ventura font limitations, refer to your Ventura Publisher Edition Reference Guide.
Loading New Fonts in Ventura

During font generation, Fontware automatically creates a Ventura-compatible width table for the fonts. The width table file has a .WID extension and is placed in the \GEMAPPS\FONTWARE directory. It contains width and height information for each character in each printer font you made. Ventura requires this information in order to print text documents using these fonts.

The first time you make fonts for Ventura, you need only load the width table in the program to use the fonts. If later you generate additional fonts, you must merge their width tables with the existing width table, as explained in the following section.

To load your first width table:

1. Enter Ventura.
2. Choose Set Printer Info in the Options menu. The SET PRINTER INFO dialog is displayed.
3. Choose Load Different Width Table.
   In the ITEM SELECTOR, change to the \GEMAPPS\FONTWARE directory, and choose the .WID file generated by Fontware. Width table file names contain the printer name and a four-digit number. The highest number indicates the most recently-generated width table.
4. Choose Add/Remove Fonts in the Options menu. Ventura displays the ADD/REMOVE FONTS dialog. The width table name is displayed to the right of the dialog title.
5. Choose Save As New Width Table and save the width table under a new name.

Your printer fonts are now ready to use.
Merging Ventura Width Tables

Fontware creates a new width table every time you make fonts. This means that when you make additional fonts, you must merge their width tables with an existing, currently-used width table in Ventura.

Follow these steps:

1. Choose **Add/Remove Fonts** from the Options menu. Ventura displays the ADD/REMOVE FONTS dialog. The current width table name is displayed to the right of dialog title.

2. As a precaution, choose **Save As New Width Table** and save the width table under a new name. While this step is optional, it protects the current width table.

3. Choose **Merge Width Tables** from the Command panel in the dialog.

   In the ITEM SELECTOR, change to the \GEMAPPS\FONTWARE\ directory, and choose the .WID file generated by Fontware. Width table file names contain the printer name and a four-digit number. The highest number indicates the most recently-generated width table.

   Ventura adds the information in the new table to the existing table. It then redispays the ADD/REMOVE FONTS dialog, which now contains your new typefaces, sizes, and styles.

   You can remove any face, size, or style that you don't want by choosing them and clicking on **Remove Selected Font**.

7. When ready, choose OK to save the new width table. Font installation for Ventura is now complete.

**Note:** Adding new fonts for use with GEM Desktop Publisher requires the GEM Desktop Publisher Font Merge utility. Instructions on using Font Merge are supplied with the GEM Desktop Publisher package.
Fontware File Management

To manage the font files stored on your hard disk, you need to recognize and interpret the font file names.

This section discusses:

- identifying font files
- storing fonts on diskettes
- removing Fontware typefaces
- deleting the Fontware directory

Identifying Font Files

When it assigns names to the fonts it generates, the installation kit uses either four- or eight-character names, plus a three-character extension. The following, for example, are valid font file names:

- `cqgq.pfa`
- `ak100ghp.sfp`
- `ag080gbp.b30`

GEM device drivers locate each font you request by interpreting information encoded in the font file.

Font File Extensions

The file extension, the three characters after the dot in a file name, identifies the device with which the font file is associated.
Display Font Extensions

Display font files have the extensions are listed below.

<table>
<thead>
<tr>
<th>Extension</th>
<th>Indicates a display font for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ega</td>
<td>AT&amp;T® 6300, IBM EGA™ (monochrome), Hercules™ (monochrome), Quadram® Prosync™/Vega Deluxe™ (752x410)</td>
</tr>
<tr>
<td>cga</td>
<td>Compaq®, IBM CGA™</td>
</tr>
<tr>
<td>vga</td>
<td>IBM VGA™, Wyse 700®, The GENIUS®, Quadram Prosync/Vega Deluxe™ (640x480)</td>
</tr>
</tbody>
</table>

Printer Font Extensions

Printer font files have the extensions listed below.

<table>
<thead>
<tr>
<th>Extension</th>
<th>Indicates a printer font for:</th>
</tr>
</thead>
<tbody>
<tr>
<td>b30</td>
<td>Epson® GQ3500™ and GEM bit-mapped fonts for 300 DP LaserJet printers</td>
</tr>
<tr>
<td>eps</td>
<td>Epson MX-80™ and FX-80™, IBM Graphics™ and Proprinter™</td>
</tr>
<tr>
<td>hph</td>
<td>GEM bit-mapped fonts for 150 DPI LaserJet printers</td>
</tr>
<tr>
<td>pfa, pfi</td>
<td>Apple® LaserWriter® and LaserWriter Plus®, PostScript compatibles</td>
</tr>
<tr>
<td>sfp, hfi</td>
<td>Softfonts for LaserJet printers</td>
</tr>
<tr>
<td>elq</td>
<td>Epson LQ-series</td>
</tr>
<tr>
<td>x20</td>
<td>Xerox® 4020™</td>
</tr>
<tr>
<td>i24</td>
<td>IBM Quietwriter™</td>
</tr>
</tbody>
</table>
Non-PostScript Fonts

Font file names for displays and non-PostScript printers have the following format:

```
tpppgdr.xxx
```

where

- **tt** is the typeface identifier
- **ppp** is a three-digit point size description
- **g** is the GEM character-set identifier
- **d** is a device class identifier
- **r** is the character 'p', a reserved position
- **xxx** is the file extension (see above)

For example, the file `av210gfp.x20` is the Swiss Light Italic (av) 21-point (210) font for the Xerox 4020 (indicated both by f and x20). For keys to the typeface and device identifiers, see Appendices B and C, respectively.

PostScript Printer Fonts

PostScript font file names have this format:

```
ttgq.pfa```

where

- **tt** is the typeface identifier
- **g** is the GEM International character set identifier
- **q** is the PostScript device class identifier

For example, the file `gsgq.pfa` is the Bitstream Charter Black PostScript font. For keys to the typeface and device identifiers, see Appendices B and C, respectively.
Storing Fonts on Floppy Disks

If you frequently change your printer (or display), back up your fonts onto floppy disks before changing your device setup in GEM Setup. Removing a device with GEM Setup deletes the fonts associated with that device from the \GEMAPPS\FONTS directory.

If you don't need the fonts right away, you can copy them from the \GEMAPPS\FONTS directory on your hard disk to a floppy disk. Then delete the fonts from the hard disk to make room for other files.

If you back up a document that uses Fontware fonts to a diskette, back up the fonts as well. Then, if you need to, you can delete the documents, any related GEM/3 files, and the fonts from your system. Later, you can restore everything to your system and print the document again.

Removing Fontware Typefaces

You can use the Add/Delete Fontware Typefaces option in Fontware to remove typefaces from your system. If you want to remove the typefaces from your system and still see a list of your typefaces in the Fontware menus, follow these steps:

1. In DOS, change to the BCO subdirectory of your Fontware directory.
2. Delete files with the file name extension .BCO.
3. If you have a PostScript printer, change to the BEZ subdirectory of the Fontware directory and delete files with the file name extension .BEZ.

The next time you use the Fontware Kit, you see your typefaces listed as before in the Make Fonts menu. When you choose a typeface, the kit prompts you to go to Add/Delete Fontware Typefaces and add the typeface again to your Fontware directory.
Fonts Directory

Unless you specify a different directory during setup, the Fontware Kit stores all fonts in the \GEMAPPS\FONTS directory. See “Setting Up” in Section 1 for instructions on changing this default directory.

Deleting the Fontware Directory

Once you’ve finished creating your fonts or are confident that you won’t need the installation kit for some time, you can remove the FONTWARE directory from your hard disk.

The fastest way to do this is from within the GEM Desktop. (If you installed PostScript fonts, see the note below before starting.) Click on the FONTWARE folder icon, press Alt D, then press y to confirm deletion, if necessary. The GEM Desktop deletes the FONTWARE directory and all of its subdirectories.

Note: After generating PostScript fonts, you can reduce disk space by deleting everything in the FONTWARE directory except:

- All files having the .TDF extension
- The Fontware DDF subdirectory

In this case, do not delete the FONTWARE directory. Again, you can delete folders and files much faster from within the GEM Desktop than from the operating system command line.
# Troubleshooting

This section suggests ways to correct problems you might encounter working with fonts.

<table>
<thead>
<tr>
<th><strong>Problem</strong></th>
<th><strong>What You Should Do</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Fontware Make Fonts Menu for the display does not appear on my screen.</td>
<td>Choose View Control Panel from the Main Menu. The device probably is set to <strong>none</strong>. Change the device to the correct printer or display, then return to the Make Fonts Menu.</td>
</tr>
<tr>
<td>The fonts I made don't appear in the list of available fonts in GEM Desktop Publisher.</td>
<td>You need to merge the width table for the new fonts using the GEM Desktop Publisher Font Merge Utility. Consult the Font Merge Utility documentation supplied with your GEM Desktop Publisher package.</td>
</tr>
<tr>
<td>Characters above a certain point size appear clipped or oddly shaped.</td>
<td>Some devices limit the space that a given character can occupy. Fontware takes the limit into account when it creates the character image and provides the best image possible within the allotted space.</td>
</tr>
<tr>
<td>Some italic characters appear clipped or squeezed on my display (or printer).</td>
<td>Certain devices don't allow characters to extend outside a predefined area. Therefore, some characters, such as lower-case italics that extend naturally outside this boundary appear clipped or distorted on the display. When printed, they may appear normal.</td>
</tr>
<tr>
<td>Characters above a certain point size won't print.</td>
<td>The font file for these characters might be too large for your printer to handle.</td>
</tr>
</tbody>
</table>
# GEM International Character Set

This appendix lists the characters in the GEM International character set along with their decimal ASCII values.

The sixth character in a font file name is a code which represents the character set: `ttppgdo.xxx`

<table>
<thead>
<tr>
<th>Decimal</th>
<th>GEM International</th>
<th>Decimal</th>
<th>GEM International</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-32</td>
<td>not used</td>
<td>51</td>
<td>3</td>
</tr>
<tr>
<td>33</td>
<td>!</td>
<td>52</td>
<td>4</td>
</tr>
<tr>
<td>34</td>
<td>&quot;</td>
<td>53</td>
<td>5</td>
</tr>
<tr>
<td>35</td>
<td>#</td>
<td>54</td>
<td>6</td>
</tr>
<tr>
<td>36</td>
<td>$</td>
<td>55</td>
<td>7</td>
</tr>
<tr>
<td>37</td>
<td>%</td>
<td>56</td>
<td>8</td>
</tr>
<tr>
<td>38</td>
<td>&amp;</td>
<td>57</td>
<td>9</td>
</tr>
<tr>
<td>39</td>
<td></td>
<td>58</td>
<td>:</td>
</tr>
<tr>
<td>40</td>
<td>(</td>
<td>59</td>
<td>;</td>
</tr>
<tr>
<td>41</td>
<td>)</td>
<td>60</td>
<td>&lt;</td>
</tr>
<tr>
<td>42</td>
<td>*</td>
<td>61</td>
<td>=</td>
</tr>
<tr>
<td>43</td>
<td>+</td>
<td>62</td>
<td>&gt;</td>
</tr>
<tr>
<td>44</td>
<td>.</td>
<td>63</td>
<td>?</td>
</tr>
<tr>
<td>45</td>
<td>-</td>
<td>64</td>
<td>@</td>
</tr>
<tr>
<td>46</td>
<td>.</td>
<td>65</td>
<td>A</td>
</tr>
<tr>
<td>47</td>
<td>/</td>
<td>66</td>
<td>B</td>
</tr>
<tr>
<td>48</td>
<td>0</td>
<td>67</td>
<td>C</td>
</tr>
<tr>
<td>49</td>
<td>1</td>
<td>68</td>
<td>D</td>
</tr>
<tr>
<td>50</td>
<td>2</td>
<td>69</td>
<td>E</td>
</tr>
<tr>
<td>Decimal</td>
<td>GEM International</td>
<td>Decimal</td>
<td>GEM International</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>---------</td>
<td>------------------</td>
</tr>
<tr>
<td>70</td>
<td>F</td>
<td>95</td>
<td>a</td>
</tr>
<tr>
<td>71</td>
<td>G</td>
<td>96</td>
<td>'</td>
</tr>
<tr>
<td>72</td>
<td>H</td>
<td>97</td>
<td>a</td>
</tr>
<tr>
<td>73</td>
<td>I</td>
<td>98</td>
<td>b</td>
</tr>
<tr>
<td>74</td>
<td>J</td>
<td>99</td>
<td>c</td>
</tr>
<tr>
<td>75</td>
<td>K</td>
<td>100</td>
<td>d</td>
</tr>
<tr>
<td>76</td>
<td>L</td>
<td>101</td>
<td>e</td>
</tr>
<tr>
<td>77</td>
<td>M</td>
<td>102</td>
<td>f</td>
</tr>
<tr>
<td>78</td>
<td>N</td>
<td>103</td>
<td>g</td>
</tr>
<tr>
<td>79</td>
<td>O</td>
<td>104</td>
<td>h</td>
</tr>
<tr>
<td>80</td>
<td>P</td>
<td>105</td>
<td>i</td>
</tr>
<tr>
<td>81</td>
<td>Q</td>
<td>106</td>
<td>j</td>
</tr>
<tr>
<td>82</td>
<td>R</td>
<td>107</td>
<td>k</td>
</tr>
<tr>
<td>83</td>
<td>S</td>
<td>108</td>
<td>l</td>
</tr>
<tr>
<td>84</td>
<td>T</td>
<td>109</td>
<td>m</td>
</tr>
<tr>
<td>85</td>
<td>U</td>
<td>110</td>
<td>n</td>
</tr>
<tr>
<td>86</td>
<td>V</td>
<td>111</td>
<td>o</td>
</tr>
<tr>
<td>87</td>
<td>W</td>
<td>112</td>
<td>p</td>
</tr>
<tr>
<td>88</td>
<td>X</td>
<td>113</td>
<td>q</td>
</tr>
<tr>
<td>89</td>
<td>Y</td>
<td>114</td>
<td>r</td>
</tr>
<tr>
<td>90</td>
<td>Z</td>
<td>115</td>
<td>s</td>
</tr>
<tr>
<td>91</td>
<td>[</td>
<td>116</td>
<td>t</td>
</tr>
<tr>
<td>92</td>
<td>\</td>
<td>117</td>
<td>u</td>
</tr>
<tr>
<td>93</td>
<td>]</td>
<td>118</td>
<td>v</td>
</tr>
<tr>
<td>94</td>
<td>^</td>
<td>119</td>
<td>w</td>
</tr>
<tr>
<td>Decimal</td>
<td>GEM International</td>
<td>Decimal</td>
<td>GEM International</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>---------</td>
<td>------------------</td>
</tr>
<tr>
<td>120</td>
<td>x</td>
<td>146</td>
<td>ÅE</td>
</tr>
<tr>
<td>121</td>
<td>y</td>
<td>147</td>
<td>ø</td>
</tr>
<tr>
<td>122</td>
<td>z</td>
<td>148</td>
<td>ö</td>
</tr>
<tr>
<td>123</td>
<td>{</td>
<td>149</td>
<td>ò</td>
</tr>
<tr>
<td>124</td>
<td></td>
<td></td>
<td>150</td>
</tr>
<tr>
<td>125</td>
<td>}</td>
<td>151</td>
<td>û</td>
</tr>
<tr>
<td>126</td>
<td>~</td>
<td>152</td>
<td>ÿ</td>
</tr>
<tr>
<td>127</td>
<td>not used</td>
<td>153</td>
<td>Ö</td>
</tr>
<tr>
<td>128</td>
<td>Ç</td>
<td>154</td>
<td>Ü</td>
</tr>
<tr>
<td>129</td>
<td>ü</td>
<td>155</td>
<td>ø</td>
</tr>
<tr>
<td>130</td>
<td>é</td>
<td>156</td>
<td>£</td>
</tr>
<tr>
<td>131</td>
<td>å</td>
<td>157</td>
<td>Ø</td>
</tr>
<tr>
<td>132</td>
<td>ä</td>
<td>158</td>
<td>á</td>
</tr>
<tr>
<td>133</td>
<td>à</td>
<td>159</td>
<td>f</td>
</tr>
<tr>
<td>134</td>
<td>å</td>
<td>160</td>
<td>á</td>
</tr>
<tr>
<td>135</td>
<td>ç</td>
<td>161</td>
<td>í</td>
</tr>
<tr>
<td>136</td>
<td>ë</td>
<td>162</td>
<td>ö</td>
</tr>
<tr>
<td>137</td>
<td>ê</td>
<td>163</td>
<td>ý</td>
</tr>
<tr>
<td>138</td>
<td>ë</td>
<td>164</td>
<td>ñ</td>
</tr>
<tr>
<td>139</td>
<td>ï</td>
<td>165</td>
<td>Ñ</td>
</tr>
<tr>
<td>140</td>
<td>î</td>
<td>166</td>
<td>ñ</td>
</tr>
<tr>
<td>141</td>
<td>ì</td>
<td>167</td>
<td>°</td>
</tr>
<tr>
<td>142</td>
<td>Ä</td>
<td>168</td>
<td>ï</td>
</tr>
<tr>
<td>143</td>
<td>Å</td>
<td>169</td>
<td>&quot;</td>
</tr>
<tr>
<td>144</td>
<td>É</td>
<td>170</td>
<td>&quot;</td>
</tr>
<tr>
<td>145</td>
<td>æ</td>
<td>171</td>
<td>ç</td>
</tr>
<tr>
<td>Decimal</td>
<td>GEM International</td>
<td>Decimal</td>
<td>GEM International</td>
</tr>
<tr>
<td>---------</td>
<td>------------------</td>
<td>---------</td>
<td>------------------</td>
</tr>
<tr>
<td>172</td>
<td>»</td>
<td>197</td>
<td></td>
</tr>
<tr>
<td>173</td>
<td>i</td>
<td>198</td>
<td>°</td>
</tr>
<tr>
<td>174</td>
<td>«</td>
<td>199</td>
<td>Á</td>
</tr>
<tr>
<td>175</td>
<td>»</td>
<td>200</td>
<td>Â</td>
</tr>
<tr>
<td>176</td>
<td>ä</td>
<td>201</td>
<td>È</td>
</tr>
<tr>
<td>177</td>
<td>ò</td>
<td>202</td>
<td>Ê</td>
</tr>
<tr>
<td>178</td>
<td>¥</td>
<td>203</td>
<td>Ë</td>
</tr>
<tr>
<td>179</td>
<td>ř</td>
<td>204</td>
<td>ì</td>
</tr>
<tr>
<td>180</td>
<td>œ</td>
<td>205</td>
<td>í</td>
</tr>
<tr>
<td>181</td>
<td>Œ</td>
<td>206</td>
<td>Ï</td>
</tr>
<tr>
<td>182</td>
<td>À</td>
<td>207</td>
<td>ï</td>
</tr>
<tr>
<td>183</td>
<td>Ä</td>
<td>208</td>
<td>Õ</td>
</tr>
<tr>
<td>184</td>
<td>Ö</td>
<td>209</td>
<td>Ò</td>
</tr>
<tr>
<td>185</td>
<td>§</td>
<td>210</td>
<td>Ö</td>
</tr>
<tr>
<td>186</td>
<td>‡</td>
<td>211</td>
<td>Š</td>
</tr>
<tr>
<td>187</td>
<td>†</td>
<td>212</td>
<td>Ŝ</td>
</tr>
<tr>
<td>188</td>
<td>¶</td>
<td>213</td>
<td>Ū</td>
</tr>
<tr>
<td>189</td>
<td>©</td>
<td>214</td>
<td>Ù</td>
</tr>
<tr>
<td>190</td>
<td>®</td>
<td>215</td>
<td>Ú</td>
</tr>
<tr>
<td>191</td>
<td>™</td>
<td>216</td>
<td>Ÿ</td>
</tr>
<tr>
<td>192</td>
<td>&quot;</td>
<td>217</td>
<td>ß</td>
</tr>
<tr>
<td>193</td>
<td>...</td>
<td>218-224</td>
<td>not used</td>
</tr>
<tr>
<td>194</td>
<td>%0</td>
<td>225</td>
<td>ß</td>
</tr>
<tr>
<td>195</td>
<td>•</td>
<td></td>
<td></td>
</tr>
<tr>
<td>196</td>
<td>–</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This appendix lists Fontware typefaces, styles, and the two-character codes that represent them in font file names. You may find it convenient to check off the typefaces below for which you've made fonts, as a means of keeping track.

The typeface code appears as the first two characters in a font file name:

```
tpppcdr.xxx
```

(for PostScript fonts)

<table>
<thead>
<tr>
<th>Code</th>
<th>Typeface</th>
<th>Code</th>
<th>Typeface</th>
</tr>
</thead>
<tbody>
<tr>
<td>aa</td>
<td>Swiss Roman</td>
<td>au</td>
<td>Swiss Light</td>
</tr>
<tr>
<td>ab</td>
<td>Swiss Italic</td>
<td>av</td>
<td>Swiss Light Italic</td>
</tr>
<tr>
<td>ac</td>
<td>Swiss Bold</td>
<td>aw</td>
<td>Swiss Black</td>
</tr>
<tr>
<td>ad</td>
<td>Swiss Bold Italic</td>
<td>ax</td>
<td>Swiss Black Italic</td>
</tr>
<tr>
<td>ae</td>
<td>Century Schoolbook® Roman</td>
<td>ay</td>
<td>Swiss Condensed Roman</td>
</tr>
<tr>
<td>af</td>
<td>Century Schoolbook Italic</td>
<td>az</td>
<td>Swiss Condensed Italic</td>
</tr>
<tr>
<td>ag</td>
<td>Century Schoolbook Bold</td>
<td>ba</td>
<td>Swiss Condensed Bold</td>
</tr>
<tr>
<td>ah</td>
<td>Century Schoolbook Bold Italic</td>
<td>bb</td>
<td>Swiss Condensed Black</td>
</tr>
<tr>
<td>ai</td>
<td>Dutch Roman</td>
<td>bc</td>
<td>Futura Book</td>
</tr>
<tr>
<td>aj</td>
<td>Dutch Italic</td>
<td>bd</td>
<td>Futura Book Italic</td>
</tr>
<tr>
<td>ak</td>
<td>Dutch Bold</td>
<td>be</td>
<td>Futura Heavy</td>
</tr>
<tr>
<td>al</td>
<td>Dutch Bold Italic</td>
<td>bf</td>
<td>Futura Heavy Italic</td>
</tr>
<tr>
<td>am</td>
<td>Zapf Calligraphic Roman</td>
<td>bg</td>
<td>Futura Medium</td>
</tr>
<tr>
<td>an</td>
<td>Zapf Calligraphic Italic</td>
<td>bh</td>
<td>Futura Medium Italic</td>
</tr>
<tr>
<td>ao</td>
<td>Zapf Calligraphic Bold</td>
<td>bi</td>
<td>Futura Bold</td>
</tr>
<tr>
<td>ap</td>
<td>Zapf Calligraphic Bold Italic</td>
<td>bj</td>
<td>Futura Bold Italic</td>
</tr>
<tr>
<td>aq</td>
<td>Futura™ Light</td>
<td>bk</td>
<td>Courier 10 Roman</td>
</tr>
<tr>
<td>ar</td>
<td>Futura Light Italic</td>
<td>bl</td>
<td>Courier 10 italic</td>
</tr>
<tr>
<td>as</td>
<td>Futura Condensed Medium</td>
<td>bm</td>
<td>Courier 10 Bold</td>
</tr>
<tr>
<td>at</td>
<td>Futura Extra Black</td>
<td>bn</td>
<td>Courier 10 Bold Italic</td>
</tr>
<tr>
<td>Code</td>
<td>Typeface</td>
<td>Code</td>
<td>Typeface</td>
</tr>
<tr>
<td>------</td>
<td>--------------------------------</td>
<td>------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>bo</td>
<td>Letter Gothic 12 Roman</td>
<td>cq</td>
<td>Bitstream Charter Roman</td>
</tr>
<tr>
<td>bp</td>
<td>Letter Gothic 12 Italic</td>
<td>cr</td>
<td>Bitstream Charter Italic</td>
</tr>
<tr>
<td>bq</td>
<td>Letter Gothic 12 Bold</td>
<td>cs</td>
<td>Bitstream Charter Black</td>
</tr>
<tr>
<td>br</td>
<td>Letter Gothic 12 Bold Italic</td>
<td>ct</td>
<td>Bitstream Charter Black Italic</td>
</tr>
<tr>
<td>bs</td>
<td>Prestige 12 Roman</td>
<td>cu</td>
<td>ITC Galliard® Roman</td>
</tr>
<tr>
<td>bt</td>
<td>Prestige 12 Italic</td>
<td>cv</td>
<td>ITC Galliard Italic</td>
</tr>
<tr>
<td>bu</td>
<td>Prestige 12 Bold</td>
<td>cw</td>
<td>ITC Galliard Bold</td>
</tr>
<tr>
<td>bv</td>
<td>Prestige 12 Bold Italic</td>
<td>cx</td>
<td>ITC Galliard Bold Italic</td>
</tr>
<tr>
<td>bw</td>
<td>ITC Avant Garde Gothic® Book</td>
<td>cy</td>
<td>ITC Garamond® Book</td>
</tr>
<tr>
<td>bx</td>
<td>ITC Avant Garde Gothic Medium</td>
<td>cz</td>
<td>ITC Garamond Book Italic</td>
</tr>
<tr>
<td>by</td>
<td>ITC Avant Garde Gothic Demi</td>
<td>da</td>
<td>ITC Garamond Bold</td>
</tr>
<tr>
<td>bz</td>
<td>ITC Avant Garde Gothic Bold</td>
<td>db</td>
<td>ITC Garamond Bold Italic</td>
</tr>
<tr>
<td>ca</td>
<td>Zapf Humanist Roman</td>
<td>dc</td>
<td>Brush Script® Italic</td>
</tr>
<tr>
<td>cb</td>
<td>Zapf Humanist Italic</td>
<td>dd</td>
<td>Blippo® Black</td>
</tr>
<tr>
<td>cc</td>
<td>Zapf Humanist Bold</td>
<td>de</td>
<td>Hobo® Roman</td>
</tr>
<tr>
<td>cd</td>
<td>Zapf Humanist Bold Italic</td>
<td>df</td>
<td>Windsor® Roman</td>
</tr>
<tr>
<td>ce</td>
<td>Bitstream Cooper Black®</td>
<td>dg</td>
<td>Swiss Compressed Roman</td>
</tr>
<tr>
<td>cf</td>
<td>University Roman</td>
<td>dh</td>
<td>Swiss Extra Compressed Roman</td>
</tr>
<tr>
<td>cg</td>
<td>Cloister Black®</td>
<td>di</td>
<td>Exotic Demi</td>
</tr>
<tr>
<td>ch</td>
<td>Broadway Roman</td>
<td>dj</td>
<td>Exotic Bold</td>
</tr>
<tr>
<td>ci</td>
<td>ITC Souvenir Light®</td>
<td>dk</td>
<td>Baskerville Roman</td>
</tr>
<tr>
<td>cj</td>
<td>ITC Souvenir Light Italic</td>
<td>dl</td>
<td>Baskerville Italic</td>
</tr>
<tr>
<td>ck</td>
<td>ITC Souvenir Demi</td>
<td>dm</td>
<td>Baskerville Bold</td>
</tr>
<tr>
<td>cl</td>
<td>ITC Souvenir Demi Italic</td>
<td>dn</td>
<td>Baskerville Bold Italic</td>
</tr>
<tr>
<td>cm</td>
<td>ITC Korinna® Regular</td>
<td>do</td>
<td>Bitstream Cooper Light</td>
</tr>
<tr>
<td>cn</td>
<td>ITC Korinna Kursiv Regular</td>
<td>dp</td>
<td>Bitstream Cooper Light Italic</td>
</tr>
<tr>
<td>co</td>
<td>ITC Korinna Extra Bold</td>
<td>dq</td>
<td>Bitstream Cooper Bold</td>
</tr>
<tr>
<td>cp</td>
<td>ITC Korinna Kursiv Extra Bold</td>
<td>dr</td>
<td>Bitstream Cooper Bold Italic</td>
</tr>
<tr>
<td>Code</td>
<td>Typeface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ds</td>
<td>Serifa® Roman</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dt</td>
<td>Serifa Italic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>du</td>
<td>Serifa Bold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dv</td>
<td>Serifa Black</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dw</td>
<td>ITC Garamond Condensed® Book</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dx</td>
<td>ITC Garamond Cond. Book Italic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dy</td>
<td>ITC Garamond Cond. Bold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dz</td>
<td>ITC Garamond Cond. Bold Italic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ea</td>
<td>News Gothic® Roman</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eb</td>
<td>News Gothic Italic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ec</td>
<td>News Gothic Bold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ed</td>
<td>News Gothic Bold Italic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ee</td>
<td>Goudy Roman</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ef</td>
<td>Goudy Oldstyle® Italic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eg</td>
<td>Goudy Bold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eh</td>
<td>Goudy Extra Bold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ei</td>
<td>Coronet Bold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ej</td>
<td>ITC Zapf Chancery® Medium Italic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ek</td>
<td>Clarendon Roman</td>
<td></td>
<td></td>
</tr>
<tr>
<td>el</td>
<td>Clarendon Bold</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ep</td>
<td>ITC Bookman® Light</td>
<td></td>
<td></td>
</tr>
<tr>
<td>eq</td>
<td>ITC Bookman Light Italic</td>
<td></td>
<td></td>
</tr>
<tr>
<td>er</td>
<td>ITC Bookman Demi</td>
<td></td>
<td></td>
</tr>
<tr>
<td>es</td>
<td>ITC Bookman Demi Italic</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This appendix lists the device codes contained in font file names. These codes identify the type of device with which the font is used and appear as the seventh character in font file names: ttpppgdr.xxx.

The resolution is the main characteristic in common among the devices in each group. Resolution is the number of dots the device prints or displays in a square inch and is indicated by both the horizontal dots per inch (hdpi) and vertical dots per inch (vdpi).
<table>
<thead>
<tr>
<th>Code</th>
<th>Resolution (hdpi,vdpi)</th>
<th>Device</th>
</tr>
</thead>
</table>
| a    | 91, 75               | AT&T 6300 personal computer  
Hercules graphics adapter (monochrome)  
IBM EGA graphics adapter |
| b    | 300, 300             | Epson GQ3500  
HP LaserJet family |
| c    | 91, 41               | Compaq personal computer  
IBM CGA graphics adapter |
| d    | 180, 180             | Epson LQ-Series printers |
| e    | 120, 144             | Epson MX-80 or FX-80 Grafrax® printer  
IBM Graphics or Proprinter printer |
| f    | 120, 120             | Xerox 4020 Inkjet printer |
| h    | 150, 150             | HP LaserJet family |
| j    | 240, 240             | IBM Quietwriter and 3812 Pageprinter™ |
| k    | 84, 84               | Quadram® Quadjet™ |
| n    | 100, 96              | IBM Color Jetprinter |
| q    | 300, 300             | Apple LaserWriter  
Apple LaserWriter Plus  
PostScript-compatible printers |
| t    | 96, 96               | HP ThinkJet™ |
| v    | 91, 91               | WYSE 700 graphics adapter, IBM VGA,  
Micro Display Systems The GENIUS  
graphics adapter and other high-resolution displays |
Fontware Installation Kit Messages

This appendix lists the messages that can appear on your display while you are running the installation kit.

<table>
<thead>
<tr>
<th>Message</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot change to Fontware Directory.</td>
<td>During Setup. The kit is unable to change to the Fontware directory you typed. Check to make sure that you typed a valid directory name.</td>
</tr>
<tr>
<td>Cannot change to Fontware Drive.</td>
<td>During Setup. The kit is unable to change to the drive you indicated for the Fontware directory. Check to make sure that you typed a valid drive letter before the directory name.</td>
</tr>
<tr>
<td>Check disk in Drive A: and close drive lever.</td>
<td>There is no disk in Drive A. If you are installing the kit, put the appropriate disk into the drive and close the drive lever. If you are adding typefaces, put a typeface disk into the drive and close the lever. A disk is in Drive A but the drive lever has not been closed. Be sure to close the drive lever.</td>
</tr>
<tr>
<td>Check disk. Files may be corrupted.</td>
<td>The kit can't read the disk you are trying to copy from. If you're using a backup of an original Bitstream Fontware disk, exit the kit, make a new backup copy, and try again. If the disk is an original Fontware disk, call Bitstream Technical Support*.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Message</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Set Up Fontware before attempting to add typefaces.</td>
<td>You have tried to choose <strong>Add/ Delete Fontware Typefaces</strong> from the Main Menu</td>
</tr>
<tr>
<td>Choose Set Up Fontware before attempting to Make Fonts.</td>
<td>You have tried to choose <strong>Make Fonts</strong> from the Main Menu before completing setup.</td>
</tr>
<tr>
<td>Choose Set Up Fontware before attempting to view the Control Panel.</td>
<td>You have tried to choose <strong>View Control Panel</strong> from the Main Menu before completing setup.</td>
</tr>
<tr>
<td>Display Sizes to Printer Sizes. Not Allowed:</td>
<td>During <code>&lt;F4&gt;</code> Copy Sizes. You have tried to copy a font size that is allowed for your display but is not allowed for your printer. Depending on your application, you may not be able to select the display font.</td>
</tr>
<tr>
<td>Fontware installation failed.</td>
<td>During Setup. This usually indicates that you do not have enough space on your system for all the Fontware Installation Kit files. Make some room on your hard disk and try Set Up Fontware again.</td>
</tr>
<tr>
<td>General Internal Error. Call Bitstream Technical Support*.</td>
<td>The kit is unable to allocate memory on your system to perform certain tasks.</td>
</tr>
<tr>
<td>Insert a Fontware typeface disk into Drive A:</td>
<td>During Add Fontware Typefaces. You have put a disk into the drive that the kit does not recognize as a typeface disk. Remove the disk from the drive, insert a typeface disk and press ↓.</td>
</tr>
<tr>
<td>Insert Fontware Typeface disk # 1 into Drive A:</td>
<td>During Add Fontware Typefaces. You have put a disk into Drive A that the kit does not recognize as a typeface disk. Check that the correct disk is in the drive.</td>
</tr>
<tr>
<td>Message</td>
<td>What It Means</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
</tr>
<tr>
<td>Internal Error ##. Call Bitstream Technical Support*.</td>
<td>This general class of errors indicates a problem specific to one of the Fontware Installation Kit menus.</td>
</tr>
<tr>
<td>No character set available.</td>
<td>An information file for the character set you have chosen may be damaged. You should set up the installation kit again.</td>
</tr>
<tr>
<td>No display devices available.</td>
<td>An information file for the display device you have chosen in the control panel may be damaged. You should set up the installation kit again.</td>
</tr>
<tr>
<td>No sizes to copy for this typeface.</td>
<td>During Make Fonts – size editing session. You have pointed to a typeface that has no size selections and pressed the &lt;F4&gt; key. If you want to copy sizes, first choose the typeface, then enter point sizes.</td>
</tr>
<tr>
<td>No typefaces on the system. Choose Add/Delete Fontware Typefaces.</td>
<td>From the Main Menu. You have tried to choose <strong>Make Fonts</strong> before adding typefaces to your system.</td>
</tr>
<tr>
<td>Please put Installation Kit disk #1 in Drive A:</td>
<td>During Setup. You have put a Fontware Installation Kit disk other than disk #1 into the drive. Check the labels of your Fontware disks, insert disk #1 into the drive, and close the lever.</td>
</tr>
<tr>
<td>Printer Sizes to Display Sizes. Not Allowed:</td>
<td>During &lt;F4&gt; Copy Sizes. You have tried to copy a font size that is allowed for your printer but is not allowed for your display. This may be because the display font size is too large.</td>
</tr>
<tr>
<td>Message</td>
<td>What It Means</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The display typeface already has sizes selected. Do you want to overwrite them?</td>
<td>During Make Fonts. You have pointed to a typeface and pressed &lt;F4&gt; to copy sizes from printer to display but you have already entered display sizes for that face. If you want to overwrite the display sizes, press Y. You can press N and then press &lt;F2&gt; to check the display sizes first.</td>
</tr>
<tr>
<td>The printer typeface already has sizes selected. Do you want to overwrite them?</td>
<td>During Make Fonts. You have pointed to a typeface and pressed &lt;F4&gt; to copy sizes from display to printer but you have already entered printer sizes for that face. If you want to overwrite the printer sizes, press Y. You can press N and then press &lt;F2&gt; to check the printer sizes first.</td>
</tr>
<tr>
<td>The size at left is repeated. Delete duplicates.</td>
<td>You have entered the indicated point size more than one time. Move the cursor to all duplicates and delete the repeated sizes. Note: Printers and displays with very low resolution may not permit some integer sizes that are very close together. If you get this message and do not see exact duplicates in the point size selection, try deleting a size that is very close to the indicated size.</td>
</tr>
<tr>
<td>The size at left is too large. Maximum is xx points.</td>
<td>You have entered a point size that is too large for your printer or display. This message indicates the largest size permitted for the current device.</td>
</tr>
<tr>
<td>The size at left is too small. Minimum is xx points.</td>
<td>You have entered a point size that is too small for your printer or display. This message indicates the smallest size permitted for the current device.</td>
</tr>
<tr>
<td>Message</td>
<td>What It Means</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time and Space Estimates. Not enough disk space available.</td>
<td>During Make Fonts. The kit has checked your available disk space against its space estimates and determined that there is not enough room on your disk. Press &lt;F1&gt; to see space estimates and available space. You should delete some font requests and check the estimates again by pressing &lt;F6&gt;.</td>
</tr>
<tr>
<td>Typeface not found. Go to Add/Delete Fontware Typefaces.</td>
<td>During Make Fonts. You have chosen a typeface that the kit does not find on your system, even though the name is listed in the Make Fonts window. This may happen if you have both a PostScript and a non-PostScript printer and you added the typeface when the Fontware Control Panel was set to the non-PostScript printer. Check the control panel to make sure that you have chosen a PostScript printer, then choose <strong>Add/Delete Fontware Typefaces</strong> and add the typeface.</td>
</tr>
<tr>
<td>Typeface will be removed from your system. Do you want to delete?</td>
<td>During Delete Fontware Typefaces. All references to the chosen typeface will be erased from your hard disk. If you delete the face and later want to make fonts using the deleted typeface, you must first add it back to your system.</td>
</tr>
<tr>
<td>Unable to copy all required files.</td>
<td>During Add Fontware Typefaces. One or more files on the disk in Drive A may not be readable. If the disk is a backup, exit the kit and make a new backup. If the disk is an original, call Bitstream Technical Support*.</td>
</tr>
<tr>
<td>Message</td>
<td>What It Means</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unable to make directory <code>&lt;directory name&gt;</code>.</td>
<td>During Setup. The Fontware Installation Kit cannot create a directory it needs to set up. This may indicate a hardware problem.</td>
</tr>
<tr>
<td>Unable to make FONTWARE.BAT.</td>
<td>During Setup. The kit cannot create a batch file that it requires. This usually means that the Fontware initialization file is damaged. You should set up the Fontware Installation Kit again.</td>
</tr>
<tr>
<td>Unable to make Fontware directory.</td>
<td>During Setup. You have entered a directory name that the kit cannot create on your hard disk. Press <code>&lt;Esc&gt;</code> and enter a different directory name. This may indicate a general problem with writing to your hard disk.</td>
</tr>
<tr>
<td>Unable to read x directory.</td>
<td>The kit cannot read files in one of the Fontware subdirectories: BCO, BEZ, CSD, DDF, TDF, TMP. You should set up the Fontware Installation Kit again.</td>
</tr>
<tr>
<td>Unable to read FONTWARE.INI.</td>
<td>You have started the kit, but it cannot read the initialization file called FONTWARE.INI. You should set up the kit again.</td>
</tr>
</tbody>
</table>